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Preface

Preface

This preface describes who should read the Cisco SFS 7000 Series Product Family Element Manager 
User Guide, how it is organized, and its document conventions. It contains the following sections:

• Audience, page xv

• Organization, page xv

• Conventions, page xvi

• Related Documentation, page xvii

• Obtaining Documentation, page xviii

• Documentation Feedback, page xviii

• Cisco Product Security Overview, page xix

• Obtaining Technical Assistance, page xx

• Obtaining Additional Publications and Information, page xxi

Audience
The intended audience is the administrator responsible for installing, configuring, and managing Server 
Switch equipment. This administrator should have experience administering similar networking or 
storage equipment. 

Organization
This publication is organized as follows:
xv
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Conventions
Conventions
This document uses the following conventions:

Chapter Title Description

Chapter 1 About Element Manager 
Fundamentals

Describes Element Manager fundamentals.

Chapter 2 Chassis Display Tasks Describes tasks you can perform on the 
chassis display.

Chapter 3 File Menu Tasks Describes tasks you can perform on the file 
menu display.

Chapter 4 Edit Menu Tasks Describes tasks you can perform on the edit 
menu display.

Chapter 5 Maintenance Menu Tasks Describes tasks you can perform on the 
maintenance menu display.

Chapter 6 Health Menu Tasks Describes tasks you can perform on the 
health menu display.

Chapter 7 Report Menu Tasks Describes tasks you can perform on the 
report menu display.

Chapter 78 InfiniBand Menu Tasks Describes tasks you can perform on the 
Infiniband menu display.

Chapter 9 Ethernet Menu Tasks Describes tasks you can perform on the 
Ethernet menu display.

Chapter 10 FibreChannel Menu Tasks Describes tasks you can perform on the 
fibre channel menu display.

Chapter 11 Help Menu Tasks Describes tasks you can perform on the help 
menu display.

Convention Description

boldface font Commands, command options, and keywords are in 
boldface. Bold text indicates Chassis Manager elements or 
text that you must enter as-is.

italic font Arguments in commands for which you supply values are in 
italics. Italics not used in commands indicate emphasis.

Menu1 > Menu2 > 
Item… 

Series indicate a pop-up menu sequence to open a form or 
execute a desired function.

[ ] Elements in square brackets are optional.

{ x | y | z } Alternative keywords are grouped in braces and separated by 
vertical bars. Braces can also be used to group keywords 
and/or arguments; for example, {interface interface type}.

[ x | y | z ] Optional alternative keywords are grouped in brackets and 
separated by vertical bars.
xvi
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Related Documentation
Notes use the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in 
the publication.

Cautions use the following conventions:

Caution  Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

Related Documentation
• For additional information about Cisco SFS 7000P series switches and command-line interface 

(CLI) commands, refer to the following:

– Release Notes for Cisco SFS 7000P Series Switch Software Release 2.5.x

– Cisco SFS 7000 Series Product Family Chassis Manager User Guide

– Cisco SFS 7000 Series Product Family Command Reference Guide

• For detailed hardware configuration and maintenance procedures, refer to the following.

– Cisco SFS 7000P Switch Installation and Configuration Note

– Cisco SFS 7008P Switch Installation and Configuration Note

– Cisco SFS 7000P Hardware Installation Guide

– Cisco SFS 7008P Hardware Installation Guide

string A nonquoted set of characters. Do not use quotation marks 
around the string or the string will include the quotation 
marks.

screen font Terminal sessions and information the system displays are in 
screen font.

boldface screen 
font

Information you must enter is in boldface screen font.

italic screen font Arguments for which you supply values are in italic screen 
font.

^ The symbol ^ represents the key labeled Control—for 
example, the key combination ^D in a screen display means 
hold down the Control key while you press the D key.

< > Nonprinting characters, such as passwords are in angle 
brackets.

[ ] Default responses to system prompts are in square brackets.

!, # An exclamation point (!) or a pound sign (#) at the beginning 
of a line of code indicates a comment line.

Convention Description
xvii
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Obtaining Documentation
Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/techsupport

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Product Documentation DVD
The Product Documentation DVD is a comprehensive library of technical product documentation on a 
portable medium. The DVD enables you to access multiple versions of installation, configuration, and 
command guides for Cisco hardware and software products. With the DVD, you have access to the same 
HTML documentation that is found on the Cisco website without being connected to the Internet. 
Certain products also have .PDF versions of the documentation available.

The Product Documentation DVD is available as a single unit or as a subscription. Registered Cisco.com 
users (Cisco direct customers) can order a Product Documentation DVD (product number 
DOC-DOCDVD= or DOC-DOCDVD=SUB) from Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Ordering Documentation
Registered Cisco.com users may order Cisco documentation at the Product Documentation Store in the 
Cisco Marketplace at this URL:

http://www.cisco.com/go/marketplace/

Nonregistered Cisco.com users can order technical documentation from 8:00 a.m. to 5:00 p.m. 
(0800 to 1700) PDT by calling 1 866 463-3487 in the United States and Canada, or elsewhere by 
calling 011 408 519-5055. You can also order documentation by e-mail at 
tech-doc-store-mkpl@external.cisco.com or by fax at 1 408 519-5001 in the United States and Canada, 
or elsewhere at 011 408 519-5001.

Documentation Feedback
You can rate and provide feedback about Cisco technical documents by completing the online feedback 
form that appears with the technical documents on Cisco.com.
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Cisco Product Security Overview
You can submit comments about Cisco documentation by using the response card (if present) behind the 
front cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Cisco Product Security Overview
Cisco provides a free online Security Vulnerability Policy portal at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

From this site, you will find information about how to:

• Report security vulnerabilities in Cisco products.

• Obtain assistance with security incidents that involve Cisco products.

• Register to receive security information from Cisco.

A current list of security advisories, security notices, and security responses for Cisco products is 
available at this URL:

http://www.cisco.com/go/psirt

To see security advisories, security notices, and security responses as they are updated in real time, you 
can subscribe to the Product Security Incident Response Team Really Simple Syndication (PSIRT RSS) 
feed. Information about how to subscribe to the PSIRT RSS feed is found at this URL:

http://www.cisco.com/en/US/products/products_psirt_rss_feed.html

Reporting Security Problems in Cisco Products
Cisco is committed to delivering secure products. We test our products internally before we release them, 
and we strive to correct all vulnerabilities quickly. If you think that you have identified a vulnerability 
in a Cisco product, contact PSIRT:

• For Emergencies only —security-alert@cisco.com

An emergency is either a condition in which a system is under active attack or a condition for which 
a severe and urgent security vulnerability should be reported. All other conditions are considered 
nonemergencies.

• For Nonemergencies — psirt@cisco.com

In an emergency, you can also reach PSIRT by telephone:

• 1 877 228-7302

• 1 408 525-6532

Tip We encourage you to use Pretty Good Privacy (PGP) or a compatible product (for example, GnuPG) to 
encrypt any sensitive information that you send to Cisco. PSIRT can work with information that has been 
encrypted with PGP versions 2.x through 9.x. 
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Preface
Obtaining Technical Assistance
Never use a revoked or an expired encryption key. The correct public key to use in your correspondence 
with PSIRT is the one linked in the Contact Summary section of the Security Vulnerability Policy page 
at this URL:

http://www.cisco.com/en/US/products/products_security_vulnerability_policy.html

The link on this page has the current PGP key ID in use.

If you do not have or use PGP, contact PSIRT at the aforementioned e-mail addresses or phone numbers 
before sending any sensitive material to find other means of encrypting the data.

Obtaining Technical Assistance
Cisco Technical Support provides 24-hour-a-day award-winning technical assistance. The Cisco 
Technical Support & Documentation website on Cisco.com features extensive online support resources. 
In addition, if you have a valid Cisco service contract, Cisco Technical Assistance Center (TAC) 
engineers provide telephone support. If you do not have a valid Cisco service contract, contact your 
reseller.

Cisco Technical Support & Documentation Website
The Cisco Technical Support & Documentation website provides online documents and tools for 
troubleshooting and resolving technical issues with Cisco products and technologies. The website is 
available 24 hours a day, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support & Documentation website requires a Cisco.com user 
ID and password. If you have a valid service contract but do not have a user ID or password, you can 
register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support & 
Documentation website by clicking the Tools & Resources link under Documentation & Tools. Choose 
Cisco Product Identification Tool from the Alphabetical Index drop-down list, or click the Cisco 
Product Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by 
product ID or model name; by tree view; or for certain products, by copying and pasting show command 
output. Search results show an illustration of your product with the serial number label location 
highlighted. Locate the serial number label on your product and record the information before placing a 
service call.
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Obtaining Additional Publications and Information
Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests, or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—An existing network is down, or there is a critical impact to your business operations. 
You and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operations are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of the network is impaired, while most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• The Cisco Product Quick Reference Guide is a handy, compact reference tool that includes brief 
product overviews, key features, sample part numbers, and abbreviated technical specifications for 
many Cisco products that are sold through channel partners. It is updated twice a year and includes 
the latest Cisco offerings. To order and find out more about the Cisco Product Quick Reference 
Guide, go to this URL: 

http://www.cisco.com/go/guide
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Obtaining Additional Publications and Information
• Cisco Marketplace provides a variety of Cisco books, reference guides, documentation, and logo 
merchandise. Visit Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

or view the digital edition at this URL:

http://ciscoiq.texterity.com/ciscoiq/sample/

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• Networking products offered by Cisco Systems, as well as customer support services, can be 
obtained at this URL:

http://www.cisco.com/en/US/products/index.html

• Networking Professionals Connection is an interactive website for networking professionals to share 
questions, suggestions, and information about networking products and technologies with Cisco 
experts and other networking professionals. Join a discussion at this URL:

http://www.cisco.com/discuss/networking

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
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About Element Manager Fundamentals

This chapter describes the Element Manager Java-based user-interface (GUI) that runs on your server switch 
and contains these sections:

• Introduction, page 1-1

• Installing Element Manager, page 1-4

• Launching Element Manager, page 1-6

Introduction
With Element Manager, you can manage individual Server Switches from an easy-to-use GUI. To run 
element manager, you must do the following tasks:

• Install the EM software on a host or workstation.

• Configure your Server Switch(es) to support EM.

• Launch EM on your host or workstation.

The primary display of Element Manager provides pulldown menus, feature buttons, and various 
clickable display elements. Figure 1-1 shows the Element Manager display.

Figure 1-1 Element Manager Primary Display

The number of menus, buttons, and display elements vary by Server Switch platform. Table 1-1 and 
Table 1-2 list and describe all possible menus and buttons. Clickable display elements vary by hardware 
platform.

When you click a display element (such as Server Switch ports), a yellow border appears around the 
element. You can double-click any clickable element to open a related configuration window. You can 
right-click these elements to view element-specific right-click menus. You can use these menus and 
windows to view element details or change the configuration.
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  Introduction
You can hold the Ctrl button and click multiple elements of the same type (for instance, multiple 
InfiniBand ports) to select multiple elements at once to configure them as a group. After you select 
multiple elements, right-click one of the elements to display a right-click menu for options that you can 
apply.

Table 1-1 lists and describes the pulldown menus in the Element Manager display.

Table 1-1 Element Manager Pulldown Menus

Menu Description

File Use the menu items in the File menu to do the following:

• Load a Server Switch in the EM display.

• Configure EM performance options such as intervals and thresholds for various 
features.

• Refresh the EM display.

• Telnet to the open Server Switch to configure the switch with the CLI. (For CLI 
details, refer to the Cisco SFS 7000 Series Product Family Command Reference 
Guide.)

Edit Use the edit menu to view port properties or card properties.

Maintenance Use the menu items in the Maintenance menu to do the following:

• View Server Switch details.

• View and configure basic services.

• View and configure the boot configuration.

• Back-up the running configuration.

• Import and export files.

• Reboot the Server Switch.

• Track diagnostic tests.

Health Use the menu items in the Health menu to monitor the Server Switch status and 
events.

Report Use the menu items in the Report menu to graph Server Switch statistics.

InfiniBand Use the menu items in the InfiniBand menu to configure InfiniBand-specific Server 
Switch features, including the Device Manager and Subnet Manager.

Ethernet Use the menu items in the Ethernet menu to configure Ethernet-specific Server Switch 
features.

Fibre Channel Use the menu items in the FibreChannel menu to configure FC-specific Server Switch 
features.

Help Use the menu items in the Help menu to launch online help and locate additional help 
resources.
1-2
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  Introduction
Table 1-2 lists and describes the feature buttons in the Element Manager display.

Table 1-2 Element Manager Feature Buttons

Button Description

Open button Click the Open button to load a different Server Switch in the EM display.

Refresh button Click the Refresh button to poll the Server Switch and update the EM 
display.

Telnet button Click the Telnet button to launch a Telnet session to the Server Switch.

Help button Click the Help button to launch EM online help.

Properties button Click the Properties button after you click an element (or multiple 
elements of the same type) to view the properties of the element(s).

Graph button Click the Graph button after you click an element (or multiple elements of 
the same type) to select element statistics that you can then graph.

Topology button Click the Topology button to view the Server Switch and neighboring 
devices.

Subnet Management button Click the Subnet Management button to open the Subnet Management 
window and configure partitions, multicast groups, and other SM-related 
features.

Storage Manager button Click the Storage Manager button to open the Storage Manager window 
and configure initiators, targets, and LUNs.
1-3
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 1      About Element Manager Fundamentals
  Installing Element Manager
Common GUI Buttons
Many windows that you can open in Element Manager display a combination of frequently appearing 
buttons. Table 1-3 lists and describes these common buttons.

Status Indicators
The Element Manager display uses specific colors to communicate the status of Server Switch elements. 
Table 1-4 lists and explains status-indicator colors.

Installing Element Manager
Element Manager runs on Linux, Solaris, and Windows platforms. Follow installation instructions for 
the appropriate platform.

System Requirements (All Platforms)
To install Element Manager, your system must meet the following requirements:

• 64 MB of available RAM

• 75 MB of available hard disk space and 50 MB of additional available hard disk space during 
installation

• 300 MHz processor

• 800 x 600 screen resolution with 16-bit color depth

Table 1-3 Common Buttons

Button Description

Apply Applies any changes that you made in the window to the Server Switch.

Refresh Updates the window with the latest information from the Server Switch.

Close Closes the window.

Help Launches context-sensitive online help.

Table 1-4 Status Indicator Colors

Color Indication

gray Element is not active (such as an InfiniBand port that does not connect to a cable).

red An administrator has taken the element offline or the element experiences an error.

green Element functions successfully.

transparent Element is unmanaged.
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  Installing Element Manager
Linux Installation
To install Element Manager on Linux, perform the following steps:

Step 1 Log in to your Linux host.

Step 2 Place the Element Manager CD-ROM in the CD-ROM drive.

Step 3 Mount your CD-ROM drive (if required).

# mount /mnt/cdrom/

Step 4 Navigate to the top-level directory of the CD-ROM.

# cd /mnt/cdrom/

Step 5 Navigate to the Linux directory.

# cd Linux

Step 6 Run the appropriate binary file and proceed with the installation wizard.

Solaris Installation
To install Element Manager on Solaris, perform the following steps:

Step 1 Log in to your Solaris host.

Step 2 Place the Element Manager CD-ROM in the CD-ROM drive.

Step 3 Access the top-level folder of the CD.

Step 4 Navigate to the em/Solaris directory.

Step 5 Start the ./install_yourOS.bin file. Proceed with the installation wizard.

Windows Installation
To install Element Manager on Windows, perform the following steps:

Step 1 Log in to your Windows host.

Step 2 Place the Element Manager CD-ROM in the CD-ROM drive.

Step 3 Navigate to the Windows directory on the CD-ROM.

Step 4 Launch the executable file (.exe) to begin the installation process. The Introduction screen appears.

Step 5 Click the Next button. The License Agreement screen appears.

Step 6 Read the license agreement and click the I accept the terms of the license agreement radio button, and 
then click the Next button. The Choose Install Folder screen appears.

Step 7 Select a folder, and then click the Next button. The Choose Shortcut Folder screen appears. 
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Step 8 Make selections as appropriate for your needs, and then click the Next button. The Pre-Installation 
Summary screen appears.

Step 9 Verify installation information in the Please Review the Following Before Continuing window, and then 
click the Install button. The installation executes.

Step 10 Click the Done button when the installation completes.

Launching Element Manager
When you launch Element Manager, the EM interface requests the IP address (or DNS name) of the 
Server Switch that you want to manage. To successfully connect to the Server Switch that you want to 
manage, you must first configure that Server Switch to permit Element Manager access. If Element 
Manager fails to connect to a given Server Switch, verify that the Server Switch meets the prerequisites 
for EM.

Preparing your Server Switch
Factory defaults permit your Server Switch to connect to Element Manager. The following settings must 
apply to your Server Switch in order for it to open in EM:

• HTTP server enabled

• Telnet server enabled

• SNMP server configured

To view your Server Switch settings, perform the following steps:

Step 1 Log in to your Server Switch.

Step 2 Enter the enable command to enter Privileged EXEC mode.

Step 3 Enter the configure terminal command to enter global configuration mode.

Step 4 Enter the ip http server command to enable the HTTP server.

Step 5 Enter the telnet enable command to enable telnet services.

Step 6 To configure and SNMP server enter the snmp-server command with the following:

– the IP address of the server that you want to configure

– (optional) recv-event-traps keyword

For more details, refer to the Cisco SFS 7000 Series Product Family Command Reference Guide.
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Chassis Display Tasks

This chapter desecribes the chasis display tasks for Element Manager and contains these sections:

• Viewing Card Properties, page 2-1

• Enabling a Card, page 2-4

• Viewing the Card Inventory, page 2-5

• Viewing Internal Gateway Ports of a Card, page 2-6

• Viewing Card IP Addresses, page 2-6

• Viewing Card Bridging Details, page 2-7

• Viewing Port Properties, page 2-8

• Viewing Serial Management Port Properties, page 2-10

• Viewing Ethernet Management Port Properties, page 2-11

• Viewing InfiniBand Management Port Properties, page 2-11

• Viewing Port Bridging Properties, page 2-12

• Configuring Ports, page 2-12

Note When you launch Element Manager and open a Server Switch, a graphical display of that Server Switch 
appears. Colors in the display indicate the status of various components of the Server Switch. Various 
right- and left-click options let you configure the components that you see in the display.

Viewing Card Properties
To view card properties, perform the following steps:

Step 1 Right-click the card in the chassis display whose properties you want to view. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar. Table 2-1 lists and describes the fields that appear in the Card tab of the card 
window.
2-1
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  Viewing Card Properties
Table 2-1 Card Tab Fields

Field Description

Admin Type field (gateway cards only) Administratively configured card type.

Card Type field Dynamically discovered card type.

Enable/Disable Card field (choose cards 
only)

Provides “up” and “down” radio buttons so you can use 
the Apply button to enable or disable the card.

Current Card Status field Displays “up” if the card can currently run traffic, 
otherwise displays “down.”

Operational State field Displays the general condition of the interface card. The 
general condition may appear as any of the following:

• unknown

• normal

• wrong-image

• bootFailed

• tooHot

• booting

A condition of unknown indicates an unsupported 
interface card. To address this condition, replace the card 
with a supported card.

The operational state of a card must appear as normal for 
the current status of the card to appear as up.

A wrong-image condition indicates that the active system 
image on the interface card does not match the active 
system image on the controller. All cards must run the 
same active system image as the controller card to 
function.

A bootFailed condition indicates that the active system 
image on the card was incompletely or incorrectly loaded. 
If the other interface cards come up successfully, reset the 
individual card. Otherwise, reboot your entire device.

When your card overheats, the tooHot condition appears 
in the show card command output. Enter the show fan 
command to check to see if your fans failed.

The booting condition indicates that the card has not 
finished loading necessary image data for internal 
configuration.
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  Viewing Card Properties
Card Boot Stage field Boot Stage appears as one of the following:

• recovery

• ipl   

• ppcboot 

• fpga 

• pic 

• ib 

• rootfs 

• kernel 

• exe 

• done 

• none

Card Boot Status field Boot Status may appear as any of the following:

• upgrading   

• success

• failed 

• badVersion   

• badCrc

• memoryError 

• outOfSpace   

• programmingError    

• hardwareError 

• fileNotFound 

• inProgress

• none

Serial Number field Factory-assigned product serial number of the card.

PCA Serial Number field Printed circuit assembly (PCA) serial number of the card.

PCA Assembly Number field Printed circuit assembly (PCA) assembly number of the 
card.

FRU Number field Field-replaceable unit (FRU) number of the card.

Table 2-1 Card Tab Fields (continued)

Field Description
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Deleting Inactive Images from an Interface Card
To remove an inactive image from an interface card, perform the following steps:

Step 1 Right-click the card in the chassis display whose properties you want to view. A right-click menu 
appears.

Step 2 Choose  Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar.

Step 3 In the Action field, click the deleteInactiveImages radio button.

Step 4 Click the Apply button.

Resetting an Interface Card

Step 1 Right-click the card in the chassis display whose properties you want to view. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar.

Step 3 In the Action field, click the reset radio button.

Step 4 Click the Apply button.

Enabling a Card
With Element Manager, you can bring up or shut down any card on your chassis. To configure the admin 
status of a card, perform the following steps:

Step 1 Right-click the card in the chassis display that you want to bring up or shut down. A right-click menu 
appears.

Action field (actions vary by card type) Provides none, reset, and deleteInactiveImages radio 
buttons. For details, refer to the “Deleting Inactive Images 
from an Interface Card” section on page 2-4 and the 
“Resetting an Interface Card” section on page 2-4.

Result field Result of the action from the Action field.

Table 2-1 Card Tab Fields (continued)

Field Description
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Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar.

Step 3 Click the up radio button in the Enable/Disable Card field.

Step 4 Click the Apply button.

Disabling a Card
To disable a card, perform the following steps:

Step 1 Right-click the card in the chassis display that you want to bring up or shut down. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar.

Step 3 Click the down radio button in the Enable/Disable Card field.

Step 4 Click the Apply button.

Viewing the Card Inventory
To view memory and image information on a card, perform the following steps:

Step 1 Right-click the card in the chassis display whose properties you want to view. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar. 

Step 3 Click the Inventory tab. Table 2-2 lists and describes the elements in the Inventory tab of the card 
window.

Table 2-2 Inventory Tab Fields

Field Description

Used Memory field Used memory on the card, in kilobytes.

Free Memory field Available memory on the device, in kilobytes.

Used Disk Space field Used disk space on the card, in kilobytes.

Free Disk Space field Available disk space on the device, in kilobytes.

Current Image Source field Image that the card runs.

Image Source for Next Reboot field Image that the card runs when you reboot.

Image One field First image stored on the card.

Image Two field Second image stored on the card.

CPU Description field Description of the CPU on the card.
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Viewing Internal Gateway Ports of a Card
Ethernet Gateway cards use two internal gateway ports to pass traffic through your Server Switch. To 
view gateway port details for Ethernet Gateway cards, perform the following steps:

Step 1 Right-click the card in the chassis display whose gateway ports you want to view. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar. 

Step 3 Click the Gateway Ports tab. Table 2-3 lists and describes the elements in the Gateway Ports tab of the 
card window.

Viewing Card IP Addresses
To view the IP addresses of Ethernet Gateway cards, perform the following steps:

Step 1 Right-click the card in the chassis display whose IP addresses you want to view. A right-click menu 
appears.

PIC Firmware Revision field (Choose cards) Current PIC firmware version that the card runs.

FPGA Firmware Revision field (choose cards) Current FPGA firmware version that the card runs.

IB Firmware Revision field Version of InfiniBand firmware on the card.

Note Element Manager displays the device-id 
and version number of the IB chip for each 
card for Anafa 2 chips. This content 
appears in parentheses next to the 
firmware version. For original Anafa 
chips, no parenthetical text appears.

Table 2-2 Inventory Tab Fields (continued)

Field Description

Table 2-3 Gateway Ports Tab Field Descriptions

Field Description

IfIndex field Port (interface) number, in slot#/port# format.

Port Name field Port name.

Port Type field Port type.

Current Port Speed field Current speed of the port.
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Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar. 

Step 3 Click the IP Addresses tab. Table 2-4 lists and describes the elements in the IP Addresses tab of the card 
window.

Viewing Card Bridging Details
To view bridging details for Ethernet Gateway cards, perform the following steps:

Step 1 Right-click the card in the chassis display whose bridging details you want to view. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the card in the title bar. 

Step 3 Click the Bridging tab. Table 2-5 lists and describes the elements in the Bridging tab of the card window.

Table 2-4 IP Addresses Tab Field Descriptions

Field Description

Port field Port number, in card#port# format. A port# of 0 represents the internal 
gateway port of the interface card.

Address field IP address that you assigned to the port.

Netmask field Subnet mask that you assigned to the port.

BcastAddrFormat field IP broadcast address format that the port uses.

ReasmMaxSize field Size of the largest IP datagram which this port can receive and reassemble 
from incoming fragmented IP datagrams.

Type field Displays “primary” or “backup” to indicate that the interface card acts as 
the primary or backup interface for the IP address that appears in the 
address field.

Status field Displays “active” or “inactive” to indicate that the card actively services IP 
packets addressed to the IP address in the address field or does not service 
packets to the specified address.

Table 2-5 Bridging Tab Field Descriptions

Field Description

Port field Port number, in slot#/port# format.

IB P_Key field Partition key that you assigned to the bridge group to which the port belongs.

Bridge Group ID field Bridge group to which the port belongs. Assign the bridge group with the 
Ethernet > Bridging menu. For more information, see the “Creating a Bridge 
Group” section on page 9-7.
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Viewing Port Properties
To view port properties, perform the following steps:

Step 1 Right-click the port in the chassis display whose properties you want to view. A right-click menu 
appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the port in the title bar. The contents of the window vary by port type.

Table 2-6 lists and describes the fields in the properties window of an Ethernet port.

Table 2-6 Ethernet Port Properties Window Field Descriptions

Field Description

Port Type field Identifies the port type based on the function of the port 
(Ethernet, Fibre Channel, InfiniBand) and the type of card on 
which the port resides.

Port Name field Provides a port name that you can edit and apply to the port.

Enable/Disable Port field Provides the up and down radio buttons so you can configure 
the administrative status of the port.

Current Port Status field Indicates whether or not the port is ready for use.

Physical State field Displays the current state of the port, for example, polling.

Auto Negotiation Supported field Displays “true” if the port supports autonegotiation.

Enable Auto Negotiation checkbox Enables or disables autonegotiation on the port.

Set Port Speed field Provides radio buttons to let you configure the speed of the 
port.

Current Port Speed field Displays the speed of the port.

Set Duplex field Provides radio buttons to let you configure the duplex setting 
of the port.

Current Duplex field Indicates whether the port runs in full duplex mode or half 
duplex mode.

Enable Link Up/Down Trap field Provides enabled and disabled radio buttons to configure 
whether or not the port sends a trap when links go up or down.

MTU field Displays the maximum transmission unit (MTU) of the port, in 
bytes.

MAC Address field Displays the media access control (MAC) address of the port.

Last Changed On field Displays the time and date of the last time that a user 
configured the port.

Action field Flushes the ARP table when you click the flushArp radio 
button, and then click the Apply button. Executes no action if 
you click the none radio button, and then click the Apply 
button.

Result field Displays the result of the action that you perform from the 
Action field.
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Table 2-7 lists and describes the fields in the properties window of an Fibre Channel port.

Table 2-8 lists and describes the fields in the properties window of an InfiniBand port.

Table 2-7 Fibre Channel Port Properties Window Field Descriptions

Field Description

Port Type field Identifies the port type based on the function of the port 
(Ethernet, Fibre Channel, InfiniBand) and the type of card on 
which the port resides.

Port Name field Provides a port name that you can edit and apply to the port.

Enable/Disable Port field Provides the up and down radio buttons so you can configure 
the administrative status of the port.

Current Port Status field Indicates whether or not the port is ready for use.

Auto Negotiation Supported field Displays “true” if the port supports autonegotiation.

Enable Auto Negotiation checkbox Enables or disables autonegotiation on the port.

Set Port Speed field Provides radio buttons to let you configure the speed of the 
port.

Current Port Speed field Displays the speed of the port.

Current Connection Type field Displays the current connection type.

Enable Link Up/Down Trap field Provides enabled and disabled radio buttons to configure 
whether or not the port sends a trap when links go up or down.

MTU field Displays the maximum transmission unit (MTU) of the port, in 
bytes.

WWNN field World-wide node name of the HCA of the port.

WWPN field World-wide port name of the port.

FC ID field Native Fibre Channel ID of the port.

Last Changed On field Displays the time and date of the last time that a user 
configured the port.

Table 2-8 InfiniBand Port Properties Window Field Descriptions

Field Description

Port Type field Identifies the port type based on the function of the port 
(Ethernet, Fibre Channel, InfiniBand) and the type of card on 
which the port resides.

Port Name field Provides a port name that you can edit and apply to the port.

Enable/Disable Port field Provides the up and down radio buttons so you can configure 
the administrative status of the port.

Current Port Status field Indicates whether or not the port is ready for use.

Auto Negotiation Supported field Displays “true” if the port supports autonegotiation.

Enable Auto Negotiation checkbox Enables or disables autonegotiation on the port.

Set Port Speed field Provides radio buttons to let you configure the speed of the 
port.
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Viewing Serial Management Port Properties
To view management port properties, perform the following steps:

Step 1 Click the Edit menu and choose  Management Ports. The Management Ports window opens.

Step 2 Click the Serial Port tab. Table 2-9 lists and describes the fields in the Ethernet Port tab.

Establishing a Serial Connection
To create a serial connection to your Server Switch, perform the following steps:

Step 1 Connect the straight-through M/F serial cable (provided with your Server Switch) to the Serial 
Management port, and then connect the cable to your terminal, workstation, or terminal server.

Step 2 Launch a terminal session (on a workstation, use a terminal emulation application such as 
HyperTerminal) and configure your terminal parameters to match the parameters listed in Table 2-9.

Step 3 Press the Enter key until the Login prompt appears.

Current Port Speed field Displays the speed of the port.

Power Connector Dongle Type field Displays the power connector Dongle type. This field appears 
only if the InfiniBand port is supporting the power connector.

Enable Link Up/Down Trap field Provides enabled and disabled radio buttons to configure 
whether or not the port sends a trap when links go up or down.

MTU field Displays the maximum transmission unit (MTU) of the port, 
in bytes.

Last Changed On field Displays the time and date of the last time that a user 
configured the port.

Table 2-8 InfiniBand Port Properties Window Field Descriptions (continued)

Field Description

Table 2-9 Serial Port Window Field Descriptions

Field Description

Baud Rate field Baud rate setting to which you must set your serial connection.

Data Bits field Data bit setting to which you must set your serial connection.

Stop Bits field Stop bit setting to which you must set your serial connection.

Parity field Parity field setting to which you must set your serial connection.
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Viewing Ethernet Management Port Properties
To view management port properties, perform the following steps:

Step 1 Click the Edit menu and choose Management Ports. The Management Ports window opens.

Step 2 Click the Ethernet Port tab. Table 2-10 lists and describes the fields in the Ethernet Port tab.

Viewing InfiniBand Management Port Properties
To view management port properties, perform the following steps:

Step 1 Click the Edit menu and choose Management Ports. The Management Ports window opens.

Step 2 Click the InfiniBand Port tab. Table 2-11 lists and describes the fields in the InfiniBand Port tab.

Table 2-10 Ethernet Management Port Window Field Descriptions

Field Description

MAC Address field MAC address of the Ethernet Management Port (which serves as 
the MAC address of the Server Switch).

Enable Auto Negotiation field Displays “true” if the Ethernet Management port dynamically 
determines the connection speed of the device to which it 
connects over via Ethernet cable. Otherwise displays “false.”

Administrative Port Status field Displays the administrative status that you configure via the CLI 
with the shutdown and no shutdown commands.

Current Port Status field Displays “up” if the port runs successfully. Displays “down” if 
the port cannot transmit and receive traffic for any reason.

IP Address field IP address of the Ethernet Management Port.

Network Mask field Subnet mask of the Ethernet Management port.

Gateway field Ethernet Gateway assigned to the port.

Address Option field Displays the address option that you configure with the 
addr-option CLI command.

Table 2-11 InfiniBand Management Port Window Field Descriptions

Field Description

Administrative Port Status field Displays the administrative status that you configure via the CLI 
with the shutdown and no shutdown commands.

Current Port Status field Displays “up” if the port runs successfully. Displays “dow”n if 
the port cannot transmit and receive traffic for any reason.

IP Address field IP address of the InfiniBand Management port.

Network Mask field Subnet mask of the InfiniBand Management port.
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Viewing Port Bridging Properties
To view the bridging properties of a port, perform the following steps:

Step 1 Right-click the Ethernet port in the chassis display whose bridging properties you want to view. A 
right-click menu appears.

Step 2 Choose Properties... from the right-click menu. A window opens and displays the type and number of 
the port in the title bar. The contents of the window vary by port type.

Step 3 Click the Bridging tab. Table 2-12 lists and describes the fields in this tab.

Configuring Ports
Element Manager provides different configuration options for each type of port. The options available 
to each port will appear in the Port Properties window.

Note To configure multiple ports at once, hold the Ctrl key and click multiple ports of the same type, and then 
right-click one of the ports that you selected to view right-click menu options.

Configuring a Port Name
To configure the administrative name of a port, perform the following steps:

Gateway field IP address of the gateway that the InfiniBand port uses.

Address Option field Displays the address option that you configure with the 
addr-option CLI command.

MTU field Maximum transmission unit of the InfiniBand port.

Table 2-11 InfiniBand Management Port Window Field Descriptions (continued)

Field Description

Table 2-12 Port Bridging Table Field Descriptions

Field Description
Port Port that you chose from the Ports table.

IEEE VLAN Tag Virtual LAN (VLAN) of the bridge to which the port belongs.

Bridge Group ID Bridge ID of the bridge to which the port belongs.
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Step 1 Double-click the port that you want to configure. A window opens that identifies the type of the port and 
the port number (in slot#port# format).

Step 2 In the Port Name field of the window, enter a name for the port, and then click the Apply button.

Step 3 Click the Close button to close the window.

Enabling or Disabling a Port
To enable or disable a port, perform the following steps:

Step 1 Double-click the port that you want to configure. A window opens that identifies the type of the port and 
the port number (in slot#port# format).

Step 2 In the Enable/Disable Port field of the window, click the up (enable) or down (disable) radio button, and 
then click the Apply button.

Step 3 Click the Close button to close the Port Properties window.

Tip As a shortcut, right-click the port and choose Enable or Disable.

Configuring Autonegotiation on a Port
To enable or disable autonegotiation on a port, perform the following steps:

Step 1 Double-click the port that you want to configure. A window opens that identifies the type of the port and 
the port number (in slot#port# format).

Step 2 In the Auto Negotiation Supported field of the window, click the Enable Auto-Negotiation checkbox to 
check (enable) or uncheck (disable) it, and then click the Apply button.

Step 3 Click the Close button to close the window.

Configuring Port Speed
To configure the speed of a port, perform the following steps:

Step 1 Double-click the port that you want to configure. A window opens that identifies the type of the port and 
the port number (in slot#port# format).

Step 2 In the Auto Negotiation field, uncheck the Enable checkbox (if necessary).

Step 3 In the Set Port Speed field of the window, click a radio button to choose a speed, and then click the Apply 
button.
2-13
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 2      Chassis Display Tasks
  Rebooting the Server Switch
Step 4 Click the Close button to close the window.

Configuring Port IP Addresses
To add IP addresses to choose ports, perform the following steps:

Step 1 Double-click the port that you want to configure. A window opens that identifies the type of the port and 
the port number (in slot#port# format).

Step 2 Click the IP Addresses tab.

Note Before you can manually add IP addresses, you must configure the port for bridging. For details, 
refer to the Ethernet Gateway User Guide.

Step 3 Click the Insert button. The Insert IP Addresses window opens.

Step 4 Enter an IP address and subnet mask, and then click the Insert button. The address appears in the table 
under the IP Addresses tab.

Step 5 Click the Close button to close the window.

Rebooting the Server Switch
To reboot the chassis, perform the following steps:

Step 1 Right-click the Server Switch in the chassis display (avoid selectable elements such as ports and cards) 
and click Reboot. A window opens and prompts you to save configuration changes.

Step 2 Click Yes to save configuration changes or click No to discard the changes. A window opens to verify 
that you want to reboot.

Step 3 Click OK to reboot; otherwise, click Cancel.
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File Menu Tasks

This chapter describes the File menu tasks for Element Manager and contains these sections:

• Opening a Server Switch with Element Manager, page 3-1

• Configuring Polling Interval, page 3-2

• Configuring SNMP Preferences, page 3-3

• Configuring Miscellaneous Trap Preferences, page 3-3

• Refreshing the Element Manager Display, page 3-4

• Launching a Telnet Session, page 3-4

• Closing Element Manager, page 3-4

Note The File menu in the Element Manager GUI provides basic GUI functions and configuration options. 
Some feature buttons provide the same functions. Where the menu and the buttons overlap, the tasks in 
this chapter describe both options.

Opening a Server Switch with Element Manager
After you launch Element Manager, you can change the Server Switch that you view and configure with 
the GUI. To configure a Server Switch other than the one that you opened when you launched EM, 
perform the following steps:

Step 1 Click the File menu and select Open. The Open Device window opens.

Step 2 Enter the IP address or DNS name (if applicable) of the Server Switch that you want to open in the 
Device Name or IP Address field.

Step 3 Enter the SNMP community to which the Server Switch belongs in the SNMP Community field.

Step 4 Click the Open button. The Server Switch loads in the EM GUI.
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Using the Open Button
To open a Server Switch with the Open feature button, perform the following steps:

Step 1 Click the Open feature button ( ). The Open Device window opens.

Step 2 Enter the IP address or DNS name (if applicable) of the Server Switch that you want to open in the 
Device Name or IP Address field.

Step 3 Enter the SNMP community to which the Server Switch belongs in the SNMP Community field.

Step 4 Click the Open button. The Server Switch loads in the EM GUI.

Configuring Polling Interval
To configure the frequency with which Element Manager polls the Server Switch for updates, perform 
the following steps:

Step 1 Click the File menu and select Preferences. The Preferences window opens.

Step 2 Click the Polling tab.

Step 3 Enter an integer value in the Status Interval field to configure the interval, in seconds, at which Element 
Manager polls the Server Switch.

Step 4 Enter an integer value in the Hotswap Detect every field to configure the number of status intervals that 
pass before Element Manager detects removed or replaced hot-swappable hardware components.

Step 5 Check the Enable checkbox, and then click the OK button.

Disable Polling
When you disable polling, Element Manager refreshes only when you manually refresh the display (see 
the “Refreshing the Element Manager Display” section on page 3-4). To disable polling, perform the 
following steps:

Step 1 Click the File menu and select Preferences. The Preferences window opens.

Step 2 Click the Polling tab.

Step 3 Uncheck the Enable checkbox, and then click the OK button.
3-2
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 3      File Menu Tasks
  Configuring SNMP Preferences
Configuring SNMP Preferences
The SNMP preferences that you can configure depend on the application that controls port 162 on the 
host that runs Element Manager. Server Switches send all SNMP traps to port 162. If you run an 
application other than Element Manager that manages port 162, you must manually register your host in 
each Server Switch that you open with EM to send Server Switch traps to your application. To manually 
register your host, see the “Configuring Your Host as a Trap Receiver” section on page 6-5.

If Element Manager controls port 162 to receive SNMP traps from the Server Switch, you can configure 
host registration and other options. To configure SNMP preferences, perform the following steps:

Step 1 Click the File menu and select Preferences. The Preferences window opens.

Step 2 Click the SNMP tab.

Step 3 Enter an integer value (from 0 to 5) in the Retry Count field to specify the maximum number of retries.

Step 4 Enter an integer value (from 3 to 30) in the Timeout field to configure the SNMP timeout interval, in 
seconds.

Step 5 (Optional) Check the Trace checkbox to begin tracing SNMP traps.

Note You can view the SNMP traps as you trace them with the Trace Log (see the “Viewing Element 
Manager Trace Log” section on page 3-4).

Step 6 (Optional) Check the Register for Traps checkbox to configure Element Manager to automatically add 
your host to the Trap Receivers table on any Server Switch that you open in the EM GUI. If another 
application on your host receives SNMP traps, refer to the “Configuring Your Host as a Trap Receiver” 
section on page 6-5 to send Server Switch traps to that application.

Note When you check the Register for Traps checkbox, Element Manager automatically checks the 
Listen for Traps checkbox.

Step 7 (Optional) Check the Listen for Traps checkbox to receive SNMP traps from the Server Switch.

Note If Element Manager does not let you access this checkbox, uncheck the Register for Traps 
checkbox.

Step 8 Click the OK button.

Configuring Miscellaneous Trap Preferences
To configure miscellaneous trap preferences, perform the following steps:

Step 1 Click the File menu and select Preferences.

Step 2 Click the Misc tab.

Step 3 Enter an integer value in the Max Traps in Log field to limit the number of traps that appear in the log.
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Step 4 (Optional) Check the Confirm row deletion checkbox to confirm the row deletion.

Step 5 (Optional) Check the Save communities in configuration files checkbox to save SNMP communities 
in the configuration file.

Step 6 Click the OK button.

Viewing Element Manager Trace Log
To view the Element Manager trace log, perform the following steps:

Step 1 Click the File menu and select Preferences.

Step 2 Click the SNMP tab.

Step 3 Check the Trace checkbox to begin tracing SNMP traps.

Step 4 Click the Misc tab.

Step 5 Click the Show Element Manager Trace Log checkbox.

Step 6 Click the OK button. The Trace Log window opens.

Refreshing the Element Manager Display
To refresh the Element Manager display to reflect the most recent status of the Server Switch, perform 
one of the following steps:

• Click the File menu and select Refresh.

• Click the Refresh feature button ( ).

Launching a Telnet Session
To refresh the Element Manager display to reflect the most recent status of the Server Switch, perform 
one of the following steps:

• Click the File menu and select Telnet.

• Click the Telnet feature button ( ).

Closing Element Manager
To close Element Manager, click the File menu and select Exit.
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Edit Menu Tasks

This chapter describes the Edit menu tasks for Element Manager and contains these sections:

• Viewing Properties of One Card, page 4-1

• Viewing Properties of All Cards of the Same Type, page 4-4

• Viewing Properties of One Port, page 4-4

• Viewing Properties of All Ports of the Same Type, page 4-8

• Configuring Card Properties, page 4-8

• Configuring Port Properties, page 4-9

Note Use the Edit menu to quickly view port and card properties. You can use the edit menu to choose all cards 
or ports of the same type, and then view the properties of those elements. You can perform Edit menu 
tasks with the EM chassis display. To view and configure the Server Switch from the chassis display, 
refer to the “Chassis Display Tasks” section on page 2-1.

Viewing Properties of One Card
To view the properties of one interface card, perform the following steps:

Step 1 Click the card whose properties you want to view.

Step 2 Click the Edit menu and click Card Properties. A window opens and displays the properties of the card.

Step 3 Click the Card tab. Table 4-1 lists and describes the fields in this display.

Table 4-1 Card Tab Fields

Field Description

Admin Type field (gateway cards only) Administratively configured card type.

Card Type field Dynamically discovered card type.

Enable/Disable Card field Provides up and down radio buttons so you can use the 
Apply button to enable or disable the card.

Current Card Status field Displays “up” if the card can currently run traffic, 
otherwise displays “down.”
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Operational State field Displays the general condition of the interface card. The 
general condition may appear as any of the following:

• unknown

• normal

• wrong-image

• bootFailed

• tooHot

• booting

A condition of unknown indicates an unsupported 
interface card. To address this condition, replace the card 
with a supported card.

The operational state of a card must appear as normal for 
the current status of the card to appear as up.

A wrong-image condition indicates that the active system 
image on the interface card does not match the active 
system image on the controller. All cards must run the 
same active system image as the controller card to 
function.

A bootFailed condition indicates that the active system 
image on the card was incompletely or incorrectly loaded. 
If the other interface cards come up successfully, reset the 
individual card. Otherwise, reboot your entire device.

When your card overheats, the tooHot condition appears 
in the show card command output. Enter the show fan 
command to check to see if your fans failed.

The booting condition indicates that the card has not 
finished loading necessary image data for internal 
configuration.

Table 4-1 Card Tab Fields (continued)

Field Description
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Card Boot Stage field Boot Stage appears as one of the following:

• recovery

• ipl   

• ppcboot 

• fpga 

• pic 

• ib 

• rootfs 

• kernel 

• exe 

• done 

• none

Card Boot Status field Boot Status may appear as any of the following:

• upgrading   

• success

• failed 

• badVersion   

• badCrc

• memoryError 

• outOfSpace   

• programmingError    

• hardwareError 

• fileNotFound 

• inProgress

• none

Serial Number field Factory-assigned product serial number of the card.

PCA Serial Number field Printed circuit assembly (PCA) serial number of the card.

PCA Assembly Number field Printed circuit assembly (PCA) assembly number of the 
card.

FRU Number field Field-replaceable unit (FRU) number of the card.

Table 4-1 Card Tab Fields (continued)

Field Description
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Viewing Properties of All Cards of the Same Type
To view the properties of all interface cards of the same type, perform the following steps:

Step 1 Click Edit > Select All, and then choose the type of card that you want to select. Yellow selection 
boundaries appear around all cards of that type.

Step 2 Click the Edit menu and click Card Properties. A window opens and displays a table of all of the 
properties of the selected cards.

Viewing Properties of One Port
To view the properties from one port, perform the following steps:

Step 1 Click the port whose properties you want to view.

Step 2 Click the Edit menu and click Port Properties. A window opens and displays the properties of the port.

Table 4-2 lists and describes the fields in the properties window of an Ethernet port.

Action field Provides radio buttons that do the following when you 
click the Apply button. 

• Take no action

• Reset (reboot) the card

• Delete inactive images from the card

Result field Displays the result of the last action (from the Action 
field) that a user executed.

Table 4-1 Card Tab Fields (continued)

Field Description

Table 4-2 Ethernet Port Properties Window Field Descriptions

Field Description

Port Type field Displays the port number in slot#/port# notation.

Port Name field Provides a port name that you can edit and apply to the port.

Enable/Disable Port field Provides the up and down radio buttons so you can configure 
the administrative status of the port.

Current Port Status field Indicates whether or not the port is ready for use.

Auto Negotiation Supported field Displays “true” if the port supports autonegotiation.

Enable Auto Negotiation checkbox Enables or disables autonegotiation on the port.
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Table 4-3 lists and describes the fields in the properties window of an Fibre Channel port.

Set Port Speed field Provides radio buttons to let you configure the speed of the 
port.

Current Port Speed field Displays the speed of the port.

Set Duplex field Provides radio buttons to let you configure the duplex setting 
of the port.

Current Duplex field Indicates whether the port runs in full duplex mode or half 
duplex mode.

Enable Link Up/Down Trap field Provides enabled and disabled radio buttons to configure 
whether or not the port sends a trap when links go up or down.

MTU field Displays the maximum transmission unit (MTU) of the port, in 
bytes.

MAC Address field Displays the media access control (MAC) address of the port.

Last Changed On field Displays the time and date of the last time that a user 
configured the port.

Action field Lets you flush the ARP table when you click the Apply button.

Result field Displays the result of the action that you perform from the 
Action field.

Table 4-2 Ethernet Port Properties Window Field Descriptions (continued)

Field Description

Table 4-3 Fibre Channel Port Properties Window Field Descriptions

Field Description

Port Type field Displays the port number in slot#/port# notation.

Port Name field Provides a port name that you can edit and apply to the port.

Enable/Disable Port field Provides the up and down radio buttons so you can configure 
the administrative status of the port.

Current Port Status field Indicates whether or not the port is ready for use.

Auto Negotiation Supported field Displays “true” if the port supports autonegotiation.

Enable Auto Negotiation checkbox Enables or disables autonegotiation on the port.

Set Port Speed field Provides radio buttons to let you configure the speed of the 
port.

Current Connection Type field Type of Fibre Channel connection between the port and the 
SAN.

Current Port Speed field Displays the speed of the port.

Enable Link Up/Down Trap field Provides enabled and disabled radio buttons to configure 
whether or not the port sends a trap when links go up or down.

MTU field Displays the maximum transmission unit (MTU) of the port, 
in bytes.

WWNN field World-wide node name of the HCA of the port.
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Table 4-4 lists and describes the fields in the properties window of an InfiniBand port.

Viewing IP Addresses of an Ethernet Port
To view the IP addresses of one Ethernet port, perform the following steps:

Step 1 Click the Ethernet port whose IP addresses you want to view.

Step 2 Click the Edit menu and click Port Properties. A window opens and displays the properties of the port.

WWPN field World-wide port name of the port.

FC ID field Native Fibre Channel ID of the port.

Last Changed On field Displays the time and date of the last time that a user 
configured the port.

Table 4-3 Fibre Channel Port Properties Window Field Descriptions (continued)

Field Description

Table 4-4 InfiniBand Port Properties Window Field Descriptions

Field Description

Port Type field Displays the port number in slot#/port# notation.

Port Name field Provides a port name that you can edit and apply to the port.

Enable/Disable Port field Provides the up and down radio buttons so you can configure 
the administrative status of the port.

Current Port Status field Indicates whether or not the port is ready for use.

Physical State field Status of the physical connection to the port.

Auto Negotiation Supported field Displays “true” if the port supports autonegotiation.

Enable Auto Negotiation checkbox Enables or disables autonegotiation on the port.

Set Port Speed field Provides radio buttons to let you configure the speed of the 
port.

Current Port Speed field Displays the speed of the port.

Power Connector Dongle Type field Displays the power connector Dongle type. This field appears 
only if the InfiniBand port is supporting power connector.

Enable Link Up/Down Trap field Provides enabled and disabled radio buttons to configure 
whether or not the port sends a trap when links go up or down.

MTU field Displays the maximum transmission unit (MTU) of the port, in 
bytes.

Last Changed On field Displays the time and date of the last time that a user 
configured the port.
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Step 3 Click the IP Addresses tab. The IP Addresses display appears. Table 4-5 lists and describes the fields in 
this display.

Viewing Bridging Properties of an Ethernet Port
To view the bridging properties of one Ethernet port, perform the following steps:

Step 1 Click the Ethernet port whose Bridging properties you want to view.

Step 2 Click the Edit menu and click Port Properties. A window opens and displays the properties of the port.

Step 3 Click the Bridging tab. The Bridging display appears. Table 4-6 lists and describes the fields in this 
display.

Table 4-5 IP Addresses Tab Field Descriptions

Field Description

Port field Port number, in card#port# format. A port# of 0 represents the internal 
gateway port of the interface card.

Address field IP address that you assigned to the port.

Netmask field Subnet mask that you assigned to the port.

BcastAddrFormat field IP broadcast address format that the port uses.

ReasmMaxSize field Size of the largest IP datagram that this port can receive and reassemble 
from incoming fragmented IP datagrams.

Type field Displays “primary” or “backup” to indicate that the interface card acts as 
the primary or backup interface for the IP address that appears in the 
address field.

Status field Displays “active” or “inactive” to indicate that the card actively services 
IP packets addressed to the IP address in the address field or does not 
service packets to the specified address.

Table 4-6 Bridging Tab Field Descriptions

Field Description

Port field Port number, in slot#/port# format.

IEEE VLAN Tag field VLAN of the bridge group.

Bridge Group ID field Bridge group to which the port belongs. Assign the bridge group with the 
Ethernet > Bridging options.
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Viewing Properties of All Ports of the Same Type
To view the properties of all ports of the same type, perform the following steps:

Step 1 Click Edit > Select All, and then choose the type of port that you want to select. Yellow selection 
boundaries appear around all ports of that type.

Step 2 Click the Edit menu and click Port Properties. A window opens and displays a table of all of the 
properties of the selected ports.

Configuring Card Properties
You can configure card properties with the Edit menu or with the chassis display. For chassis display 
instructions, refer to the “Chassis Display Tasks” section on page 2-1.

Configuring Administrative Card Type
Configure administrative card types to reserve Server Switch slots for particular interface cards. You can 
configure administrative card types from a one-card display or a multiple-card display.

Configuring One Card as Administrative Card Type

To configure the card type from one interface card, perform the following steps:

Step 1 Click the card whose type you want to configure.

Step 2 Click the Edit menu and click Card Properties. A window opens and displays the properties of the card.

Step 3 Click the appropriate radio button in the AdminType field, click the Apply button, and then click the 
Close button.

Configuring Multiple Cards as Administrative Card Types

To configure the card types from multiple interface cards, perform the following steps:

Step 1 Click Edit > Select All, and then choose the type of card that you want to select. Yellow selection 
boundaries appear around all cards of that type.

Step 2 Click the Edit menu and click Card Properties. A window opens and displays a table of all of the 
properties of the selected cards.

Step 3 Click the type, in the AdminType column, of the card that you want to configure. A pulldown menu 
appears. Choose a value from the pulldown menu, and then repeat this step for each additional card that 
you want to configure.
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Enabling or Disabling a Card
You can enable and disable cards from a one-card display or a multiple-card display.

Enabling or Disabling Cards from One Card

To enable or disable cards from a one-card display, perform the following steps:

Step 1 Click the card that you want to enable or disable.

Step 2 Click the Edit menu and click Card Properties. A window opens and displays the properties of the card.

Step 3 Click the up or down radio button, click the Apply button, and then click the Close button.

Enabling or Disabling Cards from Multiple Cards

To enable or disable cards from a multiple-card display, perform the following steps:

Step 1 Click Edit > Select All, and then choose the type of card that you want to select. Yellow selection 
boundaries appear around all cards of that type.

Step 2 Click the Edit menu and click Card Properties. A window opens and displays a table of all of the 
properties of the selected cards.

Step 3 Click the status, in the Enable/Disable Card column, of the card that you want to enable or disable. A 
pulldown menu appears. Choose up or down, and then repeat this step for each additional card that you 
want to enable or disable.

Configuring Port Properties
You can use the edit menu to configure port properties, or you can use the chassis display directly. To 
configure port properties from the chassis display, refer to the “Chassis Display Tasks” section on 
page 2-1.

Configuring Port Name
You can rename ports from a one-port display or a multiple-port display.

Configuring the Name of One Port

To configure the name from one port, perform the following steps:

Step 1 Click the port whose name you want to change.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays port details.
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Step 3 Edit the name in the Port Name field, click the Apply button, and then click the Close button.

Configuring the Names of Multiple Ports

To configure the names from multiple ports, perform the following steps:

Step 1 Click Edit > Select All, and then click the type of the ports whose names you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays a tabular layout of the 
properties of the ports.

Step 3 Double-click the text in the Port Name column of a port that you want to rename, and then edit the name. 
Repeat this step for all ports that you want to rename.

Step 4 Click the Apply button, and then click the Close button.

Enabling or Disabling a Port
You can enable or disable ports from a one-port display or a multiple-port display.

Enabling or Disabling a Port from One Port

To enable or disable one port, perform the following steps:

Step 1 Click the port that you want to enable or disable.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays port details.

Step 3 In the Enable/Disable Port field, click the up radio button or down radio button.

Step 4 Click the Apply button, and then click the Close button.

Enabling or Disabling Ports from Multiple Ports

To enable or disable ports from multiple ports, perform the following steps:

Step 1 Click Edit > Select All, and then click the type of the ports whose names you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays a tabular layout of the 
properties of the ports.

Step 3 Click the cell in the Enable/Disable Port column of a port that you want to enable or disable, and then 
choose up or down from the pulldown menu that appears.

Step 4 Click the Apply button, and then click the Close button.
4-10
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 4      Edit Menu Tasks
  Configuring Port Properties
Enabling or Disabling Autonegotiation
You can enable or disable autonegotiation on ports from a one-port display or a multiple-port display.

Enabling or Disabling Autonegotiation from One Port

To enable or disable autonegotiation on a port from one port, perform the following steps:

Step 1 Click the port that you want to enable or disable.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays port details.

Step 3 Check or uncheck the Enable Auto-Negotiation checkbox.

Step 4 Click the Apply button, and then click the Close button.

Enabling or Disabling Autonegotiation from Multiple Ports

To enable or disable autonegotiation on ports from multiple ports, perform the following steps:

Step 1 Click Edit > Select All, and then click the type of the ports whose names you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays a tabular layout of the 
properties of the ports.

Step 3 Click the cell in the Enable Auto-Negotiation column of a port that you want to configure, and then 
choose true or false from the pulldown menu that appears.

Step 4 Click the Apply button, and then click the Close button.

Configuring the Port Speed
You can configure port speed from a one-port display or a multiple-port display.

Note You must disable autonegotiation on a port before you assign a speed to the port.

Configuring the Port Speed from One Port

To configure port speed from one port, perform the following steps:

Step 1 Click the port that you want to enable or disable.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays port details.

Step 3 Click the radio button, in the Set Port Speed field, of the speed that you want to apply.

Step 4 Click the Apply button, and then click the Close button.
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Configuring the Port Speed from Multiple Ports

To configure port speed on ports from multiple ports at once, perform the following steps:

Step 1 Click Edit > Select All, and then click the type of the ports whose names you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays a tabular layout of the 
properties of the ports.

Step 3 Click the cell in the Set Port Speed column of a port that you want to configure, and then choose the 
speed that you want to apply from the pulldown menu that appears. Repeat this step for all ports that you 
want to configure.

Step 4 Click the Apply button, and then click the Close button.

Enabling or Disabling Link Up/Down Traps
You can enable or disable link up and link down traps from a one-port display or a multiple-port display.

Enabling or Disabling Link Up/Down Traps from One Port

To enable or disable up/down traps from one port, perform the following steps:

Step 1 Click the port that you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays port details.

Step 3 Click the enabled or disabled radio button in the Enable Link Up/Down Trap field.

Step 4 Click the Apply button, and then click the Close button.

Enabling or Disabling Link Up/Down Traps from Multiple Ports

To enable or disable up/down traps from multiple ports, perform the following steps:

Step 1 Click Edit > Select All, and then click the type of the ports whose names you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays a tabular layout of the 
properties of the ports.

Step 3 Click the cell in the Enable Link Up/Down Trap column of a port that you want to configure, and then 
choose enabled or disabled from the pulldown menu that appears. Repeat this step for all ports that you 
want to configure.

Step 4 Click the Apply button, and then click the Close button.
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Executing Port Actions
Some port types can execute specific actions. You can execute actions from a one-port display or a 
multiple-port display.

Executing Port Actions from One Port

To execute actions from one port, perform the following steps:

Step 1 Click the port that you want to enable or disable.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays port details.

Step 3 In the Action field, click the radio button of the action that you want to execute.

Step 4 Click the Apply button, and then click the Close button.

Executing Port Actions from Multiple Ports

To execute actions from multiple ports, perform the following steps:

Step 1 Click Edit > Select All, and then click the type of the ports whose names you want to configure.

Step 2 Click the Edit menu and choose Port Properties. A window opens and displays a tabular layout of the 
properties of the ports.

Step 3 Click the cell in the Action column of a port on which you want to execute an action, and then choose 
the action from the pulldown menu that appears. Repeat this step for every port on which you want to 
execute an action.

Step 4 Click the Apply button, and then click the Close button.
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C H A P T E R 5

Maintenance Menu Tasks

This chapter describes the Maintenance menu tasks of Element Manager and contains these sections:

• Viewing Basic System Information, page 5-1

• Configuring Basic System Information, page 5-3

• Configuring Date and Time Properties, page 5-4

• Configuring Basic Services, page 5-5

• Viewing RADIUS Servers, page 5-6

• Customizing the Boot Configuration, page 5-9

• Backing Up the Running Configuration File, page 5-10

• Viewing Files in the File System, page 5-10

• Installing Software Images, page 5-12

• Importing Configuration Files and Image Files, page 5-15

• Exporting Configuration Files and Log Files, page 5-16

• Saving a Configuration File, page 5-17

• Rebooting the Server Switch with Element Manager, page 5-17

• Running General Diagnostics, page 5-18

• Viewing POST Diagnostics, page 5-20

• Viewing FRU Diagnostics, page 5-21

Note The Maintenance menu provides opportunities to monitor your Server Switch and configure 
fundamental behavior.

Viewing Basic System Information
Basic system information includes the name of your device, the location of your device, and support 
resources.

To view basic system information, perform the following steps:
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Step 1 Click the Maintenance menu and choose System Info. The System Info window opens. Table 5-1 lists 
and describes the fields in the window.

Step 2 Click the Global Setting tab to display the Global Settings shown in Figure 5-1.

Figure 5-1 Global Settings

Step 3 Table 5-2 lists and describes the fields in the Global Settings window.

Table 5-1 System Info Window Fields

Element Description

Description field Description of the chassis and the image that runs on the chassis.

System Uptime field Amount of time that the chassis has run since the last boot.

Last Change Made At field Date and time that a user last changed the running configuration.

Last Config Saved At field Date and time that a user last saved the running configuration as the 
startup configuration.

System Name field Configurable name for your Server Switch.

Location field Configurable location of your Server Switch.

Support Contact field Configurable support information for your Server Switch.

Rack Locator UID field (select 
chassis)

Unique identifier (UID) for the Rack Locator test.

SystemSyncState field Displays SFS-7008 system synchronization state information.

Table 5-2 Global Settings Window Fields

Element Description 

Enable Ib Counter Reset: When checked, resets the Enable Ib counter.

SystemOperMode field Provides the Normal radio button for non-VFrame 
systems and the VFrameManaged radio button for 
systems in a VFrame environment. For more 
information, refer to VFrame documentation.
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Configuring Basic System Information
Basic system information includes the name of your device, the location of your device, and support 
resources.

Naming Your InfiniBand Switch
To assign a hostname to your device, perform the following steps:

Step 1 Click the Maintenance menu and choose System Info. The System Info window opens.

Step 2 In the System Name field, type the name that you want to assign to the device, and then click the Apply 
button.

Defining Device Location
To add a physical device location description to your switch, perform the following steps:

Step 1 Click the Maintenance menu and choose System Info. The System Info window opens.

Step 2 In the Location field, type the name location of your device, and then click the Apply button.

Defining Technical Support Resource
The technical support e-mail address that you define appears in the System frame when you refresh or 
restart Element Manager. To define a technical support resource, perform the following steps:

Step 1 Click the Maintenance menu and choose System Info. The System Info window opens.

Step 2 In the Support Contact field, type the e-mail address of your technical support provider, and then click 
the Apply button.

Configuring SystemOperMode
Configure SystemOperMode status to alter the behavior of the Server Switch to respond appropriately 
to a VFrame environment or a non-VFrame environment. To configure SystemOperMode, perform the 
following steps:

Step 1 Click the Maintenance menu and choose System Info. The System Info window opens.

Step 2 In the SystemOperMode field, click one of the following radio buttons:

– Click Normal to configure the Server Switch for a non-VFrame environment.
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– Click VFrameManaged to configure the Server Switch for a VFrame-managed environment.

Step 3 Click the Apply button.

Configuring Date and Time Properties
An internal clock runs on your device, but we recommend that you configure your device to access a 
network time protocol (NTP) server to synchronize your device with your network.

Configuring Date and Time
To configure the date and time of the internal clock on your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Time. The Date and Time Properties window opens.

Step 2 In the Date field, enter the date in the MM/DD/YY format.

Step 3 In the Time field, enter the time in HH:MM:SS format, and then click the Apply button.

Step 4 Click the Apply button in the Date and Time partition.

Assigning NTP Servers
To configure your device to use an NTP server to synchronize your Server Switch with the network, 
perform the following steps:

Step 1 Click the Maintenance menu and choose Time. The Date and Time Properties window opens.

Step 2 In the NTP Server 1 field, enter the IP address of the NTP server that you want your Server Switch to use.

Step 3 (Optional) In the NTP Server 2 field, enter the IP address of the NTP server that you want your switch 
to use in the event that your switch cannot access the primary NTP server.

Step 4 (Optional) In the NTP Server 3 field, enter the IP address of the NTP server that you want your switch 
to use in the event that your switch cannot access the primary or secondary NTP servers.

Step 5 Click the Apply button in the NTP Servers partition.

Note When your device cannot access a NTP server, it defaults to the onboard clock.
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Configuring Basic Services
You can configure basic services to facilitate remote access to your device.

Assigning a DNS Server
To assign a DNS server to your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the DNS tab.

Step 3 In the Server 1 field, enter the IP address of the primary DNS server that you want to use.

Step 4 (Optional) In the Server 2 field, enter the IP address of the DNS server that you want to use if your device 
cannot access the primary DNS server.

Step 5 In the Domain field, enter the domain to which you want your switch to belong, and then click the Apply 
button.

Enabling or Disabling the FTP Access
To enable or disable FTP transfers to and from your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the FTP tab.

Step 3 Check (to enable) or uncheck (to disable) the Enable FTP Server checkbox, and then click the Apply 
button.

Enabling or Disabling the Telnet Access
To enable or disable Telnet access to your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the Telnet tab.

Step 3 Check (to enable) or uncheck (to disable) the Enable Telnet Server checkbox, and then click the Apply 
button.
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Assigning a SYSLOG Server

Note This task assumes that you have already configured the host and connected it to the IB fabric.

To assign a syslog server to store logs from your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the Syslog tab.

Step 3 In the Remote Syslog Server field, enter the IP address of the remote server to accept messages from 
your device, and then click the Apply button.

Assigning an Authentication Method
To assign an authentication method to your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the Radius tab.

Step 3 In the Authentication Method field, click a radio button to choose a method, and then click the Apply 
button. Table 5-3 lists and describes the radio buttons that you can choose.

Viewing RADIUS Servers
To view the RADIUS servers that you have configured your device to use to authenticate CLI and 
Element Manager logins, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Table 5-3 CLI Authentication Methods

Button Description

local Authenticates user logins with the local CLI user database only.

localThenRadius Authenticates user logins with the local CLI user database. Upon failure, 
authenticates with the RADIUS server.

radiusThenLocal Authenticates user logins with the RADIUS server. Upon failure, authenticates 
with the local CLI user database.
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Step 2 Click the Radius Servers tab. Table 5-4 lists and describes the fields in the Radius Servers table.

Adding RADIUS Servers

To configure a new RADIUS server on your device, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the Radius Servers tab.

Step 3 Click the Insert button. The Insert Radius Server window opens.

Table 5-4 Radius Server Properties Window Elements

Element Description

Address field Displays the IP address of the RADIUS server.

UDP Port field UDP authentication port of the RADIUS server.

Edit this value and click the Apply button to configure the UDP port of the 
RADIUS server. The numbers to the right of the field indicate the range of 
integer values that this field supports.

Encryption Key field Authentication key that the client and RADIUS server use.

Enter a value and click the Apply button to configure the encryption key of 
the RADIUS server. The numbers to the right of the field indicate the range 
of integer values that this field supports.

Timeout field Amount of time, in seconds, in which the server must authenticate a login 
before the login fails.

Edit this value and click the Apply button to configure the timeout value of 
the RADIUS server. The numbers to the right of the field indicate the range 
of integer values that this field supports.

Max Retries field Number of sequential logins that a user may perform before the server denies 
access to the username altogether.

Edit this value and click the Apply button to configure the maximum number 
of retries that the RADIUS server permits. The numbers to the right of the 
field indicate the range of integer values that this field supports.

Access Requests field Number of authentication requests that the server has received from your 
device since your device booted.

Access Accepts field Number of logins to your device that the server authenticated since your 
device booted.

Access Rejects field Number of logins to your device that the server denied since your device 
booted.

Server Timeout field Number of authentications that timed out on the server since your device 
booted.
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Note Click the Close button at any time to abort this process with no changes to your device. 
Configurations apply only after you click the Apply button.

Step 4 In the Address field, enter the IP address of the server.

Step 5 (Optional) Edit the UDP Port field. The numbers to the right of the field indicate the range of integer 
values that this field supports.

Step 6 (Optional) Enter an encryption key in the Encryption Key field.

Step 7 (Optional) Edit the Timeout field. The numbers to the right of the field indicate the range of integer 
values that this field supports.

Step 8 (Optional) Edit the Max Retries field. The numbers to the right of the field indicate the range of integer 
values that this field supports.

Step 9 Click the Insert button.

Editing a RADIUS Server Configuration

To remove a RADIUS server from your configuration, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the Radius Servers tab.

Step 3 Identify the row of the RADIUS server that you want to reconfigure, and then double-click the cell that 
you want to edit.

Note You can only edit cells that have a white background.

Step 4 Edit the content of the cell.

Step 5 Click the Apply button.

Step 6 Delete RADIUS Servers.

To remove a RADIUS server from your configuration, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the Radius Servers tab.

Step 3 Click the row entry of the RADIUS server that you want to delete.

Step 4 Click the Delete button.
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Enabling HTTP Services
To configure RADIUS services, perform the following steps:

Step 1 Click the Maintenance menu and choose Services. The Services window opens.

Step 2 Click the HTTP tab.

Step 3 Check the Enable HTTP Server checkbox.

Step 4 (Optional) Assign a port in the HTTP Port field.

Step 5 (Optional) Check the Enable HTTP Polling checkbox.

Step 6 (Optional) Check the Enable HTTPS Server checkbox.

Step 7 (Optional) Assign a port in the HTTPS Port field.

Step 8 Select a security method from the Secure Cert Common Name field.

Step 9 Click the Apply button.

Customizing the Boot Configuration
To customize the boot configuration do the following:

• View the image that the switch will boot during the next reboot.

• Delete the startup configuration.

• Overwrite the startup configuration with another configuration file in your file system.

Configuring Reboot Image
To choose the image that the Server Switch loads when it reboots, perform the following steps:

Step 1 Click the Maintenance menu and choose Boot Config. The Boot Configuration window opens.

Step 2 From the Image Source For Next Reboot pulldown menu, choose the image that you want the Server 
Switch to boot when it reboots.

Step 3 Click the Apply button in the Software Images partition.

Deleting or Overwriting the Startup Configuration

Step 1 Click the Maintenance menu and choose Boot Config. The Boot Configuration window opens.

Step 2 (Optional) Click the Overwrite startup configuration with radio button, and then choose a configuration 
from the pulldown menu to replace the current startup configuration with another configuration file.
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Note To overwrite your startup configuration with your running configuration, refer to the “Backing 
Up the Running Configuration File” section on page 5-10.

Step 3 (Optional) Click the Delete startup configuration radio button to configure your Server Switch to use 
the factory default startup configuration.

Step 4 Click the Apply button in the Startup Configuration partition.

Backing Up the Running Configuration File
To save your running configuration file, perform the following steps:

Step 1 Click the Maintenance menu and choose Backup Config. The Backup Configuration window opens.

Step 2 Enter a file name in the Save Configuration As field. Element Manager will save your running 
configuration in the configuration directory with the name that you specify.

Note Enter startup-config in this field if you want to save the running configuration as the startup 
configuration. This process overwrites the existing startup configuration file.

Step 3 Click the Save button.

Viewing Files in the File System
To view files, such as image files, log files, and configuration files, that reside on your device, perform 
the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens. 
Table 5-5 lists and describes the fields in the Current Files on System table in this window.

Table 5-5 Current Files on System Table Field Descriptions

Field Description

Slot ID Slot of the controller card on which the file resides.

File Name Name of the file.

File Type Type of file. The following types may appear:

config

log

image
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Step 2 (Optional) Click the Refresh button to poll your switch and update your display to reflect the most 
current inventory of your file system.

Deleting Files in the File System
To delete files from your file system, perform the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens.

Step 2 Click the line in the Current Files on System table that lists the file that you want to delete, and then 
click the Delete button. A Delete File window opens.

Step 3 Click the Yes button.

Understanding Configuration Files
A configuration file is a text file that stores a list of CLI commands.

Startup-Config

The main configuration file is called startup-config. This file stores all of the CLI commands necessary 
to completely configure a box from a factory default state. This configuration file can be copied, backed 
up, and modified. 

Running-Config

Whenever configuration changes are made via the GUI or CLI, a CLI command is temporarily saved in 
a virtual configuration file called running-config. If the administrator wishes to save these changes 
permanently, this file is copied into the startup-config file. 

Any number of configuration files can be stored. For convenience and rapid configuration, files can also 
maintain a partial list of CLI commands. These files can also be copied into running-config for 
immediate use or startup-config for persistent use across reboots.

Size Size of the file, in bytes.

Date Most recent date and time that your device or a user updated the file.

Table 5-5 Current Files on System Table Field Descriptions (continued)

Field Description
5-11
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 5      Maintenance Menu Tasks
  Installing Software Images
Understanding Log Files
Log files are text files that record activity, including configuration changes. Depending on their size, log 
files are rotated and compressed. Log files can also be exported from the system by using the copy 
command. 

File Management and Storage

The management of log files is performed automatically, but you can configure log files. Log files are 
stored separately from other file types, but all files share the 128 MB of flash memory. Log files are 
stored in syslog files.

The system checks the size of the active log file hourly, and when it exceeds 1 MB, the active log file, 
ts_log, is closed, compressed, and renamed ts_log.1.gz. Other ts_log.x.gz files are incremented by 1. 
These files can be downloaded via the Log Viewer GUI, which can create filters for troubleshooting and 
auditing purposes. 

Message Types

The following levels of logging are captured:

• CONF—configuration changes; no user action is required.

• INFO—general information; no user action is required.

• WARN— abnormal condition; user intervention may be required.

• ERROR— abnormal condition; user intervention is required.

• FATAL—abnormal condition; user must reboot.

Installing Software Images
To proceed to the instructions, refer to the “Installing a Software Image” section on page 5-15. The 
sections that follow provide context and details about installing images.

The Image data that is used to configure the software is being continuously updated and enhanced. Use 
the latest system image data to ensure the most efficient usage of your system. 

Refer to the user’s support portal at support.cisco.com for the latest upgrades.

System Image
A system image is an unpacked and installed image file. An image file is the source from which to install 
a system image and it has an .img extension. 

When an image file is installed, the image file is expanded into a system image. The system image is 
what the user will refer to in order to specify what the system should use to boot up each card in the 
system. 
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Image File
Image files are stored in flash memory as a single complete file with an “.img” extension. Each image 
file contains all the operating software (application software and firmware/microcode) needed by the 
various cards that can be installed into the system. 

The system cannot use an image file directly to boot up the system. The image file must first be installed. 
The installation process automatically unbundles the image file and distributes the software components 
to each card in the system. Users do not have to be aware of individual software components. The user 
executes one CLI command to install an image file. Refer to the install command in the CLI Reference 
Guide. 

The Server Switch operating system stores up to three images on a disk: the uninstalled image, the 
current system (or installed) image, and the recovery image. 

The system only has enough flash memory to store:

• one system image file (active)

• one image file (inactive/uninstalled)

• one recovery image

Occasionally, you will have to manually delete an image file from the InfiniBand system to make room 
for a new version. Refer to the “Deleting Files in the File System” section on page 5-11. 

Inactive Image

An inactive image is an image that has been downloaded, but has not been installed. It is not the active, 
or system image. 

The operating system can only store one inactive image. Delete inactive images through the CLI (refer 
to the “Deleting Files in the File System” section on page 5-11), or by clicking the delete button in the 
Element Manager. 

Active Image

An active image is the current system image. An installed, or active image has gone through the entire 
upgrade process. The system image usually has a slash (/) in its name. Do not modify or delete the 
installed system image. 

Recovery Image

The Recovery Image is a default image that comes installed on the system. The Recovery Image can be 
used to quickly restore operation to the system if an image upgrade should fail. 

Version Numbers

The operating system and installed system image running on the InfiniBand system determine the 
supported software features. 

Two types of system-images are provided:

• An image for the HCA card 

• An image for the Cisco SFS 7000, Cisco SFS 7008, Cisco SFS 7008, or Cisco IB Server Switch 
Module.
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Before configuring the InfiniBand system, check the version of the installed system image used to boot 
the chassis. Use this information to ensure that you upgrade to the correct software.

Copying/Downloading the Image
Upgrading the Server Switch operating system requires several steps, which are described in the 
following sections. One step is to copy the image before installing it. 

Table 5-6 lists several options for copying the image into the system.

Card Status Requirements
Only cards with an oper-status of “up” are updated. If a card is down when you run install, or a card is 
added after running install, perform the following steps:

Step 1 Bring up the card 

Step 2 Run the installation again.

Step 3 Specify the same image file. If the image is already installed on a card, that card is skipped. 

Step 4 Be sure to specify the boot-config again so that all cards know to boot from the same system image.

Upgrade Procedure Overview
The system upgrade process is summarized in the following steps:

Step 1 Set up the hardware connection for the upgrade.

Step 2 Verify the installed system image version number.

Step 3 Download an image file from a network-accessible FTP server, or download an image file remotely from 
a TFTP server. 

Step 4 Install the new system image.

Step 5 Configure the CLI and Element Manager to use the appropriate configuration file the next time they 
reboot.

Step 6 Reboot the system.

Table 5-6 Copying/Downloading Image Options

Through the CLI Through the GUI

FTP Remote FTP Server

TFTP Local File

SCP Remote Secure Server
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Installing a Software Image
To install an image file, perform the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens.

Note If you have not already imported an image file to your file system, refer to the “Importing 
Configuration Files and Image Files” section on page 5-15.

Step 2 Click the line in the Current Files on System table that lists the file that you want to install, and then 
click the Install button. A verification window opens.

Note Before you install an image, verify that you have brought up all of the cards on the chassis that 
you want to run the new image. Cards that run a different image from the chassis cannot pass 
traffic.

Note Alert other users that you plan to install a new image to your Server Switch.

Step 3 Click the Yes button to install the image.

Importing Configuration Files and Image Files
You can import files to your Server Switch from your local host or a remote FTP server.

Importing from a Remote Server
To import files to your Server Switch from remote devices, perform the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens.

Step 2 Click the Import button. The Import File window opens.

Step 3 From the File Type pulldown menu, choose the type of file that you want to import (image or 
configuration).

Step 4 Click the Remote FTP Server radio button or Remote SCP Server radio button.

Step 5 Enter the DNS name or IP address of the FTP server that holds the file that you want to import in the 
Server Name or IP Address field.

Step 6 Enter the user ID that logs you in to the FTP server in the User Name field.

Step 7 Enter the password that logs you in to the FTP server in the Password field.

Step 8 Enter the directory path and name of the file on the FTP server in the File Path and Name field.

Step 9 Enter the name that the file will take on your Server Switch in the File Name on System field.
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Step 10 Click the Copy button.

Importing from Your Local Host
To import files to your Server Switch from your local host, perform the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens.

Step 2 Click the Import button. The Import File window opens.

Step 3 Select, from the File Type pulldown menu, the type of file that you want to import (image or 
configuration).

Step 4 Click the Local File radio button.

Step 5 Click the Choose button and navigate to the file that you want to import.

Step 6 Click the file that you want to import, and then click the OK button.

Step 7 Enter the name that the file will take on your Server Switch in the File Name on System field.

Step 8 Click the Copy button.

Exporting Configuration Files and Log Files
You can export files from your Server Switch to your local host or a remote FTP server.

Exporting to a Remote Server
To export files from your Server Switch to a remote device, perform the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens.

Step 2 Click the file that you want to export. The Export button becomes active.

Step 3 Click the Export button. The Export File window opens.

Step 4 Click the Remote FTP Server radio button or Remote SCP Server radio button.

Step 5 In the Server Name or IP Address field, enter the DNS name or IP address of the FTP server that will 
receive the file that you want to export.

Step 6 In the User Name field, enter the user ID that logs you in to the FTP server.

Step 7 In the Password field, enter the password that logs you in to the FTP server.

Step 8 In the File Path and Name field, enter the path on your remote host where you want to copy the exported 
file, and the name that you want to assign for the file.

/root/files/old-config.cfg

Step 9 Click the Copy button.
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Exporting to Your Local Host
To export files from your Server Switch to your local host, perform the following steps:

Step 1 Click the Maintenance menu and choose File Management. The File Management window opens.

Step 2 Click the file that you want to export. The Export button becomes active.

Step 3 Click the Export button. The Export File window opens.

Step 4 Click the Local File radio button.

Step 5 Click the Choose button.

Step 6 Navigate to the directory where you want to copy the file, and then click the OK button.

Step 7 Click the Copy button.

Saving a Configuration File
To back up your running configuration to the standby controller on your chassis, perform the following 
steps:

Step 1 Click the Maintenance menu and choose Save Config.

Note If you make configuration changes to the master image and then save the configuration, verify that the 
master and backup have synchronized, and then save the configuration on the backup as well. For more 
information, see the “Configuring Database Synchronization” section on page 8-25.

Rebooting the Server Switch with Element Manager
To reboot your Server Switch with Element Manager, perform the following steps:

Step 1 Click the Maintenance menu and choose Reboot.

Step 2 Click the OK button.
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Running General Diagnostics
With Element Manager, you can run the following diagnostics:

• chassis

• card

• port

Running Chassis Diagnostics
To run chassis diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > General.

Step 2 Click the Chassis tab.

Step 3 In the Module Type field, click the radio button of the type of the element that you want to diagnose.

Step 4 Enter the index number of the element that you want to diagnose in the Module Number field.

Step 5 In the Test field, click the radio button of the type of test that you want to run.

Step 6 Enter the number of times that you want the test to run in the Iterations field.

Step 7 In the Action field, click the start radio button to begin a test or the stop radio button to end a test.

Step 8 In the Option field, click the error condition that you want to apply.

Step 9 Click the Apply button to execute the configuration and start or stop the test.

Configuring Card Diagnostics
To run card diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > General.

Step 2 Click the Card tab.

Step 3 Click the Insert button. The Diagnostic, Insert Card window opens.

Step 4 Click the Card pulldown menu and choose the card that you want to test.

Step 5 In the Test field, click the type of test that you want to execute.

Step 6 In the Iterations field, click the number of test iterations that you want to run.

Step 7 Choose an action from the Action field:

– Click the start radio button if you want the test to run when you click the Insert button 

• Click the stop radio button if you want the test to appear in the table but not execute. To run the 
test later, see the “Running Configured Diagnostic Tests” section on page 5-20.

Step 8 Click the Insert button.
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Deleting a Card Test Entry
To delete a card test entry, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > General.

Step 2 Click the Card tab.

Step 3 Click the row of the entry that you want to delete, and then click the Delete button.

Configuring Port Diagnostics
To run port diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > General.

Step 2 Click the Port tab.

Step 3 Click the Insert button. The Diagnostic, Insert Port window opens.

Step 4 Enter a port in the Port field, or click the “...” button, choose ports, and click the OK button.

Step 5 In the Test field, click the radio button of the test that you want to execute.

Step 6 (Optional) Check the Data Validation checkbox to validate data.

Step 7 Enter the size, in bits, of the data packet that you want to send in the Data Size field.

Step 8 Enter the data pattern that you want to iterate in the test in the Data Pattern field.

Step 9 Enter the number of iterations that you want to execute in the Iterations field.

Step 10 Enter a source LID in the Source ID field.

Step 11 Enter a destination LID in the Target ID field.

Step 12 Select an action from the Action field:

– Click the start radio button if you want the test to execute when you click the Insert button.

– Click the stop radio button if you want the test to appear in the table but not execute. To execute 
the test later, see “Running Configured Diagnostic Tests” section on page 5-20.

Step 13 Click the Insert button.

Deleting a Port Test Entry

To delete a card test entry, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > General.

Step 2 Click the Port tab.

Step 3 Click the row of the entry that you want to delete, and then click the Delete button.
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Running Configured Diagnostic Tests
To run a diagnostic test that you have already added to the Diagnostics window, perform the following 
steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > General.

Step 2 Click the appropriate tab for the test that you want to run.

Step 3 Identify the entry of the test that you want to run.

Step 4 Click the cell in the Action column of that entry and choose start from the pulldown menu.

Note The cell must display stop for this process to work. If the cell displays start, choose stop from 
the pulldown menu and click the Apply button, and then perform this step.

Step 5 Click the Apply button, and then repeatedly click the Refresh button to track the progress of the test.

Viewing POST Diagnostics
You can view POST diagnostics for the following elements:

• Cards

• Power Supplies

• Fans

Viewing Card POST Diagnostics
To view card POST diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > POST.

Step 2 Click the Card tab. Table 5-7 lists and describes the fields that appear.

Table 5-7 Card POST Field Descriptions

Field Description

Slot ID Slot number.

POST Status Indicates the result of POST (Power-on-self-test):

unknown

passed

failed

PostErrorCodes Show error(s) detected during POST.
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Viewing Power Supply POST Diagnostics
To view power supply POST diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > POST.

Step 2 Click the Power Supply tab. Table 5-8 lists and describes the fields that appear.

Viewing Fan POST Diagnostics
To view fan POST diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > POST.

Step 2 Click the Fan tab. Table 5-9 lists and describes the fields that appear.

Viewing FRU Diagnostics
You can view FRU diagnostics for the following elements:

Table 5-8 Card POST Field Descriptions

Field Description

PS ID Power supply number.

POST Status Indicates the result of POST:

unknown

passed

failed

PostErrorCodes Show error(s) detected during POST.

Table 5-9 Card POST Field Descriptions

Field Description

Fan ID Fan number.

POST Status Indicates the result of POST):

• unknown

• passed

• failed

PostErrorCodes Show error(s) detected during POST.
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• cards

• power supplies

• fans

Viewing Card FRU Diagnostics
To view card FRU diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > POST.

Step 2 Click the Card tab. Table 5-10 lists and describes the fields that appear.

Viewing Power Supply FRU Diagnostics
To view power supply FRU diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > POST.

Step 2 Click the Power Supply tab. Table 5-11 lists and describes the fields that appear.

Viewing Fan FRU Diagnostics
To view fan FRU diagnostics, perform the following steps:

Step 1 Click the Maintenance menu, and then choose Diagnostics > POST.

Table 5-10 Card POST Field Descriptions

Field Description

Slot ID Slot number.

FruError Shows the last hardware error (if any) detected on this FRU. The information 
returned in this variable is read from the device’s VPD.

Table 5-11 Card POST Field Descriptions

Field Description

PS ID Power supply number.

FruError Shows the last hardware error (if any) detected on this FRU. The information 
returned in this variable is read from the device’s VPD.
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Step 2 Click the Fan tab. Table 5-12 lists and describes the fields that appear.

Table 5-12 Card POST Field Descriptions

Field Description

Fan ID Fan number.

FruError Shows the last hardware error (if any) detected on this FRU. The information 
returned in this variable is read from the device’s VPD.
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Health Menu Tasks

This chapter describes the Health menu tasks for Element Manager and contains these sections:

• Viewing Health Summary, page 6-1

• Viewing Power Supply Status, page 6-2

• Viewing Fan Status, page 6-2

• Viewing Sensor Status, page 6-3

• Configuring Your Host as a Trap Receiver, page 6-5

• Viewing Logs, page 6-6

Note The Health menu provides options that let you verify the status of your Server Switch. With Health menu 
options, you can view the operational status of Server Switch and view logs of Server Switch events.

Viewing Health Summary
To view a summary of the health of your Server Switch, perform the following steps:

Step 1 Click the Health menu and choose Status. The Health Status window opens.

Step 2 Click the Summary tab. Table 6-1 lists and describes the Summary tab field.

Table 6-1 Summary Tab Field Descriptions

Field Description

Up Time Displays amount of time that the switch has been up since the last reboot.

Power Displays a green check if all power supplies function successfully. Displays a red X if a 
power supply experiences a problem.

Fans Displays a green check if all fans function successfully. Displays a red X if a fan 
experiences a problem.

Sensors Displays a green check if all temperature sensors function successfully. Displays a red X 
if a temperature sensor experiences a problem or if the temperature exceeds the safe 
threshold.
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Viewing Power Supply Status
To view the status of the power supplies on your Server Switch, perform the following steps:

Step 1 Click the Health menu and choose Status. The Health Status window opens.

Step 2 Click the Power Supplies tab. Table 6-2 lists and describes the Power Supplies tab field.

Viewing Fan Status
To view the status of the fans on your Server Switch, perform the following steps:

Step 1 Click the Health menu and choose Status. The Health Status window opens.

Step 2 Click the Fans tab. Table 6-3 lists and describes the Fans tab field.

Table 6-2 Power Supplies Tab Field Descriptions

Field Description

PS ID Numeric identifier of the power supply. For more information on the power 
supplies in your device, refer to your hardware documentation.

Type Type of power (AC or DC).

Admin Status Displays the status to which a user has configured the power supply.

Oper Status Displays “up” to indicate that your power supply functions and currently 
supplies power to your device. Displays “down” for faulty power supplies.

Utilization Percentage of total power supply resources in use.

Voltage Voltage of the power supply.

Product Serial Number Factory-assigned product serial number.

PCA Serial Number Printed circuit assembly (PCA) serial number.

PCA Assembly Number Printed circuit assembly (PCA) assembly number.

FRU Number Field replaceable unit (FRU) number.

Table 6-3 Fans Tab Field Descriptions

Field Description

FanId Numeric identifier of the fan. For more information on the fans in your 
device, refer to your hardware documentation.

OperStatus Displays “up” if the fan functions properly; otherwise, displays “down.”

Speed Displays the speed of the fan in percentage of maximum speed.

ProductSerialNum Factory-assigned product serial number.

PcaSerialNum Printed circuit assembly (PCA) serial number.
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Viewing Sensor Status
To view the status of the temperature sensors on your Server Switch, perform the following steps:

Step 1 Click the Health menu and choose Status. The Health Status window opens.

Step 2 Click the Sensors tab. Table 6-4 lists and describes the Sensors tab field.

Viewing Server Switch Events
When you configure your local host to receive Server Switch events, you can then view a log of the 
events. Before you view Server Switch events, refer to the “Configuring Your Host as a Trap Receiver” 
section on page 6-5.

To view Server Switch events on a host that you have configured to receive events, perform the following 
tasks:

Step 1 Click the Health menu and choose Event Viewer. The Event Viewer window opens. Table 6-5 lists and 
describes the fields in the window.

Step 2 (Optional) Click the Node column header to organize the Event Viewer table by node. Click the header 
a second time to reverse the order (from top to bottom) of the display.

PcaAssemblyNum Printed circuit assembly (PCA) assembly number.

FruNum Field replaceable unit (FRU) number.

Table 6-3 Fans Tab Field Descriptions (continued)

Field Description

Table 6-4 Fans Tab Field Descriptions

Field Description

Slot ID Numeric identifier of the slot in which the temperature sensor resides. For 
more information on the slots in your device, refer to your hardware 
documentation.

Sensor ID Numeric identifier of the temperature sensor.

Oper Status Operational code of the sensor. The values are normal, tempAlert, 
currAlert, or voltAlert.

Oper Code Temperature of the slot.

Current Temp Current temperature of the chassis.

Alarm Temp Chassis temperature that triggers an alarm.

Shutdown Temp Chassis temperature that triggers a shutdown.
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Step 3 (Optional) Click the Time column header to organize the Event Viewer table by node. Click the header 
a second time to reverse the order (from top to bottom) of the display.

Step 4 (Optional) Click the Type column header to organize the Event Viewer table by node. Click the header 
a second time to reverse the order (from top to bottom) of the display.

Step 5 (Optional) Click the Description column header to organize the Event Viewer table by node. Click the 
header a second time to reverse the order (from top to bottom) of the display.

Exporting Event Logs to a Text File
To export an event log, perform the following steps:

Step 1 Click the Health menu and choose Event Viewer. The Event Viewer window opens.

Step 2 Click the Export button. The Save window opens.

Step 3 Navigate to the directory on your local host on which you want to store the event log.

Step 4 Enter a filename for the log in the File Name field, and then click the Save button. Element Manager 
creates a text file with the contents of the event log on your host.

Clearing Event Entries by Category
To clear choose event types from the Event Viewer table, perform the following steps:

Step 1 Click the Health menu and choose Event Viewer. The Event Viewer window opens.

Step 2 Click the Clear button, and then click the type of entry that you want to remove from the table. All 
entries of that type disappear from the display.

Clearing All Event Entries
To clear all events from the Event Viewer table, perform the following steps:

Step 1 Click the Health menu and choose Event Viewer. The Event Viewer window opens.

Table 6-5 Event Viewer Field Descriptions

Field Description

Node IP address of the Server Switch on which the event took place.

Time Time that the event took place.

Type Type of event that took place.

Description Description of the event.
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Step 2 Click the Clear button, and then click All. All event entries disappear from the display.

Configuring Trap Receivers
You must configure your host to receive traps in order to view events. If no other application on your 
local host controls port 162, Element Manager automatically registers your local host as a trap receiver. 
To verify that Element Manager registered your host, perform the following steps:

Step 1 Click the Health menu, and then click Trap Receivers. The Trap Receivers window opens.

Step 2 Verify that the IP address of your host appears in the Address column. If it appears, verify that “true” 
appears in the Receive Events column.

Note If your local host has multiple IP addresses (for instance, one from a LAN and one from a wireless 
connection, disable all IP addresses other than the LAN address, and then close Element Manager and 
open it again. Verify that only the LAN address appears in the Trap Receivers window. If it appears, 
you can enable your other addresses.

Configuring Your Host as a Trap Receiver
If you have an application (other than Element Manager) that takes over port 162 to receive and manage 
SNMP traps, you must add your host to the Server Switch configuration with Element Manager so that 
the application receives Server Switch traps. To add your host as a trap receiver, perform the following 
steps:

Step 1 Click the Health menu and choose Trap Receivers. The Trap Receivers window opens.

Step 2 Click the Insert button. The Insert Trap Receivers window opens.

Step 3 Enter the IP address of your host in the Address field.

Step 4 Enter the SNMP community of your host in the Community field.

Step 5 Check the Receive Events checkbox, and then click the Insert button.

Deleting Your Host as a Trap Receiver
If you manually configured your host as a trap receiver, you must manually remove your host to 
de-register. To delete your host as a trap receiver, perform the following steps:

Step 1 Click the Health menu and choose Trap Receivers. The Trap Receivers window opens.

Step 2 Click your host in the Trap Receivers table, and then click the Delete button.

Step 3 Click the Close button.
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Viewing Authentication Failures
To view authentication failures, perform this step:

Step 1 Click the Health menu and choose Authentication. The Authentication window opens. Table 6-6 lists 
and displays the fields in this window.

Enabling Failure Traps
To enable authentication traps, perform the following steps:

Step 1 Click the Health menu and choose Authentication. The Authentication window opens.

Step 2 Click the enabled radio button, and then click the Apply button.

Viewing Logs
To view one of the logs in the file system on your Server Switch, perform the following steps:

Step 1 Click the Health menu, and then click Log Viewer. The Log Viewer window opens.

Step 2 Click the Download button. The Download Log Files window opens.

Step 3 Click, in the Available log files table, the log that you want to view, and then click the Download button. 
The Save As window opens.

Step 4 Navigate to the directory in which you want to save the log file, and then click the Save button. A 
Download Complete window opens and displays an Open File checkbox.

Step 5 Check the Open File checkbox, and then click the OK button. The log opens in the Log Viewer window.

Table 6-6 Authentication Field Descriptions

Field Description

Enable Authentication Traps Provides radio buttons to enable and disable authentication traps.

CLI Access Violation Count Number of CLI access violation counts.

CLI Last Violation Time Time of the most recent CLI access violations.

SNMP Access Violation Count Number of SNMP access violation counts.

SNMP Last Violation Time Time of the most recent SNMP access violations.

HTTP Access Violation Count Number of HTTP access violation counts.

HTTP Last Violation Time Time of the most recent HTTP access violations.
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Applying Filters to ts_log Displays
When you configure and apply filters, Element Manager removes from the display all entries that do not 
match the filter criteria. To remove particular entries from log displays, perform the following steps:

Step 1 Click the Health menu, and then click Log Viewer. The Log Viewer window opens.

Step 2 Open a ts_log file. For detailed instructions, refer to the “Viewing Logs” section on page 6-6.

Step 3 Click the Filter button. The Log Filter window opens.

Step 4 Select the filter attributes that you want to apply:

– All filter options are cumulative. If you choose slot 1 and WARN, the log viewer displays only 
logs that apply to slot 1 and are of the WARN type. Any WARN type messages that do not apply 
to slot 1 do not appear. Any slot 1 messages of other types do not appear.

– Click the Show Advanced button to reveal application options that you can add to the filter. 
Click an application to apply it to the filter. Press and hold the Ctrl key and click additional 
applications to apply multiple applications to the filter.

Step 5 Click the Apply button. All entries that do not match the filter disappear from the display.
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Report Menu Tasks

This chapter describes the Report menu tasks for Element Manager and contains these sections:

• Viewing Port Statistics, page 7-1

• Graphing Port Statistics, page 7-8

• Viewing Card Statistics, page 7-10

• Graphing Card Statistics, page 7-13

Note Use the Report menu to view card and port statistics. With the menu, you can view all relevant statistics 
in a table, or you can choose statistics to create a custom graph.

Viewing Port Statistics
To view port statistics, perform the following steps:

Step 1 In the chassis display, click the port whose statistics you want to view.

Step 2 Click the Report menu and choose Graph Port. A window opens that displays the type and number of 
the port.

Step 3 Click the Interface tab. A table of port statistics appears. Table 7-1 lists and describes the fields in this 
table.

Table 7-1 Port Statistics Display Field Descriptions

Field Description

InOctets Cumulative number of octets that arrived at the port, including framing 
characters.

InUcastPkts Cumulative number of incoming packets destined for a single port.

InMulticastPkts Cumulative number of incoming packets destined for the ports of a multicast 
group.

InBroadcastPkts Cumulative number of incoming packets destined for all ports on the fabric.

InDiscards Cumulative number of inbound packets that the port discarded for a reason 
other than a packet error (such as the lack of buffer space).

InErrors Number of inbound packets with errors that the port discarded.
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Configuring the Refresh Rate
Element Manager refreshes all statistics displays at regular intervals. To configure the interval, perform 
the following steps:

Step 1 In the chassis display, click the port whose refresh rate you want to change.

Step 2 Click the Report menu and choose Graph Port. A window opens that displays the type and number of 
the port.

Step 3 Click the pulldown menu at the bottom of the window and choose the interval at which you want the 
display to refresh.

Note You do not need to click any apply or ok button. The change takes place immediately.

InUnknownProtos For packet-oriented interfaces, the number of packets received via the 
interface that were discarded because of an unknown or unsupported 
protocol. For character-oriented or fixed-length interfaces that support 
protocol multiplexing, the number of transmission units received via the 
interface that were discarded because of an unknown or unsupported 
protocol. For any interface that does not support protocol multiplexing, this 
counter is always 0. 

OutOctets Total number of octets transmitted out of the interface, including framing 
characters. 

OutUcastPkts Total number of packets that higher-level protocols requested be transmitted, 
and which were not addressed to a multicast or broadcast address at this 
sublayer, including those packets that were discarded or not sent.

OutMulticastPkts Total number of packets that higher-level protocols requested be transmitted, 
and which were addressed to a multicast address at this sub-layer, including 
those that were discarded or not sent. For a MAC layer protocol, includes 
both Group and Functional addresses. 

OutBroadcastPkts Total number of packets that higher-level protocols requested to be 
transmitted, and which were addressed to a broadcast address at this 
sublayer, including those packets that were discarded or not sent.

OutDiscards Number of outbound packets that were chosen to be discarded even though 
no errors had been detected to prevent their being transmitted. One possible 
reason for discarding such a packet could be to free-up buffer space.

OutErrors For packet-oriented interfaces, the number of outbound packets that could 
not be transmitted because of errors. For character-oriented or fixed-length 
interfaces, the number of outbound transmission units that could not be 
transmitted because of errors. 

Table 7-1 Port Statistics Display Field Descriptions (continued)

Field Description
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Viewing Fibre Channel Statistics
In addition to general statistics, the Report menu provides Fibre Channel-specific statistics for FC 
gateway ports. To view FC statistics, perform the following steps:

Step 1 In the chassis display, click the FC gateway port whose FC statistics you want to view.

Step 2 Click the Report menu and choose Graph Port. A window opens that displays the type and number of 
the port.

Step 3 Click the FibreChannel tab. A table of FC statistics appears. Table 7-2 lists and describes the fields in 
this table.

Table 7-2 Fibre Channel Statistics Field Descriptions

Field Description

FcSecondsSinceLastReset Number of seconds since the Fibre Channel port last reset.

LinkEvents Total number of link events (such as link up, link down) 
processed by the Fibre Channel interface gateway(s).

FcpCmdsOutstanding Total number of FCP commands outstanding on the Fibre 
Channel interface gateway(s).

FcpCmdsCompleted Total number of FCP commands completed on the Fibre Channel 
interface gateway(s).

FcpErrors Total number of FCP errors encountered on the Fibre Channel 
interface gateway(s).

FcInitiatorIO Quantity of Initiator I/O.

FcTxFrames Number of transmitted Fibre Channel frames.

FcTxWords Number of transmitted Fibre Channel words.

FcRxFrames Number of received Fibre Channel frames.

FcRxWords Number of received Fibre Channel words.

FcLIPCount Number of Loop Initialization Primitives.

FcNOSCount Number of not operational primitive sequences.

FcErrorFrames Number of error frames.

FcDumpedFrames Number of frames that the port dumped.

FcLinkFailureCount Number of link failures.

FcLossOfSyncCount Number of loss-of-sync errors.

FcLossOfSignalCount Number of loss-of-signal errors.

FcPrimitiveSeqProtocolErrCount Number of primitive sequence protocol errors.

FcInvalidTxWordCount Number of invalid transmission word errors.

FcInvalidCRCCount Number of invalid cyclical redundancy checks.
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Viewing IP Statistics
In addition to general statistics, the Report menu provides IP-specific statistics for Ethernet gateway 
ports. To view IP statistics, perform the following steps:

Step 1 In the chassis display, click the Ethernet gateway port whose IP statistics you want to view.

Step 2 Click the Report menu and choose Graph Port. A window opens that displays the type and number of 
the port.

Step 3 Click the IP tab. A table of IP statistics appears. Table 7-3 lists and describes the fields in this table.

Table 7-3 IP Statistics Field Descriptions

Field Description

InReceives Cumulative number of input datagrams (including errors) that interfaces 
received for the IP address that you specified with the ip keyword.

InHdrErrors Cumulative number of datagrams that interfaces discarded. Reasons to discard 
a datagram include the following:

• Bad checksums

• Version number mismatches

• Format errors

• Exceeded time-to-live values

• IP option processing errors

InHdrChksumErr The number of input datagrams discarded due to a checksum error in their IP 
headers.

InAddrErrors Cumulative number of input datagrams that ports discarded because the IP 
address in the destination field of the header of the datagram was not a valid 
address to be received by the port.

ForwDatagrams Cumulative number of datagrams that arrived at the port en-route to a final 
destination. For non-IP-gateway ports, this value includes only packets that the 
port source-routed successfully.

InUnknownProtos Cumulative number of datagrams that the port successfully received but 
discarded due to an unknown or unsupported protocol.

InDiscards Cumulative number of datagrams that the port discarded for a reason other than 
a problem with the datagram (such as the lack of buffer space).

InDelivers Cumulative number of input datagrams that the port successfully delivered to IP 
user protocols, including the Internet Control-Message Protocol (ICMP).

OutRequests Cumulative number of IP datagrams that local IP user protocols (including 
ICMP) supplied to IP in-requests. This counter does not include any datagrams 
counted as forw-datagrams.

OutDiscards Cumulative number of output IP datagrams that the port discarded for a reason 
other than a problem with the datagram (such as the lack of buffer space).
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Viewing Ethernet Statistics
In addition to general statistics, the Report menu provides IP-specific statistics for Ethernet gateway 
ports. To view Ethernet statistics, perform the following steps:

Step 1 In the chassis display, click the Ethernet gateway port whose Ethernet statistics you want to view.

Step 2 Click the Report menu and choose Graph Port. A window opens that displays the type and number of 
the port.

OutNoRoutes Cumulative number of IP datagrams that the port discarded because a route 
could not be found to transmit them to their destination. This counter includes 
any packets counted in forw-datagrams that still qualify. This counter also 
includes any datagrams that a server switch cannot route because all of the 
gateways on the server switch are down.

FragOKs Cumulative number of IP datagrams that the port has successfully fragmented.

FragFails Cumulative number of IP datagrams that the port discarded because the port 
could not fragment them. (For instance, this occurs when the Don’t Fragment 
flag of the datagram is set.)

FragCreates Cumulative number of IP datagram fragments that the port has generated.

Table 7-3 IP Statistics Field Descriptions (continued)

Field Description
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Step 3 Click the Ethernet tab. A table of Ethernet statistics appears. Table 7-4 lists and describes the fields in 
this table.

Table 7-4 Ethernet Statistics Field Descriptions

Field Description

AlignmentErrors A count of frames received on a particular interface that are not an 
integral number of octets in length and do not pass the FCS check. The 
count represented by an instance of this object is incremented when the 
alignmentError status is returned by the MAC service to the LLC (or 
other MAC user). Received frames for which multiple error conditions 
obtain are counted exclusively according to the error status presented to 
the LLC. This counter does not increment for 8-bit wide group encoding 
schemes.

FCSErrors A count of frames received on a particular interface that are an integral 
number of octets in length but do not pass the FCS check. This count 
does not include frames received with frame-too-long or frame-too-short 
errors. The count represented by an instance of this object is incremented 
when the frameCheckError status is returned by the MAC service to the 
LLC (or other MAC user). Received frames for which multiple error 
conditions obtained are counted exclusively according to the error status 
presented to the LLC. 

Coding errors detected by the physical layer for speeds above 10 Mbps 
will cause the frame to fail the FCS check. 

SingleCollisionFrames A count of successfully transmitted frames on a particular interface for 
which transmission is inhibited by exactly one collision. A frame that is 
counted by an instance of this object is also counted by the 
corresponding instance of the out-ucast-pkts, out-multicast-pkts, or 
out-broadcast-pkts, and is not counted by the corresponding instance of 
the multiple-collision-frames object. This counter does not increment 
when the interface is operating in full-duplex mode. 

MultipleCollisionFrames A count of successfully transmitted frames on a particular interface for 
which transmission is inhibited by more than one collision. A frame that 
is counted by an instance of this object is also counted by the 
corresponding instance of the out-ucast-pkts, out-multicast-pkts, or 
out-broadcast-pkts, and is not counted by the corresponding instance of 
the single-collision-frames object. This counter does not increment when 
the interface is operating in full-duplex mode.

SQETestErrors A count of times that the SQE TEST ERROR message is generated by 
the PLS sublayer for a particular interface. The SQE TEST ERROR is set 
in accordance with the rules for verification of the SQE detection 
mechanism in the PLS Carrier Sense Function, as described in IEEE Std. 
802.3, 1998 Edition, section 7.2.4.6. This counter does not increment on 
interfaces operating at speeds greater than 10 Mbps or on interfaces 
operating in full-duplex mode.

DeferredTransmissions A count of frames for which the first transmission attempt on a particular 
interface is delayed because the medium is busy. The count represented 
by an instance of this object does not include frames involved in 
collisions. This counter does not increment when the interface is 
operating in full-duplex mode. 
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LateCollisions The number of times that a collision is detected on a particular interface 
later than one Ethernet slot-time unit into the transmission of a packet. A 
late collision included in a count represented by an instance of this object 
is also considered as a generic collision for purposes of other 
collision-related statistics. This counter does not increment when the 
interface is operating in full-duplex mode. 

ExcessiveCollisions A count of frames for which transmission on a particular interface fails 
due to excessive collisions. This counter does not increment when the 
interface is operating in full-duplex mode.

InternalMacTransmitErrors A count of frames for which transmission on a particular interface fails 
due to an internal MAC sublayer transmit error. A frame is only counted 
by an instance of this object if it is not counted by the corresponding 
instance of the late-collisions object, the excessive-collisions object, or 
the carrier-sense-errors object. The precise meaning of the count 
represented by an instance of this object is implementation-specific. In 
particular, an instance of this object may represent a count of 
transmission errors on a particular interface that is not otherwise 
counted. 

CarrierSenseErrors The number of times that the carrier sense condition was lost or never 
asserted when attempting to transmit a frame on a particular interface. 
The count represented by an instance of this object is incremented at 
most once per transmission attempt, even if the carrier sense condition 
fluctuates during a transmission attempt. This counter does not 
increment when the interface is operating in full-duplex mode. 

FrameTooLongs A count of frames received on a particular interface that exceed the 
maximum permitted frame size. The count represented by an instance of 
this object is incremented when the frame-too-longs status is returned by 
the MAC service to the LLC (or other MAC user). Received frames for 
which multiple error conditions obtain are counted exclusively according 
to the error status presented to the LLC. 

InternalMacReceiveErrors A count of frames for which reception on a particular interface fails due 
to an internal MAC sublayer receive error. A frame is only counted by an 
instance of this object if it is not counted by the corresponding instance 
of the frame-too-longs, alignment-errors, or fcs-errors object. The 
precise meaning of the count represented by an instance of this object is 
implementation-specific. In particular, an instance of this object may 
represent a count of receive errors on a particular interface that is not 
otherwise counted. 

Table 7-4 Ethernet Statistics Field Descriptions (continued)

Field Description
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Graphing Port Statistics
Element Manager provides utilities that create line charts, area charts, bar charts, and pie charts to 
visually represent port statistics.

To graph particular port statistics, perform the following steps:

Step 1 In the chassis display, click the port whose statistics you want to view.

Step 2 Click the Report menu and choose Graph Port. A window opens that displays the type and number of 
the port.

Step 3 Click the Interface tab. (Optionally, you can click the IP, Ethernet, or FibreChannel tabs, when 
available.) A table of port statistics appears.

Step 4 Select the values that you want to include in the graph with one of the following methods:

– Click-and-drag your cursor across the values that you want to graph.

– Hold the Ctrl key and click the values that you want to graph.

Step 5 Click the button of the graph that you want to create. See Figure 7-1. The graph appears 

Figure 7-1 Graph Buttons

 Line Chart
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 Area Chart

 Bar Chart

 Pie Chart

Note With most charts, the display will reload with updated information based on the refresh rate. To 
configure the interval, refer to the “Configuring the Refresh Rate” section on page 7-2.
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Using a Swap Chart Type, Layout, and Scale
With the exception of pie charts, the chart display lets you do the following:

• Swap between charts.

• Increase or decrease the scale of the display.

• View the chart horizontally or vertically.

To perform these functions, use the buttons in Table 7-5.

Viewing Card Statistics
With Element Manager, you can view statistics of Fibre Channel gateway cards or Ethernet gateway 
cards.

Viewing Fibre Channel Card Statistics
To view port statistics, perform the following steps:

Step 1 In the chassis display, click the card whose statistics you want to view.

Table 7-5 Chart Buttons

Button Name Function

Stacked Overlays the graphical output of each statistic.

Horizontal Rotates the axis of the graph by 90 degrees.

Log Scale Zooms in and out.

Line Chart Displays a line chart.

Area Chart Displays an area chart.

Bar Chart Displays a bar chart.
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Step 2 Click the Report menu and choose Graph Card. A window opens that displays the type and number of 
the card and presents card statistics in tabular format. Table 7-6 lists and describes the fields in this table.

Viewing Ethernet Card Statistics
To view port statistics, perform the following steps:

Step 1 In the chassis display, click the card whose statistics you want to view.

Table 7-6 FC Card Statistics

Field Description

LinkEvents Total number of link events (such as the link up, link down) processed by the 
Fibre Channel interface gateway(s).

SrpInitiatedIos Total number of SRP I/O requests.

SrpCmdsCompleted Cumulative number of commands that one or all FC gateways executed.

SrpBytesRead Cumulative number of SRP bytes read by one or all FC gateways.

SrpBytesWritten Cumulative number of SRP bytes written by one or all FC gateways.

SrpConnections Total number of connections used by the SRP initiator.

SrpCmdsOutstanding Cumulative number of outstanding SRP commands.

SrpErrors Cumulative number of SRP errors.

FcInitiatedIos Total number of I/O responses by the Fibre Channel device to SRP initiator 
requests. 

FcpCmdsCompleted Cumulative number of commands that one or all FC gateways executed.

FcpBytesRead Cumulative number of FC bytes read by one or all FC gateways.

FcpBytesWritten Cumulative number of FC bytes written by one or all FC gateways.

FcpCmdsOutstanding Cumulative number of outstanding FC commands.

FcpErrors Cumulative number of FC errors on one or all gateways.
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Step 2 Click the Report menu and choose Graph Card. A window opens that displays the type and number of 
the card and presents card statistics in tabular format. Table 7-7 lists and describes the fields in this table.

Table 7-7 Ethernet Card Statistics

Field Description

InReceives Cumulative number of input datagrams (including errors) that interfaces received 
for the IP address that you specified with the ip keyword.

InHdrErrors Cumulative number of datagrams that interfaces discarded. Reasons to discard a 
datagram include the following:

• Bad checksums

• Version number mismatches

• Format errors

• Exceeded time-to-live values

• IP option processing errors

InHdrChksumErr Cumulative number of header checksum errors.

InAddrErrors Cumulative number of input datagrams that ports discarded because the IP 
address in the destination field of the header of the datagram was not a valid 
address to be received by the port.

ForwDatagrams Cumulative number of datagrams that arrived at the port en-route to a final 
destination. For non-IP-gateway ports, this value includes only packets that the 
port source-routed successfully.

InUnknownProtos Cumulative number of datagrams that the port successfully received but 
discarded due to an unknown or unsupported protocol.

InDiscards Cumulative number of datagrams that the port discarded for a reason other than 
a problem with the datagram (such as the lack of buffer space).

InDelivers Cumulative number of input datagrams that the port successfully delivered to IP 
user protocols, including Internet Control-Message Protocol (ICMP).

OutRequests Cumulative number of IP datagrams that local IP userprotocols (including ICMP) 
supplied to IP in-requests. This counter does not include any datagrams counted 
as forw-datagrams.

OutDiscards Cumulative number of output IP datagrams that the port discarded for a reason 
other than a problem with the datagram (such as the lack of buffer space).

OutNoRoutes Cumulative number of IP datagrams that the port discarded because a route could 
not be found to transmit them to their destination. This counter includes any 
packets counted in forw-datagrams that still qualify. This counter also includes 
any datagrams that a server switch cannot route because all of the gateways on 
the server switch are down.

FragOKs Cumulative number of IP datagrams that the port has successfully fragmented.

FragFails Cumulative number of IP datagrams that the port discarded because the port 
could not fragment them. (For instance, this occurs when the Don’t Fragment flag 
of the datagram is set.)

FragCreates Cumulative number of IP datagram fragments that the port has generated.
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Configuring the Refresh Rate
Element Manager refreshes all statistics displays at regular intervals. To configure the interval, perform 
the following steps:

Step 1 In the chassis display, click the port whose refresh rate you want to change.

Step 2 Click the Report menu and choose Graph Card. A window opens that displays the type and number of 
the port.

Step 3 Click the pulldown menu at the bottom of the window and choose the interval at which you want the 
display to refresh.

Note You do not need to click any apply or ok button. The change takes place immediately.

Graphing Card Statistics
Element Manager provides utilities that create line charts, area charts, bar charts, and pie charts to 
visually represent port statistics.

To graph particular card statistics, perform the following steps:

Step 1 In the chassis display, click the card whose statistics you want to view.

Step 2 Click the Report menu and choose Graph Card. A window opens that displays the type and number of 
the port. A table of card statistics appears.

Step 3 Select the values that you want to include in the graph with one of the following methods:

– Click-and-drag your cursor across the values that you want to graph.

– Hold the Ctrl key and click the values that you want to graph.

Step 4 Click the button of the graph that you want to create. See Figure 7-2. The graph appears.

Figure 7-2 Graph Buttons

 Line Chart

 Area Chart

 Bar Chart

 Pie Chart
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The graph appears.

Example

Note With most charts, the display will reload with updated information based on the refresh rate. To 
configure the interval, refer to the “Configuring the Refresh Rate” section on page 7-13.

Using Swap Chart Type, Layout, and Scale
With the exception of pie charts, the chart display lets you do the following:

• Swap between charts.

• Increase or decrease the scale of the display.

• View the chart horizontally or vertically.
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To perform these functions, use the buttons in Table 7-5.

Table 7-8 Chart Buttons

Button Name Function

Stacked Overlays the graphical output of each statistic.

Horizontal Rotates the axis of the graph by ninety degrees.

Log Scale Zooms in and out.

Line Chart Displays a line chart.

Area Chart Displays an area chart.

Bar Chart Displays a bar chart.
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InfiniBand Menu Tasks

This chapter desribes the InfiniBand menu tasks for Element Manager and contains these sections:

• Viewing Subnet Manager Properties, page 8-7

• Configuring Max Hops, page 8-11

• Understanding Partitions, page 8-12

• Viewing Partition Details, page 8-16

• Viewing Multicast Group Details, page 8-18

• Viewing Multicast Member Details, page 8-18

• Viewing InfiniBand Services, page 8-19

• Viewing Switch Route Details, page 8-20

• Viewing Switch Element Route Details, page 8-20

• Adding a Subnet Manager, page 8-21

• Configuring Subnet Manager Properties, page 8-22

• Configuring Database Synchronization, page 8-25

• Viewing the Database Synchronization State, page 8-28

• Viewing Partitions, page 8-29

• Viewing Multicast Groups, page 8-32

• Viewing Infiniband Services, page 8-34

• Viewing InfiniBand Routes, page 8-35

• Enabling Performance Management, page 8-36

• Monitoring Connections, page 8-37

• Viewing Port Counters, page 8-43

• Enabling Port Monitoring, page 8-47

• Launching Topology View, page 8-50

• Viewing Subnet Details, page 8-52

• Viewing Subnet Management Agents, page 8-56

• Viewing Device Management, page 8-65
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Note This section provides information to familiarize you with the InfiniBand technology. For 
hardware-specific information, consult the relevant hardware documentation.

Understanding InfiniBand
InfiniBand (IB) is a high speed, high density serial interconnect that increases CPU utilization, decreases 
latency, and eases the management pain of data centers. The term “InfiniBand” refers to the entire 
hardware, communication, and management infrastructure. Use of this technology increases the 
communication speed between the following:

• CPUs

• devices within servers

• subsystems located throughout a network. 

InfiniBand combines high-speed hardware, specialized protocols, and Remote Data Memory Access 
(RDMA) techniques to increase CPU utilization and decrease latency. Operations of the InfiniBand 
Architecture are managed by the  SM.

InfiniBand Components
One or more of the following hardware components may be used to maximize your server network. 

• InfiniBand switch—Passes traffic between IB-capable devices over the InfiniBand network

• Host channel adapters (installed in host)—Serves an IB version of a network interface card (NIC) 
to connect the host to the IB network

• Ethernet gateway—Provides Ethernet connectivity to an IB network

• Fibre Channel gateway—Provides Fibre Channel connectivity to an IB network

Protocols
InfiniBand requires a new set of protocols. All of the necessary protocol drivers are included with the 
Server Switch solution.

IPoIB

The IP over IB (IPoIB) link driver provides standardized IP encapsulation over InfiniBand fabrics. IPoIB 
can transparently use IP over InfiniBand technology, similar to the way that IP runs over Ethernet.

The primary responsibilities of the IPoIB driver are to perform address resolution and the management 
of multicast membership.

SDP

The Sockets Direct Protocol (SDP) is a transparent protocol used on InfiniBand networks to allow 
sockets-based applications to take advantage of the RDMA performance over an InfiniBand network. 
SDP provides: a reduction in the amount of software running inside a process context and zero copy SDP 
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protocol support enables databases, application servers, and CPUs to operate more efficiently because 
the databases spends less time waiting for work, the application servers spend less time waiting for 
responses, and the CPUs have more cycles free for other work.

SRP

SCSI RDMA Protocol (SRP) is an upper-layer storage protocol for InfiniBand that runs SCSI commands 
across RDMA-capable networks for InfiniBand hosts to communicate with Fibre Channel storage 
devices. This protocol allows InfiniBand hosts to natively send SCSI commands as if the storage was 
directly attached.

The SRP protocol operate using an RDMA communication service that provides communication 
between pairs of consumers; it uses messages for control information and RDMA operations for data 
transfers.

The SRP protocol is used only if you have a Fibre Channel Gateway installed in your InfiniBand system. 

uDAPL

The user Direct Access Programming Library (uDAPL) is a standardized user mode API that natively 
supports InfiniBand fabrics. uDAPL performs name to address translations, establishes connections, and 
transfers data reliably. The primary responsibilities of uDAPL are: connection management and low 
latency data transfer and completion

Architectural Elements
The following structures serve as foundational elements of InfiniBand architecture:

• Remote Direct Memory Access (RDMA)

• Queue Pairs

• Services

RDMA

InfiniBand utilizes RDMA technology. RDMA allows one computer to place information directly into 
the memory of another computer. RDMA is specifically characterized by two important features: allows 
user space applications to directly access hardware and zero-copy data movement

A combination of hardware and software allows user space applications to read and write the memory 
of a remote system without kernel intervention or unnecessary data copies. This results in lower CPU 
utilization per I/O operation and more efficient use of machine resources because applications place 
most of the messaging burden upon InfiniBand’s high-speed network hardware. 

Queue Pairs

A verb is used to define the functionality of the Host Channel Adapter (HCA). A verb consumer refers 
to the direct user of the verb. 

A work queue provides a consumer with the ability to queue up a set of instructions that are executed by 
the Channel Adapter. There are two types of Work Queues: Send Work Queue (outbound) and a Receive 
Work Queue (inbound). Together these Work Queues create a Queue Pair. 
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The Queue Pair (QP) is one of the primary architectural elements of InfiniBand. In InfiniBand, 
communication occurs between QPs, instead of between ports. 

A QP is an addressable entity that consists of two Work Queues: a Send Work Queue and a Receive Work 
Queue. (A work queue provides a verb consumer with the ability to queue up a set of instructions that 
are executed by the Channel Adapter.) The Channel Adapter hardware takes over the task of arbitrating 
communication by multiplexing access to the send queue or demultiplexing messages on the receive 
queue. 

A connection is made by linking a local queue pair to a remote queue pair. Applications do not share 
QPs; once you set them up, you can manage them at the application level without incurring the overhead 
of system calls. 

Send and Receive work queues have these characteristics:

• Always created as a pair 

• Always remain a pair

• Known as QPs

• Identified by a QP number, which is within the Channel Adapter. 

Queue pairs have:

• A region of memory to be used as buffers (numbers of QPs are only limited by memory).

• A key that must match on each incoming packet (the Q_Key) to verify the validity of the packet, 

• (Potentially) a partition key, which specifies the portion of the fabric that this queue pair may access.

The QP is the mechanism by which you define quality of service, system protection, error detection and 
response, and allowable services.

Each QP is independently configured for a particular type of service. These service types provide 
different levels of service and different error-recovery characteristics as folows:

• Reliable connection

• Unreliable connection

• Reliable Datagram

• Unreliable Datagram

Once the fabric connections are discovered, QPs and protection domains are established, and the type 
and quality of service are defined for each queue pair, the fabric operates reliably and securely at full 
performance without impact on system hardware or software resources.

Understanding the Subnet Manager
The Subnet Manager (SM) configures and maintains fabric operations. There can be multiple  SMs, but 
only one master. The  SM is the central repository of all information that is required to set up and bring 
up the InfiniBand fabric.

The master SM does the following:

• Discovers the fabric topology.

• Discovers end nodes. 

• Configures switches and end nodes with their parameters, such as the following:

– Local Identifiers (LIDs)

– Global Unique Identifier (GIDs)
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– Partition Key (P_Keys)

• Configures switch forwarding tables.

• Receives traps from Subnet Management Agents (SMAs).

• Sweeps the subnet, discovering topology changes and managing changes as nodes are added and 
deleted.

Subnet Management Agents

SMAs are part of the SM. An SMA is provided with each node and process packets from the  SM. 

If a  SM is elected master, all of its components, including SA, are implicitly elected master. If a  SM 
ceases to be master, all of its components cease responding to messages from clients.

Subnet Manager Hot Standby

The master and slave  SMs can be synchronized so the information in the master is carried over to the 
slave in the event of a fail-over. Refer to the “Enabling SM Database Synchronization” section on 
page 8-25 to configure SM hot standby.

The hot standby/database sync feature is used to synchronize the databases between  SMs running on 
separate chassis. 

The  SM maintains a database  in the volatile memory of the master SM containing all required 
information. The database synchronization is accomplished in two stages:

• Cold Synchronization—This stage is initiated by the master SM when it is ready to start a 
synchronization session with a standby SM. In this stage, all out of sync tables are copied from the 
master SM to the standby SM. 

• Transactional Synchronization—This stage is entered following successful completion of the cold 
synchronization stage. In this stage, all database update transaction requests that are processed by 
the master, are replicated to the standby.

A standby SM can become the master in this situation. 

• A crash of the node running the current master SM.

• Partitioning of the subnet (such as due to link failure).

• Graceful shutdown of the master ( such as for maintenance purposes).

The following occurs in the event of a failure:

• The standby SM becomes the new master. 

• The new master rebuilds the database  from information retrieved during the subnet discovery 
phase. 

• Existing LID assignments are retained, where possible. 

• All ports are reset to force them to rejoin multicast groups, readvertise services, rerequest event 
forwarding, and re-establish connections. 

• A “SlaveToMaster” event trap is generated to trigger any necessary processing by external 
management applications.
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Subnet Manager Routing
There are two different concepts associated with InfiniBand routing: 

• Routing internally within a switch (hops between switch chips)

• Routing between whole switches (hops between nodes). This is also referred to as routing between 
“switch elements.”

Internal switch routing can be configured to provide the highest performance in passing traffic and to 
minimize the threat of congestion within the switch. 

The routing process proceeds as follows:

Step 1 The  SM first discovers all the InfiniBand switch chips in the network.

Step 2 The SM groups the internal switch chips within each chassis into a “switch element.”

Step 3 The SM process continues until all the InfiniBand switches are grouped into switch elements.

Step 4 After all the switch chips are grouped, the SM will route the switch elements according to the routing 
algorithm discussed in the “Minimum Contention, Shortest Path and Load Balancing Algorithm” section 
on page 8-7.

Step 5 The internal network of each InfiniBand switch is then routed based on the best algorithm for each switch 
element.

Multiple Paths

The SM allows you to define the Local Identifier Mask Control (LMC) value per subnet. The default 
value of the LMC is 0. By default, only one Local Identifier (LID) is assigned to each host port.

Once the LMC value has been assigned, the SM will route different paths for each LID associated with 
the same host port. The result of these paths is based on the routing algorithm applied. 

Understanding SM Routing Terms 

The following terms are important to understand before distinguishing the various types of algorithms 
that the SM uses for routing: 

• Distance is defined as the number of hops (InfiniBand switches or switch elements) between source 
and destination.

• Tolerance is used when deciding if a particular path is better in distance than the already selected 
path. You can choosethe tolerance to be used for shortest path calculation as follows: 

– If the tolerance is set to 0, a path has equal distance in calculating the route as the shortest path 
route only if it has an equal number of hops. 

– If the tolerance is set to 1, a path has equal distance in calculating the route as the shortest path 
route only if the path has a number of hops equal to either the shortest path or the shortest path 
plus 1.

• Contention is declared for every switch port on the path that is already used for routing another LID 
associated with the same host port.
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Minimum Contention, Shortest Path and Load Balancing Algorithm

Minimum Contention, Shortest Path and Load Balancing is the algorithm that is used by default to route 
between the switch elements and for routing between the internal InfiniBand switch chips within each 
switch element.

The following algorithm is used for the calculation:

Step 1 The shortest path for each of the host ports is calculated.

Step 2 Contention is calculated for all the available paths that are within the (shortest path + tolerance) distance.

a. The path with the least contention is selected.

b. If two paths have the same contention, the path with less distance is selected.

c. If two paths have the same contention and the same distance, the port usage count is used to provide 
load balancing over the two paths. The usage count is a measure of how many LIDs have been 
configured to use that particular port.

Deterministic Source Based Routing Algorithm

The Deterministic Source Based Routing is used in some HPC environments where the requirements 
may need to be more stringently defined. An administrator can identify the exact route that a given port 
and LID takes for traversing through the network.

Currently, only the internal routing for the Cisco SFS 7008 (a 96 port switch) supports this routing 
scheme. Refer to the Cisco SFS 7008 Hardware Guide, or contact technical support for more 
information.

Configuring Your Network For Optimal Routing

For optimal routing, we recommend that you do the following: 

• Create equal paths between switch elements

• Determine the first path that will be discovered

We recommend that InfiniBand switch elements be connected so that all paths between any pair of 
switch elements are the same distance (i.e. same number of hops), if possible. This enables you to obtain 
the optimal paths using the default tolerance of 0. If the paths are of different lengths, then the tolerance 
value will need to be determined.

The SM Routing Algorithm selects the first best path that it finds. If multiple paths with the same 
properties are available, then the first of these paths found is the one that is selected. Therefore, it is 
possible to set up the cabling between switch elements to force the algorithm to prioritize certain paths. 
Depending on the network requirements, the prioritized paths can either be concentrated on a particular 
switch element or spread across multiple switch elements to improve fault tolerance.

Viewing Subnet Manager Properties
To view SM properties, perform the following steps:
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Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of SM properties appears. Table 8-1 lists and describes the 
elements in this window.

Table 8-1 Subnet Manager Properties Window Fields

Element Description

Subnet Prefix field Displays the subnet prefix of the Subnet Manager.

GUID field Displays the GUID of the networking device on which the SM runs.

Status field Status of the Subnet Manager. It may appear as master, standby, 
inactive, or discovery.

Activity Count field Activity counter that increments each time the  SM issues an subnet 
management packet (SMP) or performs other management activities.

SM Key field 64-bit subnet management key assigned to the Subnet Manager. The 
SM key serves as the prefix of all GIDs and “brands” nodes as 
members of this subnet.

Priority field Priority of the SM relative to other SMs in the IB network. The higher 
the number, the greater the priority.

Sweep Interval field Specifies how frequently the SM queries the InfiniBand fabric for 
network changes.

Response Timeout field Maximum amount of time that the SM waits for a response after it 
sends a packet to a port. If the SM does not receive a response in time, 
the SM identifies the port as unresponsive.

Master Poll Interval field Interval at which the slave SM polls the master to see if it still runs.

Master Poll Retries field Number of unanswered polls that cause the slave to identify the master 
as dead.

Max Active SMs field Maximum number of standby SMs that the master supports. A value 
of 0 indicates unlimited SMs.

LID Mask Control field Number of path bits present in the base LID to each channel adapter 
port. Increasing the LMC value increases the number of LIDs assigned 
to each port to increase the number of potential paths to reach each 
port.

Switch Life Time field The life time of a packet inside a Server Switch. This value defaults to 
20.

Switch Link HoQ Life field The life time of a packet at the head-of-queue of a switch port. This 
value defaults to 20.

CA Link HoQ Life field The life time of a packet at the head-of-queue of the host port. This 
value defaults to 20.

Note Element Manager does not currently support this field.

Max Hops field Specifies the maximum hops.
8-8
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 8      InfiniBand Menu Tasks
  Viewing Subnet Manager Properties
Configuring the Subnet Manager Priority
To configure the SM priority, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of Subnet Manager properties appears.

Step 3 Highlight the value in the Priority column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring the Subnet Manager Sweep Interval
To configure the SM sweep interval, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of SM properties appears.

Step 3 Highlight the value in the Sweep Interval column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring the Subnet Manager Response Timeout
To configure the SM response timeout, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of Subnet Manager properties appears.

Step 3 Highlight the value in the Response Timeout column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring the Subnet Manager Master Poll Interval
To configure the interval at which the switch polls the master switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.
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Step 3 Highlight the value in the Master Poll Interval column and replace it with the value that you want to 
apply.

Step 4 Click the Apply button.

Configuring the Subnet Manager Master Poll Retries
To configure the number of failed polls that prompts the slave to identify the master as “down,” perform 
the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.

Step 3 Highlight the value in the Master Poll Retries column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring the Maximum Number of Active Subnet Managers
To configure the maximum number of active SMs on the IB network, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.

Step 3 Highlight the value in the Max Active SMs column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring the LID Mask Control
To configure LID mask control, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.

Step 3 Highlight the value in the LID Mask Control column and replace it with the value that you want to apply.

Step 4 Click the Apply button.
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Configuring the Switch Lifetime
To configure the switch life time, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.

Step 3 Highlight the value in the Switch Life Time column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring the Switch Link HoQ Life
To configure the switch link HoQ life, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.

Step 3 Highlight the value in the Switch Link HoQ Life column and replace it with the value that you want to 
apply.

Step 4 Click the Apply button.

Configuring CA Link HoQ Life
To configure the CA link HoQ life, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.

Step 3 Highlight the value in the CA Link HoQ Life column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Configuring Max Hops
To configure the maximum hops, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager tab. A table of  SM properties appears.
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Step 3 Highlight the value in the Max-Hops column and replace it with the value that you want to apply.

Step 4 Click the Apply button.

Viewing Database Synchronization Details
Element Manager provides multiple screens that you can use to configure database synchronization. 
Configuration details and field descriptions appear in the “Configuring Database Synchronization” 
section on page 8-25.

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Database Sync tab. Details appear in the table below the tab.

Note Database synchronization is enabled by default.

Understanding Partitions
A partition defines a set of InfiniBand nodes that are permitted to communicate with one another. 
Partitions provide the following: 

• Security

• Allows a large cluster to be divided and isolated into small sub-clusters.

• Maps IB nodes to selected VLANs

Note With database sync enabled on all chassis, only the chassis running the master SM will accept partition 
configuration from the user. For more information, see the “Configuring Database Synchronization” 
section on page 8-25.

How Partitions Work
A partition defines a set of InfiniBand nodes that are permitted to communicate with one another. Each 
node may be part of multiple partitions so that a system administrator can define overlapping partitions 
as the situation requires. Normal data packets carry a 16-bit P_Key, or partition key, that defines a unique 
partition. The Subnet Manager (SM) configures each node's channel adapter with its set of P_Keys. 
When a packet arrives at a node, the channel adapter checks that the packet's P_Key is valid based on 
the Subnet Manager's configuration. Packets with invalid P_Keys are discarded. P_Key validation 
prevents a server from communicating with another server outside of its partition.

InfiniBand partitions are comparable to hardware-enforced security features of conventional I/O 
networking technologies, such as Ethernet VLANs and Fibre-Channel zones. 
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Partition Members
Without members, a partition does not have meaning to the system. Ports are added to the partition, and 
become members of that partition. Each port may be part of multiple partitions so that the system 
administrator can define overlapping partitions as the situation requires. 

At the time a port member is added to the partition, the administrator must decide whether that particular 
port will have full or limited membership. 

Membership Types
A partition contains a group of members, but different types of members can exist within a single 
partition. Partition memberships allows even further control because it defines communication within 
the members of that group, and not just outside of it.

There are two types of partition memberships: full membership, and limited membership. A 
full-membership partition member can communicate with all other partition members, including other 
full members, as well as limited members. A limited-membership partition member cannot communicate 
with other limited-membership partition members. However, a limited partition member can 
communicate with a full member.

About the Default Partition

The  SM automatically configures a default partition, which is always p_key ff:ff. 

The default partition controls all connected ports, and by default, everything is a full member of the 
default partition. The default p_key cannot be altered or deleted as it is the controlling mechanism that 
manages the configuration of all the partitions. 

Selecting a P_Key Value
For a list of acceptable P_Key values, refer to Table 8-3 on page 8-15.

Upon creation, the p_key value, see Figure 8-1 is technically a 15-bit number. However, after the p_key 
is created and the port(s) membership type has been established, the entire value becomes 16 bits. The 
most significant bit (MSB) displays the type of membership (0 = Limited member, 1 = Full member).

When assigning a p_key value, you need to choose four hexadecimal numbers. However, because of the 
way that the 16th bit is used, only certain numbers can be used for the left-most variable (the MSB). For 
example, do not create two p_keys: 

0 #:# # and 8#:# #, as they will be viewed as the same number by the system. 
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Figure 8-1 Partition Keys

Hexadecimal to Binary Conversions

Table 8-2 is provided to assist in the creation of P_keys. 

When creating the partition p_key, enter a hexadecimal value that is the equivalent of 16 bits in binary. 
For example, enter 80:00 (hex) to be 10000000000000000 (binary). 

The default partition (which cannot be altered) is 7f:ff.

Table 8-2 Binary Conversions

Hexadecimal Binary

0 0000

1 0001

2 0010

3 0011
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Examples of Valid P_Key Values

You can choose your own p_key values, or you can choose your values from the list in Table 8-3. 

Understanding how P_Keys are Saved
Partition information is saved persistently by the master Subnet Manager. P_key information can be 
synchronized between the master  SM and a slave Subnet Manager. The synchronization of the subnet 
managers means that the partition configuration (and other information) is exchanged between the active 
and standby  SMs. The partition configuration will be transferred if an InfiniBand switch fails. 

The partition configuration is not saved persistently on a slave SM. 

If you have more than one InfiniBand switch in your fabric, refer to the “Enabling SM Database 
Synchronization” section on page 8-25.

4 0100

5 0101

6 0110

7 0111

8 1000

9 1001

A 1010

B 1011

C 1100

D 1101

E 1110

F 1111

Table 8-2 Binary Conversions (continued)

Hexadecimal Binary

Table 8-3 Valid P_Key Numbers

00:01 00:11

00:02 00:12

00:03 00:13

00:04 00:14

00:05 00:15

00:06 00:16

00:07 00:17

00:08 00:18

00:09 00:19

00:10 00:20
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If you are configuring one InfiniBand switch, it will automatically be the master, and the partition 
configuration is saved persistently on the switch. 

Viewing Partition Details
To view the attributes of the partitions on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Partitions tab. Details appear in the table below the tab. Table 8-4 lists and describes the fields 
in the table.

Configure Multicast Groups
To configure multicast groups, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Multicast Group Config tab.

Step 3 Click the CreateMulticastGroup radio button in the Action field.

Step 4 Enter a MGID in the Multicast Group ID field.

Step 5 (Optional) Enter a queue key in the QKey field.

Step 6 Click a radio button in the MTU field to configure the maximum transmission unit of the group.

Step 7 Enter a Traffic Class integer value (between 0 and 255) in the TClass field.

Step 8 Enter a partition key in the PKey field.

Table 8-4 Partition Field Descriptions

Field Description

SubnetPrefix Subnet prefix of the subnet whose partitions you want to view.

Key Partition key of the partition whose members the display prints below.

VectorIndex Index identifier of the vector of the partition. This value is available for 
application purposes.

Vector Vector of the partition table in which the partition resides. This value is 
available for application purposes.

VectorSize Size, in bytes, of the current vector. This value is available for application 
purposes.

VectorElementSize Size, in bytes, of each element of the vector. This value is available for 
application purposes.

LastChange Indicates the time stamp when the partition table was last changed.
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Step 9 Click a data rate radio button in the Rate field.

Step 10 Enter an integer value (between 0 and 63) in the Packet Life Time field.

Step 11 Enter an integer value (between 0 and 15) in the Service Level field.

Step 12 Enter a 16-bit label in the Flow Label field.

Step 13 Enter an integer value (between 0 and 255) in the Hop Limit field.

Step 14 Click a scope radio button in the Scope field.

Step 15 Click the Apply button.

Note The TClass, Packet Lifetime, Flow Label, and Hop Limit attributes are not supported in this release.

Configuring IPoIB Broadcast Multicast Groups
To configure IPoIB broadcast multicast groups, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Multicast Group Config tab.

Step 3 Click the CreateIPoIBbroadcastMulticastGroup radio button in the Action field.

Step 4 Enter a MGID in the Multicast Group ID field.

Step 5 (Optional) Enter a queue key in the QKey field.

Step 6 Click a radio button in the MTU field to configure the maximum transmission unit of the group.

Step 7 Enter a Traffic Class integer value (between 0 and 255) in the TClass field.

Step 8 Enter a partition key in the PKey field.

Step 9 Click a data rate radio button in the Rate field.

Step 10 Enter an integer value (between 0 and 63) in the Packet Life Time field.

Step 11 Enter an integer value (between 0 and 15) in the Service Level field.

Step 12 Enter a 16-bit label in the Flow Label field.

Step 13 Enter an integer value (between 0 and 255) in the Hop Limit field.

Step 14 Click a scope radio button in the Scope field.

Step 15 Click the Apply button.

Note The TClass, Packet Lifetime, Flow Label, and Hop Limit attributes are not relevant as of this release.
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Viewing Multicast Group Details
To view the attributes of the multicast groups on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Multicast Group tab. Details appear in the table below the tab. Table 8-5 lists and describes 
the fields in the table.

Viewing Multicast Member Details
To view the attributes of the multicast members on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Table 8-5 Multicast Group Field Descriptions

Field Description

SubnetPrefix Subnet prefix of the Subnet Manager.

MGID The 128-bit multicast GID address for this multicast group.

QKey The 16-bit Q-Key of this multicast group.

MLID The 16-bit LID of this multicast group.

MTU Maximum transmission unit 

TClass The Tclass to be used in the GRH if GRH is used.

PKey The 16-bit Partition Key for this multicast group.

Rate Traffic rate of this multicast group. 

PacketLifeTime Packet life time of this multicast group. 

SL Service level of this multicast group. 

FlowLabel Flow label to be used on this multicast group if GRH Is used. 

HopLimit Hop limit to be used on this multicast group if GRH Is used. 

Scope Scope of this multicast group. 

UserConfigured Displays “true” if a user configured the entry; otherwise displays “false.”
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Step 2 Click the Multicast Member tab. Details appear in the table below the tab. Table 8-5 lists and describes 
the fields in the table.

Viewing InfiniBand Services
Subnet services provide your IB fabric with various features, such as the ability to run particular 
protocols. To view the subnet services on your IB fabric, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Services tab. Details appear in the table below the tab. Table 8-7 lists and describes the fields 
in the Subnet Managers table.

Table 8-6 Multicast Member Field Descriptions

Field Description

SubnetPrefix Subnet prefix of this IB subnet.

MGID The 128-bit multicast GID address for this multicast group.

VectorIndex Index identifier of the particular vector of the multicast member table that 
contains the multicast member. This value is available for application purposes.

Vector Vector of the multicast member table that contains the multicast member. This 
value is available for application purposes.

VectorSize Size of the vector, in bytes, of the multicast member table that contains the 
multicast member. This value is available for application purposes.

VectorElementSize Size of the multicast member entry (element) in the multicast member table. 
This value is available for application purposes.

LastChange Indicates the time stamp when the multicast member table was last changed.

Table 8-7 Services Table Fields

Field Description

Subnet Prefix Subnet prefix of the subnet service.

ID Unique identifier that the SM assigns to the service.

GID Services use the same GID as the IB controller (node) on which they run.

PKey Partition key of the node on which the service runs.

Lease Lease period remaining (in seconds) for this service. A value of 4294967295 
means the lease is indefinite.

Key The 64-bit service key.
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Viewing Switch Route Details
Switch routes represent the complete path that traffic takes through the IB fabric from the source LID to 
the destination LID. To view the attributes of the switch routes on your Server Switch, perform the 
following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the SwitchRoute tab. Details appear in the table below the tab. Table 8-8 lists and describes the 
fields in the table.

Viewing Switch Element Route Details
To view the attributes of the switch element routes on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Name Name of the subnet service.

Data Data associated with this service.

Table 8-7 Services Table Fields (continued)

Field Description

Table 8-8 Switch Route Fields

Field Description

SubnetPrefix Subnet prefix of the route.

SourceLID Source LID of the route.

DestLID Destination LID of the route.

VectorIndex Index identifier of the particular vector of the route table that contains the 
route. This value is available for application purposes.

Vector Vector of the route table that contains the route. This value is available for 
application purposes.

VectorSize Size of the vector, in bytes, of the route table that contains the route. This 
value is available for application purposes.

VectorElementSize Size of the route entry (element) in the route table. This value is available for 
application purposes.

LastChange Indicates the time stamp when the route table was last changed.
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Step 2 Click the SwitchElementRoute tab. Details appear in the table below the tab. Table 8-9 lists and 
describes the fields in the table.

Adding a Subnet Manager
To add a Subnet Manager to your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 In the left-hand navigation bar, click Subnet Managers. The Subnet Managers display appears in the 
right-hand portion of the window.

Step 3 Click the Add button in the bottom-right-hand section of the window. The Add Subnet Manager window 
opens.

Step 4 Enter a subnet prefix in the Subnet Prefix field.

Step 5 Enter a subnet priority level in the Priority field.

Step 6 (Optional) Enter a subnet management key in the smKey field.

Step 7 (Optional) Enter a value in the LID Mask Control field to increase the number of LIDs assigned to each 
port to increase the number of potential paths to reach each port.

Step 8 Click the Add button. The new SM appears in the Summary table in the Subnet Managers display.

Table 8-9 Switch Element Route Fields

Field Description

SubnetPrefix Subnet prefix of this IB subnet.

SourceLID Source LID of the route.

DestLID Destination LID of the route.

VectorIndex Index identifier of the particular vector of the route table that contains the route. 
This value is available for application purposes.

Vector Vector of the route table that contains the route. This value is available for 
application purposes.

VectorSize Size of the vector, in bytes, of the route table that contains the route. This value 
is available for application purposes.

VectorElementSize Size of the route entry (element) in the route table. This value is available for 
application purposes.

LastChange Indicates the time stamp when the route table was last changed.
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Removing a Subnet Manager
To add a Subnet Manager to your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 In the left-hand navigation bar, click Subnet Managers. The Subnet Managers display appears in the 
right-hand portion of the window.

Step 3 In the Summary table in the Subnet Managers display, click the SM that you want to remove.

Step 4 Click the Remove button. The entry disappears from the display and the Server Switch configuration.

Configuring Subnet Manager Properties
 SMs provide a number of user-configurable attributes. The sections that follow explain each attribute 
and describe how to configure it.

Configuring SM Priority
Every Subnet Manager in the InfiniBand network carries a priority value, and at any given time the 
Subnet Manager with the highest integer value priority becomes the master Subnet Manager. To 
configure the Subnet Manager priority on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Priority field. The higher the integer value, the higher the priority.

Step 4 Click the Apply button.

Configuring Sweep Interval
The sweep interval specifies how frequently the SM queries the InfiniBand fabric for network changes. 
To configure the sweep interval on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Sweep Interval field. This interval represents the number of seconds 
between sweeps.

Step 4 Click the Apply button.
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Configuring Response Timeout
The response timeout of a SM specifies the maximum amount of time that the SM waits for a response 
after it sends a packet to a port. If the SM does not receive a response in the response-time interval, the 
SM identifies the port as unresponsive. To configure the response timeout, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Response Timeout field. The SM measures response timeout in 
milliseconds.

Step 4 Click the Apply button.

Configuring the Master Poll Interval
The master poll interval determines the interval at which the slave SM polls the master to see if the 
master still runs. To configure the master poll interval, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Master Poll Interval field. The value represents the interval, in seconds.

Step 4 Click the Apply button.

Configuring the Number of Master Poll Retries
The master poll retries value specifies the number of unanswered polls that cause the slave to identify 
the master as dead. To configure this value, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Master Poll Retries field.

Step 4 Click the Apply button.
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Configuring the Maximum Number of Active Standby SMs that the Master SM 
Supports

Note As of this release, the master SM supports sync with only one standby.

To configure an unlimited number of active standby (slave) SMs, enter a value of 0. To configure this 
value, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Max active SMs field.

Step 4 Click the Apply button.

Configuring LID Mask Control
LID mask control assigns the number of path bits present in the base LID to each channel adapter port. 
Increasing the LMC value increases the number of LIDs assigned to each port to increase the number of 
potential paths to reach each port. To configure LID mask control, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the LID Mask Control field.

Step 4 Click the Apply button.

Configuring Switch Life Time

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Switch Life Time field.

Step 4 Click the Apply button.
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Configuring Switch Link HoQ Life

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Switch Link HoQ Life field.

Step 4 Click the Apply button.

Configuring Max Hops

Step 1 Click the InfiniBand menu and choose Subnet Management (tabular format). The Subnet Manager 
window opens.

Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Enter an integer value in the Max-Hops field.

Step 4 Click the Apply button.

Configuring Database Synchronization
The database synchronization feature propagates information from the database of the master SM to the 
standby SMs. The sections that follow describe how to configure this feature.

Note With database sync enabled on all chassis, only the chassis running the master SM will accept partition 
configuration from the user. For more information, see <Link>“How Partitions Work” on 
page 12<Link>.

Enabling SM Database Synchronization
If you are configuring more than one InfiniBand chassis in your fabric, it is likely that you will want to 
enable database synchronization of the  SMs.

Note This features is enabled by default.

Enable Subnet Manager database synchronization to update standby SMs with information in the master 
SM.

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.
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Step 2 Click the Subnet Manager that you want to configure. Each Subnet Manager appears in the left-hand 
navigation window with a Subnet Manager icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Check the Enable checkbox in the SM Database Synchronization field.

Step 5 Click the Apply button.

Configuring the Maximum Number of Backup Subnet Managers to Synchronize
To configure the maximum number of backup  SMs that will synchronize with the master SM, perform 
the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Max Backup SMs field.

Step 5 Click the Apply button.

Configuring Session Timeout
To configure the interval, in seconds, during which a synchronization session status MAD packet must 
arrive at the master SM to maintain synchronization, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Session Timeout field. This value determines the timeout duration, in 
seconds.

Step 5 Click the Apply button.

Configuring the Poll Interval
To configure the interval, in seconds, at which the master SM polls an active slave SM to verify 
synchronization, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.
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Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Poll Interval field. This value sets the poll interval, in seconds.

Step 5 Click the Apply button.

Configuring the Cold Sync Timeout Value
To configure the amount of time, in seconds, that a cold synchronization tries to initiate before it times 
out, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Cold Sync Timeout field. This value sets the timeout interval, in seconds.

Step 5 Click the Apply button.

Configuring the Cold Sync Limit Value
To configure the maximum number of cold syncs to perform during a given cold sync period, perform 
the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Cold Sync Limit field. This value sets the maximum number of syncs that 
can occur during the sync period (“Configuring the Cold Sync Limit Period” section on page 8-27).

Step 5 Click the Apply button.

Configuring the Cold Sync Limit Period
To specify the length of the interval during which cold syncs may occur, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).
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Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Cold Sync Limit Period field. This value sets the length of the interval 
during which cold syncs may occur.

Step 5 Click the Apply button.

Configuring the New Session Delay
To specify the amount of time that the master SM waits before it attempts to initiate a synchronization 
session with a new SM, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the New Session Delay field. This value determines the amount of time, in 
seconds, that the master SM waits before it attempts to initiate a synchronization session with a new SM.

Step 5 Click the Apply button.

Configuring the Resync Interval
To specify the interval at which the master SM sends a resynchronization request to all active sync 
sessions, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 Enter an integer value in the Resync Interval field. This value specifies the interval, in seconds, at which 
the master SM sends a resynchronization request to all active sync sessions.

Step 5 Click the Apply button.

Viewing the Database Synchronization State
To verify that the master SM and slave SM(s) are in sync, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).
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Step 3 Click the Database Sync tab in the right-hand panel of the display.

Step 4 View the State field.

Viewing Nodes

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the  SM that you want to configure. Each  SM appears in the left-hand navigation window with a  
SM icon ( ).

Step 3 Click the Nodes icon.

Step 4 Click the Nodes in Subnet tab to display the Node GUID, Type, Description, Number of Ports, System 
Image GUID, and the Vendor ID information.

Viewing Partitions
To view the partitions on your IB network, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Partitions ( ) branch. The partitions summary appears in the right-hand display. 
<Link>Table 8-10 lists and describes the fields in this display.

Creating a Partition
To create an IB partition, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Table 8-10 Partitions Summary Field Descriptions

Field Description

Partition Key Partition key (numeric identifier) of the partition.

Full Member Count Number of full partition members.

Limited Member Count Number of limited partition members.
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Step 3 Click the Partitions ( ) branch.

Step 4 Click the Add button. The Add Partition window opens.

Step 5 Enter a partition key for the new partition in the PKey field, then click the Add button.

Removing a Partition
To delete a partition, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Partitions ( ) branch.

Step 4 Click the partition, in the Summary display, that you want to remove, then click the Remove button.

Viewing Partition Details
To view partition details, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the plus-sign (+) next to the Partitions ( ) branch to display all partitions in the left-hand 
navigation menu.

Step 4 Click the partition key of the partition whose details you want to view. The members (full and limited) 
of the partition appear in the display.

Note To view the GUIDs of the Server Switch management ports in the display, click the Show Switch 
Mgmt Ports button. Click the Hide Switch Mgmt Ports button to remove these GUIDs from 
the display.

Adding Full Members to a Partition
Full members of a partition can communicate to other full members and to limited members.

Adding Available Members

To add a port from the Available Members pool to a partition as a full member, perform the following 
steps:
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Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the plus-sign (+) next to the Partitions ( ) branch to display all partitions in the left-hand 
navigation menu.

Step 4 Click the partition key of the partition to which you want to add members. The members (full and 
limited) of the partition appear in the display.

Step 5 Click the port, in the Available Members field, that you want to add to the partition, then click the 
right-pointing arrow next to the Full Members field.

Adding Unavailable Members

To add a partition member that does not appear in the Available Members pool, perform the following 
steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the plus-sign (+) next to the Partitions ( ) branch to display all partitions in the left-hand 
navigation menu.

Step 4 Click the partition key of the partition to which you want to add members. The members (full and 
limited) of the partition appear in the display.

Step 5 Click the Add Other button. The Add Other Partition Member window opens.

Step 6 Enter the GUID of the host that includes the port(s) that you want to add to the partition in the Node 
GUID field.

Step 7 Specify the port(s) that you want to add to the partition in the Port field.

Step 8 Click the Full radio button, then click the Add button.

Adding Limited Members to a Partition
Limited members of a partition can communicate with full members of the partition, but not with other 
limited members.

Adding Available Members

To add a port from the Available Members pool to a partition as a limited member, perform the 
following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.
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Step 3 Click the plus-sign (+) next to the Partitions ( ) branch to display all partitions in the left-hand 
navigation menu.

Step 4 Click the partition key of the partition to which you want to add members. The members (full and 
limited) of the partition appear in the display.

Step 5 Click the port, in the Available Members field, that you want to add to the partition, then click the 
right-pointing arrow next to the Limited Members field.

Adding Unavailable Members

To add a partition member that does not appear in the Available Members pool, perform the following 
steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the plus-sign (+) next to the Partitions ( ) branch to display all partitions in the left-hand 
navigation menu.

Step 4 Click the partition key of the partition to which you want to add members. The members (full and 
limited) of the partition appear in the display.

Step 5 Click the Add Other button. The Add Other Partition Member window opens.

Step 6 Enter the GUID of the node that includes the port(s) that you want to add to the partition in the Node 
GUID field.

Step 7 Specify the port(s) that you want to add to the partition in the Port field.

Step 8 Click the Limited radio button, then click the Add button.

Viewing Multicast Groups
To view the multicast groups on your IB network, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose partitions you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Multicast Groups ( ) branch. The multicast groups summary appears in the right-hand 
display. Table 8-11 lists and describes the fields in this display.

Table 8-11 Multicast Group Summary Field Descriptions

Field Description

MGID Numeric multicast group identifier of each multicast group on the IB fabric.

QKey The 16-bit Q-Key of this multicast group.
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Viewing Multicast Group Details
To view multicast group details, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose multicast groups you want to view. The left-hand 
navigation menu expands.

Step 3 Click the plus-sign (+) next to the Multicast Groups ( ) branch to display all groups in the left-hand 
navigation menu.

Step 4 Click the MGID of the multicast group whose details you want to view, then click the General tab. MC 
group details appear in the display. Table 8-12 lists and describes the fields in this display.

Viewing Multicast Group Members

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

MTU Maximum transmission unit of the multicast group.

PKey Partition key of the multicast group.

Table 8-11 Multicast Group Summary Field Descriptions (continued)

Field Description

Table 8-12 Multicast Group General Details Field Descriptions

Field Description

QKey The 16-bit Q-Key of this multicast group.

MLID The 16-bit LID of this multicast group

MTU Maximum transmission unit of the multicast group.

TClass The Tclass to be used in the GRH if GRH is used.

PKey Partition key of the multicast group.

Rate Traffic rate of this multicast group.

Packet Life Time Packet life time of this multicast group.

SL Service level of this multicast group.

Flow Label Flow label to be used on this multicast group if GRH Is used.

Hop Limit Hop limit to be used on this multicast group if GRH Is used.

Scope Scope of this multicast group.

User Configured Displays true if a user configured the entry; otherwise displays false.
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Step 2 Click the plus-sign (+) next to the  SM whose multicast groups you want to view. The left-hand 
navigation menu expands.

Step 3 Click the plus-sign (+) next to the Multicast Groups ( ) branch to display all groups in the left-hand 
navigation menu.

Step 4 Click the MGID of the multicast group whose details you want to view, then click the Members tab. MC 
group members appear in the display. Table 8-13 lists and describes the fields in this display.

Viewing Infiniband Services
To view the IB services that run on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose services you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Services ( ) branch. Details of IB services appear in the right-hand display. Table 8-14 lists 
and describes the fields in the Summary section of the display.

Table 8-15 lists and describes the fields in the Details section of the display.

Table 8-13 Multicast Group Members Field Descriptions

Field Description

Port GID Global identifier of the member port.

Join State Displays whether the port is a full member or limited member of the group. 

Proxy Join Status Displays true or false.

Table 8-14 Services Summary Field Descriptions

Field Description

Name ASCII identifier of the service

Service Id Numeric identifier that nodes use to call the service.

Service GID 64-bit ID of the service.

PKey 16-bit multicast GID address.

Table 8-15 Services Details Field Descriptions

Field Description

Service Name ASCII identifier of the service

Service Id Numeric identifier that nodes use to call the service.

Service GID GID of the node that provides the service.

Service PKey 16-bit P-Key.
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Viewing InfiniBand Routes
To view the IB routes that run on your Server Switch, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose services you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Routes ( ) branch. IB routes fields appear in the right-hand display.

Step 4 Enter the source LID of the route in the Source LID field.

Step 5 Enter the destination lid of the route in the Destination LID field.

Step 6 Click the Show Route button.

Step 7 Click the Switch Route tab. Table 8-16 lists and displays the fields in the display.

Step 8 Click the Switch Element Route tab. Table 8-17 lists and displays the fields in the display.

Lease Lease period remaining (in seconds) for this service. A value of 4294967295 
means the lease is indefinite.

Key 128-bit service key.

Data (8 bit) Header of the data type 8

Data (16 bit) Header of the data type 16

Data (32 bit) Header of the data type 32

Data (64 bit) Header of the data type 64

Table 8-15 Services Details Field Descriptions (continued)

Field Description

Table 8-16 Switch Route Field Descriptions

Field Description

Node GUID Global unique ID of the node.

In Port Port of ingress.

Out Port Port of egress

Table 8-17 Switch Element Route Field Descriptions

Field Description

Chassis GUID Global unique ID of the node.

In Port Port of ingress.

Out Port Port of egress
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Viewing Subnet Managers Information
To view the  SM information, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose services you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Subnet Managers Info icon and the Port GUID, Priority, and SM state information appears in 
the right-hand display.

Viewing Event Subscriptions
To view the  SM information, perform the following steps:

Step 1 Click the InfiniBand menu and choose Subnet Management. The Subnet Management window opens.

Step 2 Click the plus-sign (+) next to the  SM whose services you want to view. The left-hand navigation menu 
expands.

Step 3 Click the Event Subscriptions icon and the LID, Node GUID, and Port Number information appears in 
the right-hand display.

Enabling Performance Management
To enable InfiniBand-port performance management, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the subnet of the ports that you want to manage (for instance, fe:80:00:00:00:00:00:00). The Port 
Counter Configuration display appears in the right-hand pane of the window.

Step 3 Click the Enable radio button.

Disabling Performance Management
To disable performance management, perform the following steps:
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Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the subnet of the ports that you want to manage (for instance, fe:80:00:00:00:00:00:00). The Port 
Counter Configuration display appears in the right-hand pane of the window.

Step 3 Click the Disable radio button.

Monitoring Connections
To monitor connections, you must

• “Defining a Connection to Monitor” section on page 8-37

• “Viewing Monitored Connections” section on page 8-38

• “Viewing Connection Counters” section on page 8-38

• “Viewing Connection Monitor Counters” section on page 8-39

• “Testing Connections” section on page 8-40

• “Viewing Port Counters of Connections” section on page 8-40

Defining a Connection to Monitor
To create a connection to monitor, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the Connection Counters branch. The Monitored Connection tab appears in the right-hand pane 
of the window.

Step 4 Click the Add button. The Add Connection window opens.

Step 5 Enter a source LID in the Source LID field.

Note To view available source and destination LIDs, return to the main Element Manager display, 
click the InfiniBand menu, choose Subnet Management (tabular format), then click the 
SwitchRoute tab. For more details, see “Viewing Switch Route Details” section on page 8-20.

Step 6 Enter a destination LID in the Destination LID field.

Step 7 Check the Enable Connection Monitoring checkbox.

Note If this checkbox is not selected, you an view only counter information and cannot view 
monitoring information.
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Step 8 Click the Add button. The connection entry appears under the Monitored Connections tab.

Viewing Monitored Connections
These instructions assume that you have already defined connections to monitor. To view monitored 
connections, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the Connection Counters branch. The Monitored Connection tab appears in the right-hand pane 
of the window. Table 8-18 lists and describes the fields in this display.

Viewing Connection Counters
To view connection counters, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands.

Step 4 Click the icon ( ) of the connection whose counters you want to view.

Step 5 Click the Connection Counters tab. Table 8-19 lists and describes the fields in the display.

Table 8-18 Monitored Connections Field Descriptions

Field Description

Subnet Prefix Subnet prefix of the monitored connection.

Source LID 16-bit source Local ID of the connection.

Destination LID 16-bit destination Local ID of the connection.

Error Status Displays unknown, exceeded, or notExceeded to indicate if the error value has 
exceeded the threshold that you configured. To configure thresholds, refer to 
“Configuring Port Monitoring Thresholds” section on page 8-48.

Util Status Displays unknown, exceeded, or notExceeded to indicate if the utilization value has 
exceeded the threshold that you configured. To configure thresholds, refer to 
“Configuring Port Monitoring Thresholds” section on page 8-48.
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Note Each hop in the display is a port on a node. When connections move through nodes, they enter 
the node in one hop (GUID A, port a), and exit in another hop (GUID A, port b). Though the 
GUIDs of subsequent hops may match, the ports do not match.

Viewing Connection Monitor Counters
To view connection monitor counters, perform the following steps:

Table 8-19 Connection Counters Field Descriptions

Field Description

Subnet Prefix Subnet prefix of the subnet on which each hop resides.

Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of the 
next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Chassis Guid Global Unique ID (GUID) of the chassis.

Slot Number Slot of the port.

Ext Port Number External port number of the port.

Data Is Valid Displays true or false.

Symbol Errors Number of symbol errors on the port.

Link Recovery Errors Number of link recovery errors on the port.

Link Downs Number of link-down errors on the port.

Received Errors Number of received errors that the port experienced.

Received Remote Physical Errors Number of physical errors the the port experienced.

Received Switch Relay Errors Number of switch relay errors that the port experienced.

Transmitted Discards Number of transmitted discards that occurred on the port.

Transmitted Constraint Errors Number of Transmitted Constraint errors that the port 
experienced.

Received Constraint Errors Number of Received Constraint errors that the port experienced.

Local Link Integrity Errors Number of logical link integrity errors on the port.

Excessive Buffer Overrun Errors Number of excessive buffer overrun errors on the port.

VL15 Droppeds Number of VL15 drops on the port.

Transmitted Data Volume of transmitted data on the port.

Received Data Volume of received data on the port.

Transmitted Packets Volume of transmitted packets on the port.

Received Packets Volume of received packets on the port.
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Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands.

Step 4 Click the icon ( ) of the connection whose counters you want to view.

Step 5 Click the Connection Monitor Counters tab. Table 8-20 lists and describes the fields in the display.

Testing Connections
To test connections, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands.

Step 4 Click the icon ( ) of the connection whose counters you want to view.

Step 5 Click the Test Connection tab.

Step 6 Click the Test button.

Viewing Port Counters of Connections
To view port counters, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Table 8-20 Connection Monitor Counters Field Descriptions

Field Description

Node Guid Global unique ID of the IB node of the hop port.

Port Number Port number of the hop.

Chassis Guid GUID of the chassis that includes the connection.

Slot Number Slot number of the port(s) in the connection.

Ext Port Number External port number of the connection port.

Error Type Type of error that occurred.
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Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands.

Step 4 Click the plus-sign next to the icon ( ) of the connection whose port counters you want to view. The 
navigation tree expands.

Step 5 Click the port (in GUID - port-number format) whose counters you want to view. Table 8-21 lists and 
describes the fields in this display.

Table 8-21 Port Counters Field Descriptions

Field Description

Subnet Prefix Subnet prefix of the subnet on which each hop resides.

Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of the 
next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Chassis Guid GUID of the chassis that includes the connection.

Slot Number Slot number of the port(s) in the connection.

Ext Port Number External port number of the connection port.

Symbol Errors Total number of symbol errors detected on one or more lanes.

Link Recovery Errors Total number of times the port training state machine has 
successfully completed the link error recovery process.

Link Downs Total number of times the port training state machine has failed 
the link error recovery process and downed the link.

Received Errors Total number of packets containing an error that were received 
on the port. These errors include: 

• Local physical errors (ICRC, VCRC, FCCRC, and all 
physical errors that cause entry into bad) 

• Malformed data packet errors (Lver, length, VL) 

• Malformed link packet errors (operand, length, VL) 

• Packets discarded due to buffer overrun

Received Remote Physical Errors Total number of packets marked with the EBP delimiter received 
on the port.

Received Switch Relay Errors Total number of packets received on the port that were discarded 
because they could be forwarded by the switch relay. Reasons for 
this include:

• DLID mapping 

• VL mapping 

• Looping (output port = input port).
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Transmitted Discards Total number of outbound packets discarded by the port because 
the port is down or congested. Reasons for this include: 

• Output port is in the inactive state

• Packet length exceeded neighbor MTU

• Switch lifetime limit exceeds

• Switch HOQ limit exceeds

Transmitted Constraint Errors Total number of packets not transmitted from the port for the 
following reasons: 

• FilterRawOutbound is true and packet is raw 

• PatitionEnforcementOutbound is true and packet fails 
partition key check, IP version check, or transport header 
version check.

Received Constraint Errors Total number of packets received on the port that are discarded 
for the following reasons: 

• FilterRawInbound is true and packet is raw 

• PartitionEnforcementInbound is true and packet fails 
partition key check, IP version check, or transport header 
version check.

Local Link Integrity Errors The number of times that the frequency of packets containing 
local physical errors exceeded local_phy_errors.

Excessive Buffer Overrun Errors The number of times that overrun errors’ consecutive flow 
control update periods occurred with at least one overrun error in 
each period.

VL15 Droppeds Number of incoming VL15 packets dropped due to resource 
limitations on port selected by PortSelect.

Transmitted Data Optional; shall be zero if not implemented. Total number of data 
octets, divided by 4, transmitted on all VLs from the port 
selected by PortSelect. This includes all octets between (and not 
including) the start of packet delimiter and VCRC. It excludes all 
link packets.

Implementers may choose to count data octets in groups larger 
than four but are encouraged to choose the smallest group 
possible. Results are still reported as a multiple of four octets.

Received Data Optional; shall be zero if not implemented. Total number of data 
octets, divided by 4, received on all VLs from the port selected 
by PortSelect. This includes all octets between (and not 
including) the start of packet delimiter and VCRC. It excludes all 
link packets. 

Implementers may choose to count data octets in groups larger 
than four but are encouraged to choose the smallest group 
possible. Results are still reported as a multiple of four octets.

Table 8-21 Port Counters Field Descriptions (continued)

Field Description
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Viewing Port Counters
To view port counters, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Port Counters branch. The navigation tree expands.

Step 4 View port counters with one of the following methods:

– Click the GUID whose port counters you want to view; all available port counters appear.

– Click the plus-sign next to the GUID of the node whose port counters you want to view, then 
click the port whose counters you want to view; counters appear for that individual port.

Table 8-22 lists and describes the fields in the port counters display.

Transmitted Packets Optional; shall be zero if not implemented. Total number of data 
packets, excluding link packets, transmitted on all VLs from the 
port selected by PortSelect.

Received Packets Optional; shall be zero if not implemented. Total number of data 
packets, excluding link packets, received on all VLs from the 
port selected by PortSelect.

Table 8-21 Port Counters Field Descriptions (continued)

Field Description

Table 8-22 Port Counters Field Descriptions

Field Description

Subnet Prefix Subnet prefix of the subnet on which each hop resides.

Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of the 
next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Chassis Guid GUID of the chassis that includes the connection.

Slot Number Slot number of the port(s) in the connection.

Ext Port Number External port number of the connection port.

Symbol Errors Total number of symbol errors detected on one or more lanes.

Link Recovery Errors Total number of times the port training state machine has 
successfully completed the link error recovery process.

Link Downs Total number of times the port training state machine has failed 
the link error recovery process and downed the link.
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Received Errors Total number of packets containing an error that were received 
on the port. These errors include: 

• Local physical errors (ICRC, VCRC, FCCRC, and all 
physical errors that cause entry into the “bad” state) 

• Malformed data packet errors (Lver, length, VL) 

• Malformed link packet errors (operand, length, VL) 

• Packets discarded due to buffer overrun

Received Remote Physical Errors Total number of packets marked with the EBP delimiter received 
on the port.

Received Switch Relay Errors Total number of packets received on the port that were discarded 
because they could be forwarded by the switch relay. Reasons for 
this include:

• DLID mapping 

• VL mapping 

• Looping (output port = input port).

Transmitted Discards Total number of outbound packets discarded by the port because 
the port is down or congested. Reasons for this include: 

• Output port is in the inactive state 

• Packet length exceeded neighbor MTU 

• Switch lifetime limit exceeds 

• Switch HOQ limit exceeds.

Transmitted Constraint Errors Total number of packets not transmitted from the port for the 
following reasons: 

• FilterRawOutbound is true and packet is raw 

• PatitionEnforcementOutbound is true and packet fails 
partition key check, IP version check, or transport header 
version check.

Received Constraint Errors Total number of packets received on the port that are discarded 
for the following reasons: 

• FilterRawInbound is true and packet is raw 

• PartitionEnforcementInbound is true and packet fails 
partition key check, IP version check, or transport header 
version check.

Logical Link Integrity Errors The number of times that the frequency of packets containing 
local physical errors exceeded local_phy_errors.

Excessive Buffer Overrun Errors The number of times that overrun errors consecutive flow control 
update periods occurred with at least one overrun error in each 
period.

VL15 Droppeds Number of incoming VL15 packets dropped due to resource 
limitations on port selected by PortSelect.

Table 8-22 Port Counters Field Descriptions (continued)

Field Description
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Received Switch Relay Errors Total number of packets received on the port that were discarded 
because they could be forwarded by the switch relay. Reasons for 
this include:

• DLID mapping 

• VL mapping 

• Looping (output port = input port).

Transmitted Discards Total number of outbound packets discarded by the port because 
the port is down or congested. Reasons for this include: 

• Output port is in the inactive state 

• Packet length exceeded neighbor MTU 

• Switch lifetime limit exceeds 

• Switch HOQ limit exceeds.

Transmitted Constraint Errors Total number of packets not transmitted from the port for the 
following reasons: 

• FilterRawOutbound is true and packet is raw 

• PatitionEnforcementOutbound is true and packet fails 
partition key check, IP version check, or transport header 
version check.

Received Constraint Errors Total number of packets received on the port that are discarded 
for the following reasons: 

• FilterRawInbound is true and packet is raw 

• PartitionEnforcementInbound is true and packet fails 
partition key check, IP version check, or transport header 
version check.

Logical Link Integrity Errors The number of times that the frequency of packets containing 
local physical errors exceeded local_phy_errors.

Excessive Buffer Overrun Errors The number of times that overrun errors consecutive flow control 
update periods occurred with at least one overrun error in each 
period.

VL15 Droppeds Number of incoming VL15 packets dropped due to resource 
limitations on port selected by PortSelect.

Table 8-22 Port Counters Field Descriptions (continued)

Field Description
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Viewing Cumulative Port Counters
To view cumulative port counters, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Port Counters branch. The navigation tree expands.

Step 4 Click the plus-sign next to the node of the port whose cumulative counters you want to view. The 
navigation tree expands.

Step 5 Click the port whose navigation counters you want to view.

Step 6 Click the Port Cumulative Counters tab. Table 8-23 lists and describes the fields in the display.

Received Data Optional; shall be zero if not implemented. Total number of data 
octets, divided by 4, received on all VLs from the port selected 
by PortSelect. This includes all octets between (and not 
including) the start of packet delimiter and VCRC. It excludes all 
link packets. 

Implementers may choose to count data octets in groups larger 
than four but are encouraged to choose the smallest group 
possible. Results are still reported as a multiple of four octets.

Transmitted Packets Optional; shall be zero if not implemented. Total number of data 
packets, excluding link packets, transmitted on all VLs from the 
port selected by PortSelect.

Received Packets Optional; shall be zero if not implemented. Total number of data 
packets, excluding link packets, received on all VLs from the 
port selected by PortSelect.

Table 8-22 Port Counters Field Descriptions (continued)

Field Description

Table 8-23 Cumulative Port Counters Field Descriptions

Field Description

Subnet Prefix Subnet prefix of the subnet on which each hop resides.

Node Guid Global unique ID of the node (switch chip, HCA, or TCA) of the 
next-hop port.

Port Number Port number (on the appropriate node) of the hop.

Chassis Guid Global Unique ID (GUID) of the chassis.

Slot Number Slot of the port.

Ext Port Number External port number of the port.
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Enabling Port Monitoring
To enable port monitoring, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the Port Monitor branch.

Step 4 Click the General tab.

Step 5 Select Enable from the State pulldown menu.

Error Status Displays true or false.

Util Status Number of symbol errors on the port.

Symbol Errors Number of link recovery errors on the port.

Link Recovery Errors Number of link-down errors on the port.

Link Downs Number of received errors that the port experienced.

Received Errors Number of physical errors the the port experienced.

Received Remote Physical Errors Number of switch relay errors that the port experienced.

Received Switch Relay Errors Number of transmitted discards that occurred on the port.

Transmit Discards Number of Transmit Constraint errors that the port experienced.

Transmit Constraint Errors Number of Received Constraint errors that the port experienced.

Received Constraint Errors Number of logical link integrity errors on the port.

Logical Link Integrity Errors Number of excessive buffer overrun errors on the port.

Excessive Buffer Overrun Errors Number of VL15 drops on the port.

VL15 Droppeds Volume of transmitted data on the port.

Transmit Data Volume of received data on the port.

Received Data Volume of transmitted packets on the port.

Transmit Packets Volume of received packets on the port.

Received Packets Subnet prefix of the subnet on which each hop resides.

Transmit Rate Global unique ID of the node (switch chip, HCA, or TCA) of the 
next-hop port.

Received Rate Port number (on the appropriate node) of the hop.

Table 8-23 Cumulative Port Counters Field Descriptions (continued)

Field Description
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Note Enable will enable the port monitoring for only the ports that are configured in the Monitor Port 
Config table, where as enableAll will enable the port monitoring for all ports regardless of 
whether the port is configured in the Monitor Port Config table or not.

Step 6 Click the Apply button.

Configuring Port Monitoring

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the Port Monitor branch.

Step 4 Click the General tab.

Step 5 Enter an integer value, between 1 and 600, in the Polling Period field to configure the number of seconds 
between polls.

Step 6 Enter an integer value, between 1 and 600, in the Start Delay field to configure the delay between startup 
and polling.

Configuring Port Monitoring Thresholds
To configure port monitoring thresholds, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the Port Monitor branch.

Step 4 Click the Threshold tab.

Step 5 Enter an integer value in the fields where you want to apply a threshold. Enter none in the fields to which 
you do not want to apply a threshold.

Step 6 Click the Apply button.

Resetting Counters
You can reset counters for

• A hop.
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• All ports on a node.

• All ports in a connection.

• All ports in a subnet.

Resetting Counters on a Hop

To reset counters on a hop, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands and 
connections appear.

Step 4 Click the plus-sign next to the connection that includes the hop that you want to clear. The navigation 
tree expands and hops appear.

Step 5 Right-click the hop whose counters you want to clear and chooseClear counters on this Hop from the 
right-click menu.

Resetting Counters on All Ports on a Node

To reset counters on a node, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands and 
connections appear.

Step 4 Click the plus-sign next to the connection that includes the node that you want to clear. The navigation 
tree expands and nodes appear.

Step 5 Right-click the node whose counters you want to clear and chooseClear counters on this Node from 
the right-click menu.

Resetting Counters on All Ports in a Connection

To reset counters on a hop, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.
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Step 3 Click the plus-sign next to the Connection Counters branch. The navigation tree expands and 
connections appear.

Step 4 Right-click the connection whose counters you want to clear and chooseClear counters on this 
Connection from the right-click menu.

Resetting All Counters in a Subnet

To reset all counters in a subnet, perform the following steps:

Step 1 Click the InfiniBand menu and choosePerformance Management. The Performance Management 
window opens.

Step 2 Click the plus-sign (+) next to the subnet of the connections that you want to monitor. The navigation 
tree expands.

Step 3 Right-click the Connection Counters branch and chooseClear Counters for All Connections.

Launching Topology View
To launch topology view, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology appears.

Note Navigation buttons appear at the top of the InfiniBand Topology window. Table 8-24 lists and describes 
these buttons.

Table 8-24 InfiniBand Topology Navigation Buttons

Button‘ Description

Refresh Refreshes the topology display.

Layout Evenly arranges the switch and HCA icons.

Zoom In Enlarges the display.
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Viewing Internal Server Switch Components
To view the switches and target channel adapters (TCAs) inside a server switch, perform the following 
steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Zoom Out Condenses the display.

Fit to Screen Zooms in or out to fit the topology in the window.

Specify Topspin Devices Opens the Specify Cisco Devices dialog box to add Server Switches to the 
display.

Legend Displays the different colors that represent different types of links.

Subnet Details Displays subnet details. For more information, refer to <Link>“Viewing 
Subnet Details” on page 52<Link>.

Help Launches on-line help.

Table 8-24 InfiniBand Topology Navigation Buttons (continued)

Button‘ Description
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Note Navigation buttons appear at the top of the InfiniBand Topology window. Table 8-25 lists and describes 
these buttons.

Viewing Subnet Details
You can view any of the following subnet details:

• nodes

• ports

• switches

• neighbors

Table 8-25 Internal InfiniBand Topology Navigation Buttons

Button Description

Layout Evenly arranges the switch and HCA icons.

Zoom In Enlarges the display.

Zoom Out Condenses the display.

Fit to Screen Zooms in or out to fit the topology in the window.

Layout Evenly arranges the switch and HCA icons.

Subnet Management 
Agents

Displays  SM agent details. For information, refer to <Link>“Viewing 
Subnet Management Agents” on page 56<Link>.

Help Launches on-line help.
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Viewing Nodes
To view the nodes in the topology view, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Click the Details button. The InfiniBand Subnet Details window opens.

Step 5 Click the Nodes tab. Table 8-26 lists and describes the fields in this tab.

Viewing Ports
To view the ports in the topology view, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Click the Details button. The InfiniBand Subnet Details window opens.

Step 5 Click the Ports tab. Table 8-27 lists and describes the fields in this tab.

Table 8-26 Nodes Tab Field Descriptions

Field Description

SubnetPrefix The subnet prefix of the node.

GUID The global unique ID (GUID) of the node.

Description An optional text string describing this node.

Type Type of node being managed.

NumPorts Number of physical ports on this node.

SystemImageGUID The system image GUID of this node. All nodes within a particular system 
(chassis) are assigned the same system image GUID.

Table 8-27 Ports Tab Field Descriptions

Field Description

SubnetPrefix The subnet prefix of the node.

NodeGUID The global unique ID (GUID) of the node that includes the port.

Port Local port number for this port.

LID 16-bit base LID of this port.
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Viewing Switches
To view the switches in the topology view, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Click the Details button. The InfiniBand Subnet Details window opens.

Step 5 Click the Switches tab. Table 8-28 lists and describes the fields in this tab.

State State of the port:

• noStateChange

• sleep

• polling

• disabled

• portConfigurationTraining

• linkup

• linkErrorRecovery

• reserved

• active

• down

LinkWidthActive Currently active link width. Indicated as follows: 

• 1: 1x 

• 2: 4x 

• 8: 12x 

• 0, 3, 4-7, 9-255 reserved.

Table 8-27 Ports Tab Field Descriptions (continued)

Field Description

Table 8-28 Switches Tab Field Descriptions

Field Description

SubnetPrefix The subnet prefix of the node.

NodeGUID The global unique ID (GUID) of the node that includes the switch.

LinearFdbCap Number of entries supported in the Linear Unicast Forwarding table. Zero 
indicates that there is no Linear Forwarding Database.
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Viewing Neighbors
To view the ports in the topology view, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Click the Details button. The InfiniBand Subnet Details window opens.

RandomFdbCap Number of entries supported in the Random Unicast Forwarding table. Zero 
indicates that there is no Random Forwarding Database.

McastFdbCap Number of entries supported in the Multicast Forwarding table.

LinearFdbTop Indicates the top of the linear forwarding table. Packets received with unicast 
DLIDs greater than this value are discarded by the switch. This component 
applies only to switches that implement linear forwarding tables and is ignored 
by switches that implement random forwarding tables.

DefaultPort Forward to this port all the unicast packets from the other ports whose DLID 
does not exist in the random forwarding table.

DefPriMcastPort Forward to this port all the multicast packets from the other ports whose DLID 
does not exist in the forwarding table.

DefNonPriMcastPort Forward to this port all the multicast packets from the smDefPriMcastPort port 
whose DLID does not exist in the forwarding table.

LifeTimeValue The time a packet can live in the switch.

PortStateChange Identifies whether or not the port is in transition.

LIDPerPort Number of LID/LMC combinations that may be assigned to a given external 
port for switches that support the random forwarding table.

PartitionEnfCap The number of entries in this partition enforcement table per physical port. 
Zero indicates that partition enforcement is not supported by the switch.

InEnfCap Indicates switch is capable of partition enforcement on received packets.

OutEnfCap Indicates switch is capable of partition enforcement on transmitted packets.

InFilterRawPktCap Indicates switch is capable of raw packet enforcement on received packets.

OutFilterRawPktCap Indicates switch is capable of raw packet enforcement on transmitted packets.

Table 8-28 Switches Tab Field Descriptions (continued)

Field Description
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Step 5 Click the Neighbors tab. Table 8-29 lists and describes the fields in this tab.

Viewing Subnet Management Agents
You can view any of the following SMA details:

• Nodes

• Switches

• Switch Cap

• Ports (1)

• Ports (2)

• Mcast

• Linear Forwarding

• PKey

• SLVL Map

Table 8-29 Neighbors Tab Field Descriptions

Field Description

SubnetPrefix Used to identify IB subnet this IB node is located in.

LocalNodeGuid The global unique ID (GUID) of the IB node.

LocalPortId Identifies the port id of the IB node.

LocalNodeType Identifies the IB node's node-type.

• channelAdapter

• switch

RemoteNodeGuid The global unique ID (GUID) of the remote IB node.

RemotePortId Identifies the port id of the remote IB node.

RemoteNodeType Identifies the remote IB node's node-type.

• channelAdapter

• switch

LinkState Used to identify the state of the linkconnecting the neighbors.

• noStateChange

• down

• initialize

• active

LinkWidthActive Used to identify the width of the link connecting the neighbors.
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Nodes
To view SMA node details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the Nodes tab. Table 8-30 lists and describes the fields in this tab.

Switches
To view SMA switch details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Table 8-30 Nodes Tab Field Descriptions

Field Description

Guid Subnet prefix of this IB subnet.

BaseVersion Supported base management datagram version.

ClassVersion Supported subnet management class.

Type Type of node being managed.

• channelAdapter

• switch

PortGuid GUID of this port. One port within a node can return the nodeGUID as its PortGUID 
if the port is an integral part of the node and is not field-replaceable.

PartitionCap Number of entries in the partition table for CA, router, and the switch management 
port. This is at a minimum set to 1 for all nodes including switch.

DeviceId Device ID information as assigned by device manufacturer.

Revision Device revision, assigned by manufacturer.

LocalPortNum The link port number this SNMP packet came in on.

VendorId Device vendor ID, per IEEE.

TrapBuffer Special purpose string buffer for InfiniBand Trap Data.

String Description of the node.

NumPorts Number of physical ports on this node.
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Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the Switches tab. Table 8-31 lists and describes the fields in this tab.

Switch Cap
To view SMA switch cap details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Table 8-31 Switches Tab Field Descriptions

Field Description

Guid Global unique ID of the switch.

LftTop Indicates the top of the linear forwarding table. Packets received with unicast 
DLids greater than this value are discarded by the switch. This component 
applies only to switches that implement linear forwarding tables and is ignored 
by switches that implement random forwarding tables.

DefaultPort Forward to this port all the unicast packets from the other ports whose DLID 
does not exist in the random forwarding table

DefMcastPriPort Forward to this port all the multicast packets from the other ports whose DLID 
does not exist in the forwarding table.

DefMcastNPPort Forward to this port all the multicast packets from the Default Primary port 
whose DLID does not exist in the forwarding table.

LifeTimeValue Time a packet can live in the switch.

PortStateChange It is set to one anytime the PortState component in the PortInfo of any ports 
transitions from Down to Initialize, Initialize to Down, Armed to Down, or 
Active to Down as a result of link state machine logic. Changes in Portstate 
resulting from SubnSet do no change this bit. This bit is cleared by writing one, 
writing zero is ignored.

LidsPerPort Specifies the number of LID/LMC combinations that may be assigned to a 
given external port for switches that support the Random Forwarding table.
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Step 6 Click the Switch Cap. tab. Table 8-32 lists and describes the fields in this tab.

Ports (1)
To view SMA port details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the Ports (1) tab. Table 8-33 lists and describes the fields in this tab.

Table 8-32 Switch Cap Tab Field Descriptions

Field Description

LftCap Number of entries supported in the Linear Unicast Forwarding Table.

RftCap Number of entries supported in the Random Unicast Forwarding Table. 
RandomFDBCap = 0 indicates that there is no Random Forwarding Database.

MftCap Number of entries supported in the Multicast Forwarding Table.

PartitionEnfCap Specifies the number of entries in the partition enforcement table per physical 
port. Zero indicates that partition enforcement is not supported by the switch.

InboundEnfCap Indicates switch is capable of partition enforcement on received packets.

OutboundEnfCap Indicates switch is capable of partition enforcement on transmitted packets.

FilterRawPktInCap Indicates switch is capable of raw packet enforcement on received packets.

FilterRawPktOutCap Indicates switch is capable of raw enforcement on transmitted packets.

Table 8-33 Ports (1) Tab Field Descriptions

Field Description

NodeGuid 64-bit GUID of the node that contains this port.

IbPort The local port number of this port (relative to a particular node).

MKey 64-bit management Key for this port.

GidPrefix 64-bit global ID prefix for this port.

Lid 16-bit base LID of this port.

MasterSMLid 16-bit base LID of the master SM that is managing this port.
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CapabilityMask Supported capabilities of this node.

• 0: Reserved, shall be zero 

• 1: IsSM 

• 2: IsNoticeSupported 

• 3: IsTrapSupported 

• 4: IsResetSupported 

• 5: IsAutomaticMigrationSupported 

• 6: IsSLMappingSupported 

• 7: IsMKeyNVRAM 

• 8: IsPKeyNVRAM 

• 9: IsLEDInfoSupported 

• 10: IsSMDisabled 

• 11-15: Reserved, shall be zero 

• 16: IsConnectionManagerSupported 

• 17: IsSNMPTunnelingSupported 

• 18: Reserved, shall be zero 

• 19: IsDeviceManagementSupported 

• 20: IsVendorClassSupported 

• 21-31: Reserved, shall be zero

DiagCode Port diagnostic code.

MKeyLeasePeriod Timer value used to indicate how long the M_Key protection bits are to be 
remain non-zero after a SubnSet(PortInfo) fails a M Key check. The value of 
the timer indicates the number of seconds for the lease period.

LocalPortNum Local port number.

LinkWidthEnabled Enabled link width (1x, 4x, or 12x).

LinkWidthSupported Supported link width.

LinkWidthActive Currently active link width.

LinkSpeedSupported Supported link speed (in Gbps).

State State of the port:

• noStateChagne

• down

• initialize

• armed

• active

Table 8-33 Ports (1) Tab Field Descriptions (continued)

Field Description
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Ports (2)
To view extended SMA port details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the Ports (2) tab. Table 8-34 lists and describes the fields in this tab.

PortPhys State of the physical port:

• noStateChange(0), 

• sleep

• polling

• disabled

• portConfigurationTraining

• linkup

• linkErrorRecovery

• reserved

• linkDownDef

LinkDownDef Port physical state “link down.”

MKeyProtectBits Determines MADheader behavior.

LMC LID mask for multipath support.

LSActive Current active link speed.

LSActiveEnabled Enabled link speed.

NeighborMTU Active maximum MTU enabled on this port for transmission.

MasterSMSL The administrative SL of the master SM that is managing this port.

Table 8-33 Ports (1) Tab Field Descriptions (continued)

Field Description

Table 8-34 Ports (2) Tab Field Descriptions

Field Description

NodeGuid 64-bit GUID of the node that contains this port.

IbPort The local port number of this port (relative to a particular node).
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Mcast
To view SMA multicast details, perform the following steps:

VLCap Virtual lanes supported on this port.

VLHighLimit Limit of high priority component of VL arbitration table.

VLArbitrationHighCap VL/Weight pairs supported on this port in the smVLArbTable for high 
priority.

VLArbitrationLowCap VL/Weight pairs supported on this port in the smVLArbTable for low 
priority.

MTUCap Maximum MTU supported by this port.

VLStallCount Specifies the number of sequential packets dropped that causes the port to 
enter the VLStalled state.

HOQLife Time a packet can live at the head of a VL queue.

OpVLs Virtual Lanes operational on this port.

PkeyEnfIn Indicates support of optional partition enforcement on packets received from 
this port.

PkeyEnfOut Indicates support of optional partition enforcement on packets transmitted 
from this port.

FilterRawPktIn Indicates support of optional raw packet enforcement on raw packets 
received from this port.

FilterRawPktOut Indicates support of optional raw packet enforcement on raw packets 
transmitted from this port.

MKeyViolations Number of SMP packets that have been received on the port that have had 
invalid M_Key, since power on or reset.

PKeyViolations Number of packets that have been received on the port that have had invalid 
P_Key, since power on or reset.

QKeyViolations Number of packets that have been received on the port that have had invalid 
Q_Key, since power on or reset

GuidCap Number of GUID entries supported in the GUIDInfo attribute for this port.

SubnetTimeout Maximum expected subnet propagation delay.

RespTimeValue Expected maximum time between the port reception of a SMP and the 
transmission of the associated response.

LocalPhysErr Threshold value. When the count of marginal link errors exceeds this 
threshold, the local link integrity error is detected. 

OverrunErr Overrun threshold value. When the count of buffer overruns exceeds the 
threshold, an excessive buffer overrun error occurs.

Table 8-34 Ports (2) Tab Field Descriptions (continued)

Field Description
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Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the Mcast tab. Table 8-35 lists and describes the fields in this tab.

Linear Forwarding
To view SMA linear forwarding table details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the Linear Forwarding tab. Table 8-36 lists and describes the fields in this tab.

Table 8-35 Mcast Tab Field Descriptions

Field Description

NodeGuid Global unique ID of the node.

TableBlockIndex Index into the multicast block table, this index starts from 1 rather than 0.

TableBlock List of 32 PortMask Block Elements. 16 bits starting at position 16*p of the port 
mask associated with the particular LID. An incoming packet with this LID is 
forwarded to all ports for which the bit in the port mask is set to 1. Note that an 
invalid LID is indicated with an all zero PortMask.

Table 8-36 Linear Forwarding Tab Field Descriptions

Field Description

NodeGuid Global unique ID of the node.

BlockIndex Index into the linear forwarding table, this index starts from 1 rather than 0.

Block Linear forwarding table block.
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PKey
To view SMA partition details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the PKey tab. Table 8-37 lists and describes the fields in this tab.

SLVL Map
To view SMA SLVL details, perform the following steps:

Step 1 Click the InfiniBand menu and chooseTopology View. The Specify Topspin Devices dialog box opens.

Step 2 (Optional) Click the checkbox, in the Enabled column, of any additional IB devices that you want to 
add to the Topology View display.

Step 3 Click the OK button. The InfiniBand Topology window appears.

Step 4 Double-click a server switch icon. The Internal InfiniBand Topology window opens.

Step 5 Click the SMAs button. The Subnet Manager Agents window opens.

Step 6 Click the SLVL Map tab. Table 8-38 lists and describes the fields in this tab.

Table 8-37 PKey Tab Field Descriptions

Field Description

NodeGuid Global unique ID of the node.

IbPort Port number.

Index PKEY table index.

TableVector GUID assigned by the SM on the subnet.

Table 8-38 SLVL Map Tab Field Descriptions

Field Description

NodeGuid Global unique ID of the node.

InIbPort Ingress port number.

OutIbPort Egress port number.

Sl#toVI SL# to VL mapping.
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Viewing Device Management

Note Device Management (DM) features are only available on I/O chassis (Cisco SFS 3001, Cisco SFS 3012).

With Device Management, you can

• View IOUs.

• View IOCs.

• View IOC Services.

Viewing IOUs
To view the I/O Units (IOUs) on your device, perform the following steps:

Step 1 Click the InfiniBand menu and chooseDM. The Device Manager window opens.

Step 2 Click the IOU tab. IOU details appear. Table 8-39 lists and describes the fields in this display.

Viewing IOCs
To view the I/O controllers (IOCs) on your device, perform the following steps:

Step 1 Click the InfiniBand menu and chooseDM. The Device Manager window opens.

Table 8-39 IOU Display Field Descriptions

Field Description

Change ID Cumulative number of changes to the controller list since the device last booted. 

Max Controllers Maximum number of controllers that your device can support.

Diag Device ID All device IDs appear as 1.

Option ROM Indicates the presence or absence of Option ROM.

Controllers Lists each slot on your device that can potentially contain a controller and 
identifies whether or not a controller resides in that slot.
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Step 2 Click the IOC tab. A table of IOC details appears. Table 8-40 lists and describes the fields in this display.

Viewing IOC Services
To view the IOC services on your device, perform the following steps:

Step 1 Click the InfiniBand menu and chooseDM. The Device Manager window opens.

Table 8-40 IOCs Display Field Descriptions

Field Description

GUID GUID of the controller.

Vendor ID Organization Unique Identifier (OUI) of the vendor.

Device ID Vendor-assigned device identifier.

Device Version Vendor-assigned device version.

Subsystem Vendor ID Vendor-assigned subsystem vendor identifier

Subsystem ID Vendor-assigned subsystem identifier.

IOClass I/O class that the IOC supports.

IOSubclass Subclass of the I/O class protocol of the IOC.

Protocol Standard protocol definition that the IOC supports.

Protocol Version Protocol version that the IOC supports.

Send Msg Queue Depth Maximum number of messages that the send message queue supports.

RDMA Read Queue Depth Maximum depth of the per-channel RDMA Read Queue.

Send Msg Size Maximum size, in bytes, of send messages.

RDMA transfer size Maximum size, in bytes, of outbound RDMA transfers that the IOC 
initiates.

Controller Op Cap Integer value (from 8 cumulative bits) between 1 and 255 that represents 
the operation type(s) that the IOC supports.

• bit 0: ST; Send Messages To IOCs

• bit 1: SF; Send Messages From IOCs

• bit 2: RT; RDMA Read Requests To IOCs

• bit 3: RF; RDMA Read Requests From IOCs

• bit 4: WT; RDMA Write Requests To IOCs

• bit 5: WF; RDMA Write Requests From IOCs

• bit 6: AT; Atomic Operations To IOCs

• bit 7: AF; Atomic Operations From IOCs

Service Entries Number of services that the IOC provides.
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Step 2 Click the IOC Services tab. A table of IOC Services details appears. <Link>Table 8-41 lists and 
describes the fields in this table.

Table 8-41 IOC Services Table Field Descriptions

Field Description

IOC GUID GUID of the node that provides the service.

Service Name ASCII identifier of the service.

Service ID Numeric identifier that nodes use to call the service.
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C H A P T E R 9

Ethernet Menu Tasks

This chapter describes the Ethernet menu tasks for Element Manager and contains these sections:

• Viewing the ARP Table, page 9-1

• Viewing Ethernet Routes, page 9-2

• Viewing IP Addresses, page 9-3

• Viewing Trunk Groups, page 9-3

• Viewing Bridge Groups, page 9-6

• Viewing Redundancy Groups, page 9-9

Note The instructions in this chapter apply only to Server Switches that run Ethernet gateways.

Viewing the ARP Table
To view the static ARP table, perform the following steps:

Step 1 Click the Ethernet menu and choose  ARP. The ARP window opens and displays the static ARP table. 
Table 9-1 lists and describes the fields in this table.

Adding a Static Entry to the ARP Table
To add a static address to the ARP table, perform the following steps:

Table 9-1 ARP Table Field Descriptions

Field Description

Port Port (in slot#port# format) on your Server Switch to which the host connects.

NetAddress IP address of the host.

PhysAddress MAC address of the host.

Type Type of route between the host and your Server Switch, either static or dynamic.
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Step 1 Click the Ethernet menu and choose  ARP. The ARP window opens and displays the static ARP table.

Step 2 Click the Insert Ethernet button. The Insert static Ethernet ARP window opens.

Step 3 Click the “...” button next to the Port field. The choose  Port window opens.

Step 4 Check the checkbox of the Ethernet gateway port to which you want to assign the new entry, and then 
click the OK button.

Step 5 Enter the IP address of the static host in the Net Address field.

Step 6 Enter the MAC address of the static host in the MAC field, and then click the Insert button.

Viewing Ethernet Routes
To view Ethernet routes, perform the following steps:

Step 1 Click the Ethernet menu and choose  Routes. The Routes window opens. Table 9-2 lists and describes 
the fields in this window.

Creating an Ethernet Route
To create an Ethernet route, perform the following steps:

Step 1 Click the Ethernet menu and choose  Routes. The Routes window opens.

Step 2 Click the Insert button. The Routes, Insert Routes window opens.

Step 3 Enter the destination IP address in the Dest field.

Step 4 Enter the subnet mask in the Mask field.

Step 5 Enter the IP address of the next hop in the NextHop field.

Table 9-2 Routes Window Field Descriptions

Field Description

Dest Destination IP address of the route.

Mask Subnet mask of the route.

NextHop IP address of the next hop on the Ethernet route (address of the Ethernet router).

Port Ethernet gateway port of the route.

Type Identifies the type of route as direct or indirect.

Proto Protocol that the route runs.

NextHopAS The Autonomous System Number of the next hop.
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Step 6 Click the Insert button.

Deleting an Ethernet Route

To delete an Ethernet route, perform the following steps:

Step 1 Click the Ethernet menu and choose  Routes. The Routes window opens.

Step 2 Click the route that you want to delete, and then click the Delete button.

Viewing IP Addresses
To view IP addresses, perform the following steps:

Step 1 Click the Ethernet menu and choose  IP Addresses. The IP Addresses window opens. Table 9-3 lists and 
describes the fields in this window.

Viewing Trunk Groups
To view the trunk groups on your Server Switch, perform the following steps:

Table 9-3 IP Addresses Window Field Descriptions

Field Description

Port The index value which uniquely identifies the interface to which this entry is 
applicable.

Address The IP address to which this entry's addressing information pertains.

Netmask The subnet mask associated with the IP address of this entry.

BcastAddrFormat The IP broadcast address format used on this interface.

ReasmMaxSize The size of the largest IP datagram which this entity can re-assemble from 
incoming IP fragmented datagrams received on this interface.

Type Identifies the address as a primary or backup address.

Status Identifies the port as active or backup.
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Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens. Table 9-4 lists and 
describes the fields in this window.

Creating a Trunk Group
To create a trunk group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens.

Step 2 Click the Insert button. The Trunking, Insert Trunk Groups window opens.

Step 3 Enter an integer value (between 1 and 256) in the ID field.

Step 4 Enter a name, with ASCII characters, in the Name field.

Step 5 Click the “...” button in the Port Members field. The choose  Ports window opens.

Step 6 Check the checkbox of any port that you want to add to the trunk group. Uncheck any box that you want 
to omit from the group. Click the OK button.

Step 7 Click the radio button of a distribution type in the Distribution Type field.

Step 8 (Optional) Check the Enabled checkbox to enable the new group when you create it. To disable the new 
group, uncheck the box.

Step 9 Click the Insert button. The new group appears as a row in the Trunking window.

Deleting a Trunk Group

To delete a trunk group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens.

Step 2 Click the entry of the trunk group that you want to delete, and then click the Delete button.

Table 9-4 Trunking Window Field Descriptions

Field Description

ID Trunk group identifier.

Name Trunk group name.

Port Members Physical Ethernet gateway ports that belong to this trunk group.

Distribution Type Packet forwarding distribution algorithm of the trunk group.

Enabled Identifies the trunk group as enabled or disabled.

MTU Displays the maximum transmission unit of the trunk group.

MAC Address Displays the MAC address assigned to this trunk group.

IfIndex Logical port identifier that represents the trunk group.
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Editing a Trunk Group
You can reconfigure the following attributes of a trunk group:

• group name

• member ports

• distribution type

• enabled/disabled status

Changing a Trunk Group Name

To change a trunk group name, perform the following steps:

Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens.

Step 2 Double-click the cell in the Name column of the entry whose name you want to change. The cell becomes 
editable.

Step 3 Enter the new trunk group name, and then press the Enter key.

Step 4 Click the Apply button.

Note You can make multiple changes before you click the Apply button, but you must click the button 
to make the changes in the configuration file on the Server Switch.

Adding or Remove Physical Ethernet Gateway Ports from a Trunk Group

To add or remove physical Ethernet gateway ports from a trunk group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens.

Step 2 Double-click the cell in the Port Members column of the entry to which you want to add or remove ports. 
The choose  Ports window opens.

Step 3 Check the checkboxes, in the choose  Ports window, of the ports that you want to add to the group. 
Uncheck the boxes of ports that you want to remove. Click the OK button.

Step 4 Click the Apply button.

Note You can make multiple changes before you click the Apply button, but you must click the button 
to make the changes in the configuration file on the Server Switch.

Changing the Distribution Type of a Trunk Group

To change the distribution type of a trunk group, perform the following steps:
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Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens.

Step 2 Click the cell, in the Distribution Type column, of the trunk group whose distribution type you want to 
change. A pulldown menu appears.

Step 3 Select a new distribution type from the pulldown menu.

Step 4 Click the Apply button.

Note You can make multiple changes before you click the Apply button, but you must click the button 
to make the changes in the configuration file on the Server Switch.

Enabling or Disabling a Trunk Group

To enable or disable a trunk group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Trunking. The Trunking window opens.

Step 2 Click the cell, in the Enabled column, of the trunk group whose enabled/disabled status you want to 
change. A pulldown menu appears.

Step 3 Select true (to enable) or false (to disable) from the pulldown menu.

Step 4 Click the Apply button.

Note You can make multiple changes before you click the Apply button, but you must click the button 
to make the changes in the configuration file on the Server Switch.

Viewing Bridge Groups
To view the bridge groups on the Server Switch, perform the following steps:

Step 1 Click the Ethernet menu and choose  Bridging. The Bridging window opens. Table 9-5 lists and 
explains the fields in this window.

Table 9-5 Bridging Window Field Descriptions

Field Description

ID Unique numeric identifier of the bridge group.

Name Name, in ASCII characters, of the bridge group.

Ethernet Port The Ethernet interface that is assigned to this bridge group. A value 
of zero(0) means no interface is currently assigned.

IB Port The Infiniband interface that is assigned to this bridge group. A value 
of zero(0) means no interface is currently assigned.
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Creating a Bridge Group
To create a bridge group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Bridging. The Bridging window opens

Step 2 Click the Add button. The Add Bridge Group window opens.

Step 3 (Optional) Enter an integer in the ID field to assign a numeric identifier to the bridge group. Element 
Manager automatically populates this field.

Step 4 Enter a plain-text identifier of ASCII characters in the Name field.

Step 5 Click the Groups tab.

Step 6 Click the choose  button in the Ethernet Port field. The Bridge Port window opens.

Step 7 From the Port pulldown menu, choose  the Ethernet gateway port that you want to assign to the bridge 
group.

Step 8 (Optional) Enter the VLAN, in the VLAN field, of the Ethernet gateway port that you want to assign to 
the bridge group.

Step 9 Click the OK button.

Step 10 Click the choose  button in the InfiniBand Port field. The Bridge Port window opens.

Step 11 From the Port pulldown menu, choose  the internal IB port on the Ethernet gateway that you want to 
assign to the bridge group.

Step 12 Enter the partition key, in the P_Key field, of the partition to which you want to add the internal port.

Step 13 Click the OK button.

Step 14 (Optional) Check the Enabled checkbox in the Broadcast Forwarding field to enable broadcast 
forwarding.

Step 15 Select one or none from the pulldown menu in the Loop Protection Method field.

Broadcast Forwarding Configures whether this bridge group should forward broadcast 
packets.

NOTE: Enabling broadcast forwarding can cause broadcast storms in a 
network if the network is not configured properly.

Broadcast Forwarding Mode Active broadcast forwarding mode.

Loop Protection Method Loop protection method of this bridge group.

IP Multicast Specifies if the group forwards IP-V4 multicast packets.

IP Multicast Mode Active IP multicast mode.

Redundancy Group Redundancy group to which this bridge group is assigned.

Admin Failover Priority Failover priority of the bridge group.

Oper Failover Priority Active failover priority of the bridge group.

Table 9-5 Bridging Window Field Descriptions (continued)

Field Description
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Step 16 (Optional) Check the Enabled checkbox in the IP Multicast field to enable IP multicasting.

Step 17 Click the Add button.

Deleting a Bridge Group

To delete a bridge group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Bridging. The Bridging window opens.

Step 2 Click the bridge group entry that you want to delete, and then click the Delete button.

Adding Bridge Forwarding to a Bridge Group

Step 1 Click the Ethernet menu and choose  Bridging. The Bridging window opens

Step 2 Click the bridge group to which you want to add bridge forwarding, and then click the Edit button. The 
Edit Bridge Group window opens.

Step 3 Click the Forwarding tab.

Step 4 Click the Add button. The Add Bridge Forwarding window opens.

Step 5 Select eth or ib from the pulldown menu in the Port Type field.

Step 6 Enter the desination IP address in the Destination Address field.

Step 7 Enter an integer value from 0 to 32 in the Destination Length field.

Step 8 Enter the IP address of the next hop in the Next Hop field.

Step 9 Enter the subnet prefix of the next hop in the Subnet Prefix field.

Step 10 Enter an integer value from 0 to 32 in the Prefix Length field.

Step 11 Click the Add button.

Adding a Subnet to a Bridge Group

Step 1 Click the Ethernet menu and choose  Bridging. The Bridging window opens

Step 2 Click the bridge group to which you want to add bridge forwarding, and then click the Edit button. The 
Edit Bridge Group window opens.

Step 3 Click the Subnet tab. 

Step 4 Click the Add button. The Add Subnet window opens.

Step 5 Enter a subnet prefix in the Subnet Prefix field.

Step 6 Enter an integer value from 0 to 32 in the Prefix Length field.
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Step 7 Click the Add button.

Viewing Redundancy Groups
To view the redundancy groups on your Server Switch, perform the following steps:

Step 1 Click the Ethernet menu and choose  Redundancy. The Redundancy Groups window opens. Table 9-6 
lists and describes the fields in this window.

Creating a Redundancy Group
To create a redundancy group, perform the following steps:

Step 1 Click the Ethernet menu and choose  Redundancy. The Redundancy Groups window opens.

Step 2 Click the Add button. The Add Redundancy Group window opens.

Step 3 (Optional) Enter an integer value in the ID field. Element Manager automatically populates this field.

Step 4 Enter a name for the redundancy group in the Name field.

Step 5 (Optional) Check the Enabled checkbox in the Load Balancing field to apply the load balancing feature 
to this redundancy group.

Step 6 (Optional) Check the Enabled checkbox in the Broadcast Forwarding field to apply the broadcast 
forwarding feature to this redundancy group.

Step 7 (Optional) Check the Enabled checkbox in the IP Multicast field to apply the multicast forwarding 
feature to this redundancy group.

Table 9-6 Redundancy Groups Window Field Descriptions

Field Description

Group ID Unique numerical identifier of the redundancy group.

Name ASCII-text name of the redundancy group.

Group P_Key The 16-bit multicast partition key used by this redundancy group.

Load Balancing Used to enable/disable the load balancing feature for this bridge group.

Bridge Group Members Indicates the bridge groups that are assigned to this redundancy group.

Broadcast Forwarding Displays “true” if broadcast forwarding is enabled, otherwise displays 
“false.”

IP Multicast Displays “true” if multicast forwarding is enabled, otherwise displays 
“false.”

Member Force Reelection Displays “true” if the group is configured to reelect a new primary when 
a new member joins, otherwise displays “false.”
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Step 8 (Optional) Check the Enabled checkbox in the Member Force Reelection field to force the redundancy 
group to elect a new primary when a new member joins.

Step 9 Click the Add Member button. The Add Member window opens.

Step 10 Select a bridge group from the Bridge Group pulldown menu.

Step 11 Click the Add button. The entry appears in the Members field.

Step 12 (Optional) Repeat Step 9Click the Add Member button. The Add Member window opens. through 
<Link>step 11 to add additional members.

Step 13 Click the Apply button.

Editing a Redundancy Group

Step 1 Click the Ethernet menu and choose  Redundancy. The Redundancy Groups window opens.

Step 2 Click the entry of the redundancy group that you want to edit, and then click the Edit button. The Edit 
Redundancy Group window opens.

Step 3 (Optional) Change the name in the Name field.

Step 4 (Optional) Check or uncheck the Enabled button in the Load Balancing field.

Step 5 (Optional) Check or uncheck the Enabled button in the Broadcast Forwarding field.

Step 6 (Optional) Check or uncheck the Enabled button in the IP Multicast field.

Step 7 (Optional) Check or uncheck the Enabled button in the Member Force Reelection field.

Step 8 (Optional) Click a bridge group member, and then click the Remove button, to remove a bridge group 
member.

Step 9 (Optional) Click the Add Member button to add a bridge group member. (Refer to Step 9Click the Add 
Member button. The Add Member window opens. through Step 11Click the Add button. The entry 
appears in the Members field. of the “Creating a Redundancy Group” section on page 9-9.

Step 10 Click the Apply button.

Deleting a Redundancy Group

Step 1 Click the Ethernet menu and choose  Redundancy. The Redundancy Groups window opens.

Step 2 Click the entry of the redundancy group that you want to delete, and then click the Delete button. The 
Delete Redundancy Group window opens.

Step 3 Click Yes.
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FibreChannel Menu Tasks

This chapter describes the FibreChannel menu tasksk for Element Manager and contains these section.:

• Viewing and Configuring Global SRP Attributes, page 10-2

• Viewing and Configuring SRP Initiators, page 10-4

• Viewing Initiator WWPNs, page 10-10

• Viewing Target Ports, page 10-11

• Viewing Initiator-Target-LUN Groups (ITLs), page 10-13

• Viewing Initiator-Target Pairs (ITs), page 10-14

• Viewing Logical Units (LUs), page 10-15

• Viewing Global SRP Statistics, page 10-19

• Viewing ITL Statistics, page 10-22

• Viewing Gateway Statistics, page 10-25

• Viewing Recommended World Wide Names, page 10-28

• Disconnecting ITLs on a Fibre Channel Gateway, page 10-28

• Viewing All Fibre Channel Gateways on the Server Switch, page 10-29

• Viewing SRP Hosts, page 10-30

Note This chapter presents step-by-step instructions that explain how to perform Fibre Channel storage tasks. 
For detailed information and configuration samples, refer to the Fibre Channel Gateway User Guide.
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Some tabular displays that appear in FibreChannel menu options include supplementary edit 
buttons. lists and describes those buttons.

Viewing and Configuring Global SRP Attributes
To view global SRP attributes, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Global tab. Table 10-2 lists and describes the fields in the display.

Table 10-1 SRP Navigation Buttons

Button Description

copy button

Click a table cell or cells, then click the copy button to copy the contents of the cell(s). 
You can then select another editable cell, or multiple editable cells, and paste the content.

paste 
button

The paste button places copied content into the cell or cells that you select. You can paste 
the content of one cell into multiple cells. You can paste the content of two side-by-side 
cells into multiple rows of side-by-side cells.

reset button

The reset button returns all cells to the value that they held before you began to edit them.

Note You can only reset cells before you click the Apply button.

Table 10-2 Global Attribute Field Descriptions

Field Description

DefaultGatewayPortMaskPolicy Boolean value that indicates if ports allow new SRP 
initiators to communicate through the Fibre Channel 
interface card(s).

DefaultLunPolicy Boolean value that indicates if new SRP initiators 
have immediate access to target LUNs.

DefaultItlHiMark The maximum number of requests that can be sent per 
logical unit. This value, an integer, falls between 1 
and 256. This value defaults to 16.

DefaultItlMaxRetry Number of times an initiator may send the same I/O to 
a logical unit. Increase the value if you expect heavy 
traffic, or increase the default-itl-min-io-timeout 
value. The value, an integer, falls between 1 and 100. 
The value defaults to 5.

DefaultItlMinIoTimeout Maximum amount of time for a logical unit to accept 
I/O traffic. Increase this value if you use a known slow 
connection or increase the default-itl-max-retry value. 
The value, an integer, falls between 1 and 1800. The 
value defaults to 10 seconds.
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Configuring Global ITL Attributes

Note When you change global attributes, the attributes do not apply to existing ITLs. Any new ITLs that you 
create will receive the new global attributes, but you must manually update any existing ITLs if you want 
them to match the properties of the new ITLs.

To configure global ITL attributes, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Global tab.

Step 3 Click one of the following radio buttons in the DefaultGatewayPortMaskPolicy field to configure the 
gateway portmask policy:

DefaultItlDynamicPathAffinity Boolean value that indicates if the system maintains a 
preference for a specific path. If the number of 
outstanding I/O requests becomes excessive, or the 
path fails, the ITL uses an alternative path.

DefaultItlDynamicGatewayPortLoadBalancing Boolean value that indicates if data may be sent 
between the initiator and Fibre Channel target using 
both ports on the gateway interface. Port selection 
occurs based upon comparative I/O traffic. The 
controller attempts to distribute traffic equally 
between the ports. This feature runs by default.

DefaultItlDynamicGatewayPortFailover Boolean value that indicates if the controller may 
select an alternate gateway interface port if the 
primary path fails. This feature does not run by 
default.

DefaultSeqItlHiMark Shows the default I/O high mark for a sequential 
device.

DefaultSeqItlMaxRetry Shows the default of the maximum number of retries 
for a sequential device.

DefaultSeqItlMinIoTimeout Shows the default of the maximum number of retries 
for a sequential device.

DefaultSeqItlDynamicPathAffinity Shows the default of the dynamic path affinity setting 
for a sequential device. 

DefaultSeqItlDynamicGatewayPortLoadBalanc
ing

Shows the default of the dynamic path affinity setting 
for a sequential device.

DefaultSeqItlDynamicGatewayPortFailover Boolean value that indicates if the controller may 
select an alternate storage port if the primary path 
fails. This feature does not run by default.

Table 10-2 Global Attribute Field Descriptions (continued)

Field Description
10-3
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 10      FibreChannel Menu Tasks
  Viewing and Configuring SRP Initiators
– Click the restricted radio button to deny new initiators access to FC gateway ports.

– Click the nonRestricted radio button to grant new initiators access to FC gateway ports.

Step 4 Click one of the following radio buttons in the DefaultLunPolicy field to configure the LUN mask 
policy:

– Click the restricted radio button to deny new initiators access to logical units.

– Click the nonRestricted radio button to grant new initiators access to logical units.

Step 5 Configure global defaults for non-sequential (random) storage devices:

a. Enter an integer value, between 1 and 256, in the DefaultItlHiMark field to specify the maximum 
number of requests that FC gateways will send to individual logical units (on non-sequential storage 
devices).

b. Enter an integer value, between 1 and 100, in the DefaultItlMaxRetry field to specify the number 
of times an initiator may send the same I/O to a logical unit (on non-sequential storage devices).

c. Enter an integer value, between 1 and 1800, in the DefaultItlMinIoTimeout field to specify the 
amount of time (in seconds) for an ITL to accept I/O traffic (on non-sequential storage devices).

d. (Optional) Check the DefaultItlDynamicPathAffinity checkbox to configure this attribute on 
non-sequential storage devices.

e. (Optional) Check the DefaultItlDynamicGatewayPortLoadBalancing checkbox to configure this 
attribute on non-sequential storage devices.

f. (Optional) Check the DefaultItlDynamicGatewayPortFailover checkbox to configure this 
attribute on non-sequential storage devices.

Step 6 Configure global defaults for sequential (tape) storage devices:

a. Enter an integer value, between 1 and 256, in the DefaultSeqItlHiMark field to specify the 
maximum number of requests that FC gateways will send to individual logical units (on sequential 
storage devices).

b. Enter an integer value, between 1 and 100, in the DefaultSeqItlMaxRetry field to specify the 
number of times an initiator may send the same I/O to a logical unit (on sequential storage devices).

c. Enter an integer value, between 1 and 1800, in the DefaultSeqItlMinIoTimeout field to specify the 
amount of time (in seconds) for an ITL to accept I/O traffic (on sequential storage devices).

d. (Optional) Check the DefaultSeqItlDynamicPathAffinity checkbox to configure this attribute on 
sequential storage devices.

e. (Optional) Check the DefaultSeqItlDynamicGatewayPortLoadBalancing checkbox to configure 
this attribute on sequential storage devices.

f. (Optional) Check the DefaultSeqItlDynamicGatewayPortFailover checkbox to configure this 
attribute on sequential storage devices.

Step 7 Click the Apply button.

Viewing and Configuring SRP Initiators
With Element Manager, you can view SRP initiators in tabular format in the SRP window, or you can 
view them modularly in the Storage Manager.
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Viewing SRP Initiators
To view SRP initiators in tabular format in the SRP window, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Initiators tab. Table 10-3 lists and explains the fields in the display

Configuring Existing SRP Initiators
To configure existing SRP initiators (hosts), perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Initiators tab.

Step 3 Identify the initiator entry that you want to reconfigure and locate that entry in the Initiators table.

Step 4 (Optional) Double-click the cell in the Description column, then edit the description.

Step 5 (Optional) Double-click the cell in the Wwnn column, then edit the WWNN.

Table 10-3 Initiators Table Field Descriptions

Field Description

Guid Global Identifier of the initiator.

Extension GUID extension of the initiator.

Description ASCII text identifier of the initiator.

Wwnn Fibre Channel gateway-assigned world-wide node name of the initiator.

Credit Maximum number of outstanding SRP requests for each initiator connection.

State When an initiator logs in to a target, the gateway port through which the 
connection goes through is marked '1'B.   Otherwise, the port is marked '0'B.

PkeyCount Number of partitions of which the initiator is a member (maximum of 16).

Pkeys Partition keys of the partitions of which the initiator is a member.

BootupTargetWwpn World-wide port name of the target that the initiator boots by default.

BootupFcLunId Identifier of the LU that contains the boot image that the initiator boots.

Action Last action that the initiator performed:

• none: initial state before the initiator takes any action

• discoveritl: discover and create ITL entities for this initiator without the 
initiator logging in

• autoBind: binds the initiator to its WWNN and WWPNs

Result Result of the action in the Action column.
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Note We strongly recommend that you never manually edit an existing world-wide node name.

Step 6 (Optional) Double-click the cell in the Pkeys column, then edit the partition keys.

Note We strongly recommend that you never manually edit an existing partition key entry.

Step 7 (Optional) Double-click the cell in the BootupTargetWwpn field and enter a new boot target.

Step 8 (Optional) Double-click the cell in the BootupFcLunId field and enter a new boot LUN.

Step 9 (Optional) Click the cell in the Action column and select an action from the pulldown menu that appears. 
The action executes when you click the Apply button. The result of the action appears in the Result 
column of the table.

Step 10 Click the Apply button.

Viewing SRP Initiators with Storage Manager
To view SRP initiators with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the SRP Hosts folder. The SRP Hosts display appears in the right-hand window. Table 10-4 lists 
and describes the fields in this display.

Viewing General SRP Initiator Details with Storage Manager

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder to expand the folder. A list of configured initiators 
appears beneath the SRP Hosts folder.

Table 10-4 SRP Hosts Field Descriptions

Field Description

Host Host name of the initiator.

WWNN Fibre Channel gateway-assigned world-wide node name of the initiator.

Ports Registered With FC gateway ports through which the initiator connects to storage.
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Step 3 Click the initiator whose details you want to view. The details appear in the right-hand display. 
Table 10-5 lists and explains the fields in this display.

Viewing Initiator-Target Connections with Storage Manager

To view initiator-target connections with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder to expand the folder. A list of configured initiators 
appears beneath the SRP Hosts folder.

Step 3 Click the initiator whose connections to targets you want to view, then click the Targets tab. The Targets 
visible to this host table appears in the right-hand display. Table 10-6 lists and describes the fields in 
this table.

Table 10-5 Initiator Details Field Descriptions

Field Description

SRP Initiator ID GUID and GUID extension of the initiator, separated by a forward-slash (/).

Ports Registered With FC gateway ports through which the initiator connects to storage.

WWNN Fibre Channel gateway-assigned world-wide node name of the initiator.

Description ASCII text identifier of the initiator.

Boot Target WWPN World-wide port name of the target that the initiator boots by default.

Boot FC LUN Identifier of the LU that contains the boot image that the initiator boots.

WWPNs When you configure an initiator and auto-bind the initiator to a WWNN and 
to WWPNs, the auto-binding process creates virtual WWPNs for every 
possible FC gateway port that could potentially appear on the Server Switch.

• The Slot/Port column of the WWPNs table displays all of the potential 
FC gateway ports on the chassis.

• The WWPN column of the WWPNs table displays the WWPN that the 
auto-binding process created for each possible physical FC gateway 
port. Storage devices use these WWPNs to communicate with the 
initiator.

• The FC Address column of the WWPNs table displays the Fibre 
Channel address of the virtual port. When the physical FC gateway port 
does not connect to storage, the address appears as 00:00:00.

Table 10-6 Targets Field Descriptions

Field Description

Target WWPN Displays the WWPNs of the target ports that the initiator sees.

Current Access Displays the Fibre Channel gateway ports through which the initiator accesses the 
target storage port.
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Configuring the Mode of an Initiator-Target Pair

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder to expand the folder. A list of configured initiators 
appears beneath the SRP Hosts folder.

Step 3 Click the initiator whose connections to targets you want to view, then click the Targets tab. The Targets 
visible to this host table appears in the right-hand display.

Step 4 Click the entry of the IT pair that you want to configure, then click the Edit button. An IT Properties 
window opens.

Step 5 In the Mode field, click the Normal radio button or the Test radio button.

Note The Current Access field must not contain any entries in order for you to configure the mode.

Viewing Initiator-LUN Connections with Storage Manager

To view initiator-target connections with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder to expand the folder. A list of configured initiators 
appears beneath the SRP Hosts folder.

Physical Access Displays the Fibre Channel gateway ports that physically connect the initiator to the 
target storage port.

Port Mask Displays the FC gateway ports (real and potential) that grant the initiator access to 
the target storage port.

Mode Mode of the IT pair (normal or test).

Table 10-6 Targets Field Descriptions (continued)

Field Description
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Step 3 Click the initiator whose connections to LUNs you want to view, then click the LUN Access tab. 
Table 10-7 lists and displays the fields that appear in the right-hand display.

Discovering LUNs with Storage Manager

To discover the LUNs that your host can see, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder to expand the folder. A list of configured initiators 
appears beneath the SRP Hosts folder.

Step 3 Click the initiator whose connections to LUNs you want to view, then click the LUN Access tab.

Step 4 Click the Discover LUNs button.

Deleting an Initiator with Storage Manager

To delete an initiator entry, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the SRP Hosts folder.

Step 3 Click the initiator that you want to remove, then click the Remove button.

Configuring General Traits of Existing SRP Initiators with Storage Manager
To configure existing SRP initiators with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Table 10-7 LUN Access Field Descriptions

Field Description

Available LUNs Displays LUNs that the initiator has discovered but cannot currently access. To 
view these LUNs, click the plus-sign (+) next to the gateway icon ( ), then click 
the plus-sign next to the target icon ( ) to display the LUN icon ( ).

Note When the initiator cannot communicate with the target or LUN, the icon 
appears gray instead of blue.

Accessible LUNs Displays LUNs that the initiator currently accesses. To view these LUNs, click 
the plus-sign (+) next to the gateway icon ( ), then click the plus-sign next to the 
target icon ( ) to display the LUN icon ( ).
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Step 2 Click the plus-sign (+) next to the SRP Hosts folder to expand the folder. A list of configured initiators 
appears beneath the SRP Hosts folder.

Step 3 Click the initiator that you want to configure, then click the General tab.

Step 4 (Optional) Edit the ASCII text description in the Description field.

Step 5 (Optional) Select a boot target from the Boot Target WWPN pulldown menu.

Step 6 (Optional) Select a boot LUN from the Boot FC LUN pulldown menu.

Step 7 Click the Apply button.

Viewing Initiator WWPNs
To view the virtual WWPNs that FC gateway ports use to direct SAN traffic to SRP hosts, perform the 
following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Initiator WWPN tab. Table 10-8 lists and describes the fields that appear in the display.

Editing Virtual WWPNs
To edit an existing virtual WWPN, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Initiator WWPN tab.

Step 3 Double-click the cell, in the Wwpn column, of the virtual WWPN that you want to edit, then edit the 
value.

Note We strongly recommend that you never manually edit a virtual WWPN.

Table 10-8 Initiator WWPN Field Descriptions

Field Description

Guid Global unique identifier of the initiator.

Extension GUID extension of the initiator.

Port Physical FC gateway port (real or potential).

Wwpn Virtual world-wide port name that the physical FC gateway port uses to direct SAN traffic 
to the initiator.

FcAddress Fibre Channel address of the virtual port that directs SAN traffic to the SRP host.
10-10
Cisco SFS 7000 Series Product Family Element Manager User Guide

OL-9161-01



 

Chapter 10      FibreChannel Menu Tasks
  Viewing Target Ports
Step 4 Click the Apply button.

Viewing Target Ports
To view the target ports that your Fibre Channel gateway have discovered, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Targets tab. Table 10-9 lists and displays the fields that appear in the Targets table.

Editing Targets
To edit SRP target entries, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Targets tab. The Targets table appears.

Step 3 Identify the target that you want to edit and locate the appropriate entry in the table.

Step 4 (Optional) Double-click the cell in the Description column and edit the ASCII description.

Step 5 (Optional) Double-click the cell in the IocGuid column and edit the I/O controller GUID.

Note We strongly recommend that you do not manually edit the I/O controller GUID value.

Step 6 (Optional) Double-click the cell in the ServiceName column and edit the name of the service.

Table 10-9 Targets Table Field Descriptions

Field Description

Wwpn World-wide port name of the target storage port.

Description ASCII text description of the target storage port. By default, the service name 
appears in this field.

IocGuid Global unique identifier of the I/O controller (on the Server Switch) that manages 
the target.

ServiceName Name of the Fibre Channel service.

ProtocolIds Identifier of the Fibre Channel protocol.

FcAddress Fibre Channel address of the target port.

Mtu Maximum transmission unit of the target port.

PhysicalAccess Physical FC gateway ports that provide a path to the target port.

Wwnn World-wide node name of the target storage device.

ConnectionType All InfiniBand connections appear as Fibre Channel NL_Ports.
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Step 7 Click the Apply button.

Adding Targets
To manually add SRP targets, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Targets tab. The Targets table appears.

Step 3 Click the Insert button. The SRP, Insert Targets window appears.

Step 4 Enter the WWPN of the target in the Wwpn field.

Step 5 Enter an ASCII text description of the target in the Description field.

Step 6 Enter the GUID of the I/O controller for the target in the IocGuid field.

Step 7 Enter a service name for the target in the ServiceName field.

Step 8 Click the Insert button.

Step 9 Click the Apply button.

Viewing Targets with Storage Manager
To view targets with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Targets folder. The Targets Ports display appears. Table 10-10 lists and describes the fields 
in the display.

Table 10-10 Targets Field Descriptions

Field Description

Number of Active Targets Number of active targets that connect to the Server Switch.

Number of Inactive Targets Number of inactive targets that connect to the Server Switch.

Total Number of Targets Total number of targets that connect to the Server Switch.

WWPN World-wide port name of the target port.

Description ASCII text description of the target port.

Physical Access FC gateway ports that connect the Server Switch to the target port.
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Editing Targets with Storage Manager
To edit SRP target entries with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the Targets folder. A list of discovered targets appears below the folder.

Step 3 Click the target, below the Targets folder, that you want to edit. Target details appear in the right-hand 
section of the display.

Step 4 (Optional) Edit the ASCII description in the Description field.

Step 5 (Optional) Edit the service name in the Service Name field.

Step 6 Click the Apply button.

Viewing Initiator-Target-LUN Groups (ITLs)
To view ITLs, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the ITLs tab. Table 10-11 lists and describes the fields that appear in the ITLs table.

Editing ITLs
To edit existing ITLs, perform the following steps:

Table 10-11 ITLs Table Field Descriptions

Field Description

Guid Global unique identifier of the initiator in the ITL.

Extension GUID extension of the initiator in the ITL.

TargetWwpn World-wide port name of the target port in the ITL.

FcLunId Fibre Channel LUN identifier of the LUN in the ITL.

DeviceCategory Type of storage device (random or sequential).

Description Description of the ITL, in ASCII characters.

SrpLunId Virtual LUN ID of the LUN in the ITL, used for LUN masking.

LogicalId Identifier of the logical unit (LU) that the LUN in the ITL represents.

GatewayPortMaskPolicy Physical FC gateway ports that connect the initiator to the target and LUN.

LunPolicy Displays restricted if the initiator does not have access to the LUN in the 
ITL and nonRestricted if the initiator accesses the LUN.

State Ports through which an IT connection occurs.

PhysicalAccess Ports through which the ITL is physically accessible.
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Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the ITLs tab.

Step 3 Identify the ITL that you want to edit and locate the entry in the ITLs table.

Step 4 (Optional) Double-click the cell in the Description cell and edit the description.

Step 5 (Optional) Double-click the cell in the SrpLunID column and edit the LUN mask. For details on LUN 
masking, refer to the Fibre Channel Gateway User Guide.

Step 6 (Optional) Double-click the cell in the LogicalId column and edit the LU identifier.

Note We strongly recommend that you never manually edit the LogicalId field.

Step 7 (Optional) Edit the gateway port-mask policy:

a. Double-click the cell in the GatewayPortMaskPolicy column. The GatewayPortMaskPolicy 
window opens.

b. Check the checkboxes of the ports that you want to add; uncheck the checkboxes of the ports that 
you want to remove

c. Click the OK button.

Step 8 (Optional) Click the cell in the LunPolicy column and select restricted or nonRestricted from the 
pulldown menu that appears.

Step 9 Click the Apply button.

Viewing Initiator-Target Pairs (ITs)
To view IT pairs, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the ITs tab. Table 10-12 lists and describes the fields that appear in the ITs table.

Table 10-12 IT Table Field Descriptions

Field Description

Guid Global unique identifier of the initiator in the IT pair.

Extension GUID extension of the initiator in the IT pair.

TargetWwpn World-wide port name of the target port in the IT pair.

Description ASCII text description of the IT pair.

GatewayPortMaskPolicy FC gateway ports that let the initiator access the target.

State FC gateway ports that the IT pair currently uses.

PhysicalAccess FC gateway ports that create a physical connection between the target and 
the initiator.

Mode Mode of the IT pair (normal or test).
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Editing ITs
To edit ITs, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the ITs tab.

Step 3 Identify the IT that you want to edit and locate the entry in the ITs table.

Step 4 (Optional) Double-click the cell in the Description cell and edit the description.

Step 5 (Optional) Edit the gateway port-mask policy:

a. Double-click the cell in the GatewayPortMaskPolicy column. The GatewayPortMaskPolicy 
window opens.

b. Check the checkboxes of the ports that you want to add; uncheck the checkboxes of the ports that 
you want to remove

c. Click the OK button.

Step 6 (Optional) Click the cell in the Action column and select an action. The action executes when you click 
the Apply button, and the result of the action appears in the Result column.

Step 7 Click the Apply button.

Viewing Logical Units (LUs)
To view the logical units that your FC gateways have discovered, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the ITs tab. Table 10-13 lists and describes the fields that appear in the ITs table.

Action Last action that the IT pair took.

Result Result of the last action that the IT pair took.

Table 10-12 IT Table Field Descriptions (continued)

Field Description

Table 10-13 Logical Units Field Descriptions

Field Description

LogicalId ID of the LU.

DeviceCategory Displays random or sequential to identify the type of LUN.

Description User-defined LU description.
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Editing LUs
To edit LU entries, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the LUs tab.

Step 3 Identify the LU entry that you want to edit and locate the entry in the LUs table.

Step 4 (Optional) Click the cell in the DeviceCategory column and select random or sequential from the 
pulldown menu that appears.

Step 5 (Optional) Double-click the cell in the Description field and edit the ASCII text description of the LU.

Step 6 (Optional) Double-click the cell in the HiMark field and edit the hi-mark value of the LU.

Step 7 (Optional) Double-click the cell in the MaxRetry field and edit the maximum retry value of the LU.

Step 8 (Optional) Click the cell in the DynamicPathAffinity column and select true or false from the pulldown 
menu that appears.

Step 9 (Optional) Click the cell in the DynamicGatewayPortLoadBalancing column and select true or false 
from the pulldown menu that appears.

Step 10 (Optional) Click the cell in the DynamicGatewayPortFailover column and select true or false from the 
pulldown menu that appears.

HiMark The maximum number of outstanding requests from the 
initiator to the storage that the ITL can maintain.

MaxRetry Displays the number of failed communication attempts that 
must occur before the LUN identifies the initiator as 
inaccessible.

MinIoTimeout Maximum amount of time that elapses before a SRP request 
times out.

DynamicPathAffinity Displays true if you enable the feature and false if you 
disable the feature.

DynamicGatewayPortLoadBalancing Displays true if you enable the feature and false if you 
disable the feature.

DynamicGatewayPortFailover Displays true if you enable the feature and false if you 
disable the feature.

VendorId Vendor-assigned ID of the LUN.

ProductId Vendor-assigned product ID of the LUN.

ProductRevision Manufacturer-assigned product revision number.

PhysicalAccess FC gateway Ports on your Server Switch that connect to the 
LU.

Targets Target port that provides access to the LU.

Table 10-13 Logical Units Field Descriptions (continued)

Field Description
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Step 11 (Optional) Double-click the cell in the Targets column and edit the targets entry.

Note We strongly recommend that you do not edit this field manually.

Step 12 Click the Apply button.

Adding LUs
To manually add SRP LUs, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the LUs tab. The LUs table appears.

Step 3 Click the Insert button. The SRP, Insert LUs window appears.

Step 4 Enter the LU ID of the LU in the LogicalId field.

Step 5 Click, in the DeviceCategory field, the sequential radio button for a tape device LU, otherwise click the 
random radio button.

Step 6 Enter a description in the Description field.

Step 7 Enter a high mark in the HiMark field.

Step 8 Enter a maximum retry value in the MaxRetry field.

Step 9 Enter a minimum timeout value in the MinIoTimeout field.

Step 10 Check one of the following checkboxes:

– DynamicPathAffinity

– DynamicGatewayPortLoadBalancing

– DynamicGatewayPortFailover

Step 11 Enter target WWPNs in the Targets field.

Step 12 Click the Insert button.

Step 13 Click the Apply button.

Viewing LUs with Storage Manager
To view LUs with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.
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Step 2 Click the Logical Units folder. Table 10-14 lists and displays the fields that appear.

Editing General LU Attributes with Storage Manager
To edit LUs with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the Logical Units folder to display the LUs in the folder.

Step 3 Click a LU icon ( ) under the Logical Units folder.

Step 4 Click the General tab.

Step 5 (Optional) Edit the ASCII text description in the Description field.

Step 6 (Optional) Enter an integer value in the Hi Mark field.

Step 7 (Optional) Enter an integer value in the Max Retry field.

Step 8 (Optional) Enter an integer value in the Min IO Timeout field.

Step 9 (Optional) Click the Path Affinity radio button.

Step 10 Click the Apply button.

Editing Initiator Access to a LU
To edit initiator access to a LU, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the Logical Units folder to display the LUs in the folder.

Step 3 Click a LU icon ( ) under the Logical Units folder.

Step 4 Click the Initiator Access tab. The Available Hosts and Accessible Hosts fields appear.

Step 5 Click all plus-sign (+) icons to reveal all available and accessible hosts.

Table 10-14 Logical Units Field Descriptions

Field Description

Number of Active Logical Units Number of active LUs that connect to the Server Switch.

Number of Inactive Logical Units Number of inactive LUs that connect to the Server Switch.

Total Number of Logical Units Total number of LUs that connect to the Server Switch.

Logical Id Logical ID of the LU.

Inquiry Data Data received by the inquiry.

Physical Access Fibre Channel gateway ports that connect the LUs to the Server 
Switch.
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Step 6 Add or remove accessible hosts:

– Click a host in the Accessible Hosts field, then click the Remove button to deny that host access 
to the LUN.

– Click a host in the Available Hosts field, then click the Add button to grant that host access to 
the LUN.

Step 7 Click the Apply button.

Viewing Global SRP Statistics
To view global statistics, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Global Stats tab. Table 10-15 lists and describes the fields that appear in the display.

Table 10-15 Global Stats Field Descriptions

Field Description

LinkEvents Total number of link events (e.g., link up, link down) processed by the Fibre 
Channel interface gateway(s).

SrpInitiatedIos Total number of I/O transactions requested by the SRP initiator. 

SrpCmdsCompleted Total number of SRP commands completed on the Fibre Channel interface 
gateway(s).

SrpBytesRead Total number of I/O bytes read by the SRP initiator that connects to this 
chassis. 

SrpBytesWritten Total number of I/O bytes written by the SRP initiator.

SrpConnections Total number of connections used by the SRP initiator.

SrpCmdsOutstanding Total number of SRP commands outstanding on the Fibre Channel interface 
gateway(s).

SrpErrors Total number of SRP errors encountered on the Fibre Channel interface 
gateway((s).

FcpInitiatedIos Total number of I/O responses by the Fibre Channel device to SRP initiator 
requests. 

FcpCmdsCompleted Total number of FCP commands completed on the Fibre Channel interface 
gateway(s).

FcpBytesRead Total number of I/O bytes read by the target device.

FcpBytesWritten Total number of I/O bytes written by the target device.

FcpCmdsOutstanding Total number of FCP commands outstanding on the Fibre Channel interface 
gateway(s).

FcpErrors Total number of FCP errors encountered on the Fibre Channel interface 
gateway(s).
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Viewing Global SRP Statistics with Storage Manager
To view global statistics with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Statistics folder. Statistics fields appear in the right-hand side of the display.

Step 3 Click the Graph Global Statistics button. The SRP Statistics window appears. Table 10-15 lists and 
describes the fields in the rows of this window. Table 10-16 lists and describes the fields in the columns 
of this window.

Note The elapsed time period appears in the bottom-right-hand corner of the SRP Statistics display.

Step 4 (Optional) Click the pulldown menu at the bottom of the SRP Statistics window and select a refresh 
interval. The data begins to refresh at the rate that you specify.

Graphing Global SRP Statistics with Storage Manager
To graph SRP statistics, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Statistics folder. Statistics fields appear in the right-hand side of the display.

Step 3 Click the Graph Global Statistics button. The SRP Statistics window appears.

Step 4 Select the values that you want to include in the graph with one of the following methods:

– Click-and-drag your cursor across the values that you want to graph.

– Hold the Ctrl key and click the values that you want to graph.

Step 5 Click the button of the graph that you want to create.

Table 10-16 SRP Statistics Column Descriptions

Column Description

AbsoluteValue Cumulative value of the row since the Server Switch booted.

Cumulative Cumulative value of the row over the elapsed time period.

Average Average value of the row over the elapsed time period.

Minimum Minimum value of the row over the elapsed time period.

Maximum Maximum value of the row over the elapsed time period.

LastValue Last change in the value of the row.
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Figure 10-1 Graph Buttons

 Line Chart

 Area Chart

 Bar Chart

 Pie Chart

The graph appears.

Note With most charts, the display will reload with updated information based on the refresh rate. To 
configure the interval, refer to “Configuring Refresh Rate” section on page 10-22.

Swapping Chart Type, Layout, and Scale

With the exception of pie charts, the chart display lets you

• Swap between charts.

• Increase or decrease the scale of the display.

• View the chart horizontally or vertically.

To perform these functions, use the buttons in Table 10-17.

Table 10-17 Chart Buttons

Button Name Function

Stacked Overlays the graphical output of each statistic.

Horizontal Rotates the axis of the graph by ninety degrees.

Log Scale Zooms in and out.

Line Chart Displays a line chart.

Area Chart Displays an area chart.

Bar Chart Displays a bar chart.
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Configuring Refresh Rate

Element Manager refreshes all statistics displays at regular intervals. To configure the interval, perform 
the following steps:

Step 1 In the chassis display, click the port whose refresh rate you want to change.

Step 2 Click the Report menu and select Graph Port. A window opens that displays the type and number of 
the port.

Step 3 Click the pulldown menu at the bottom of the window and select the interval at which you want the 
display to refresh.

Note You do not need to click any “apply” or “ok” button. The change takes place immediately.

Viewing ITL Statistics
To view ITL statistics, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the ITL Stats tab. Table 10-18 lists and describes the fields that appear in the display.

Table 10-18 ITL Stats Field Descriptions

Field Description

Guid GUID of the initiator.

Extension GUID extension of the initiator.

TargetWwpn WWPN of the target.

FcLunId LUN ID of the LUN in the ITL.

SlotId Slot on the Server Switch in which the FC gateway resides.

SrpInitiatedIos Total number of SRP I/O requests.

SrpCmdsCompleted Cumulative number of commands that one or all FC gateways executed.

SrpBytesRead Cumulative number of SRP bytes read by one or all FC gateways.

SrpBytesWritten Cumulative number of SRP bytes written by one or all FC gateways.

SrpCmdsOutstanding Cumulative number of outstanding FC commands.

SrpErrors Cumulative number of SRP errors.

FcpInitiatedIos Total number of FC I/O requests.

FcpCmdsCompleted Cumulative number of commands that one or all FC gateways executed.

FcpBytesRead Cumulative number of FC bytes read by one or all FC gateways.

FcpBytesWritten Cumulative number of FC bytes written by one or all FC gateways.
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Viewing ITL Statistics with Storage Manager
To view ITL statistics with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Statistics folder. Statistics fields appear in the right-hand side of the display.

Step 3 Select an initiator from the Initiator pulldown menu.

Step 4 Select a target from the Target pulldown menu.

Step 5 Select a logical unit from the LUN pulldown menu.

Step 6 Select a Fibre Channel gateway from the Gateway pulldown menu.

Step 7 Click the Graph ITL Statistics button. The ITL Statistics window opens. Table 10-18 lists and 
describes the fields in this window. Table 10-19 lists and describes the columns in this window.

Graphing ITL Statistics with Storage Manager
To graph ITL statistics with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Statistics folder. Statistics fields appear in the right-hand side of the display.

Step 3 Select an initiator from the Initiator pulldown menu.

Step 4 Select a target from the Target pulldown menu.

FcpCmdsOutstanding Cumulative number of outstanding FC commands.

FcpErrors Cumulative number of FC errors on one or all gateways.

Table 10-18 ITL Stats Field Descriptions (continued)

Field Description

Table 10-19 SRP Statistics Column Descriptions

Column Description

AbsoluteValue Cumulative value of the row since the Server Switch booted.

Cumulative Cumulative value of the row over the elapsed time period.

Average Average value of the row over the elapsed time period.

Minimum Minimum value of the row over the elapsed time period.

Maximum Maximum value of the row over the elapsed time period.

LastValue Last change in the value of the row.
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Step 5 Select a logical unit from the LUN pulldown menu.

Step 6 Select a Fibre Channel gateway from the Gateway pulldown menu.

Step 7 Click the Graph ITL Statistics button. The ITL Statistics window opens.

Step 8 Select the values that you want to include in the graph with one of the following methods:

– Click-and-drag your cursor across the values that you want to graph.

– Hold the Ctrl key and click the values that you want to graph.

Step 9 Click the button of the graph that you want to create.

Figure 10-2 Graph Buttons

 Line Chart

 Area Chart

 Bar Chart

 Pie Chart

The graph appears.

Note With most charts, the display will reload with updated information based on the refresh rate. To 
configure the interval, refer to “Configuring Refresh Rate” section on page 10-22.

Swapping Chart Type, Layout, and Scale

With the exception of pie charts, the chart display lets you

• Swap between charts.

• Increase or decrease the scale of the display.

• View the chart horizontally or vertically.

To perform these functions, use the buttons in Table 10-20.

Table 10-20 Chart Buttons

Button Name Function

Stacked Overlays the graphical output of each statistic.

Horizontal Rotates the axis of the graph by ninety degrees.
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Viewing Gateway Statistics
To view Fibre Channel gateway statistics, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Gateway Stats tab. Table 10-21 lists and describes the fields that appear in the display.

Log Scale Zooms in and out.

Line Chart Displays a line chart.

Area Chart Displays an area chart.

Bar Chart Displays a bar chart.

Table 10-20 Chart Buttons (continued)

Button Name Function

Table 10-21 Gateway Stats Field Descriptions

Field Description

SlotId Slot in the Server Switch in which the Fibre Channel gateway resides.

LinkEvents Total number of link events (e.g., link up, link down) processed by the Fibre 
Channel interface gateway(s).

SrpCmdsOutstanding Total number of SRP commands outstanding on the Fibre Channel interface 
gateway(s).

SrpCmdsCompleted Total number of SRP commands completed on the Fibre Channel interface 
gateway(s).

SrpErrors Total number of SRP errors encountered on the Fibre Channel interface 
gateway((s).

SrpInitiatedIos Total number of I/O transactions requested by the SRP initiator. 

FcpCmdsOutstanding Total number of FCP commands outstanding on the Fibre Channel interface 
gateway(s).

FcpCmdsCompleted Total number of FCP commands completed on the Fibre Channel interface 
gateway(s).

FcpErrors Total number of FCP errors encountered on the Fibre Channel interface 
gateway(s).

FcpInitiatedIos Total number of I/O responses by the Fibre Channel device to SRP initiator 
requests.

SrpBytesRead Total number of I/O bytes read by the SRP initiator that connects to this 
chassis. 

SrpBytesWritten Total number of I/O bytes written by the SRP initiator.
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Viewing Gateway Statistics with Storage Manager
To view gateway statistics with Storage Manager, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Statistics folder. Statistics fields appear in the right-hand side of the display.

Step 3 Click the gateway, in the Gateways field, whose statistics you want to view.

Step 4 Click the Graph Gateway Statistics button. The SRP Statistics window appears. Table 10-21 lists and 
describes the fields in the rows of this window. Table 10-22 lists and describes the fields in the columns 
of this window.

Note The elapsed time period appears in the bottom-right-hand corner of the SRP Statistics display.

Step 5 (Optional) Click the pulldown menu at the bottom of the SRP Statistics window and select a refresh 
interval. The data begins to refresh at the rate that you specify.

Graphing Gateway Statistics with Storage Manager
To graph SRP statistics, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

FcpBytesRead Total number of I/O bytes read by the target device.

FcpBytesWritten Total number of I/O bytes written by the target device.

SrpConnections Total number of connections used by the SRP initiator.

Table 10-21 Gateway Stats Field Descriptions (continued)

Field Description

Table 10-22 SRP Statistics Column Descriptions

Column Description

AbsoluteValue Cumulative value of the row since the Server Switch booted.

Cumulative Cumulative value of the row over the elapsed time period.

Average Average value of the row over the elapsed time period.

Minimum Minimum value of the row over the elapsed time period.

Maximum Maximum value of the row over the elapsed time period.

LastValue Last change in the value of the row.
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Step 2 Click the Statistics folder. Statistics fields appear in the right-hand side of the display.

Step 3 Click the gateway, in the Gateways field, whose statistics you want to view.

Step 4 Click the Graph Gateway Statistics button. The SRP Statistics window appears.

Step 5 Select the values that you want to include in the graph with one of the following methods:

– Click-and-drag your cursor across the values that you want to graph.

– Hold the Ctrl key and click the values that you want to graph.

Step 6 Click the button of the graph that you want to create.

Figure 10-3 Graph Buttons

 Line Chart

 Area Chart

 Bar Chart

 Pie Chart

The graph appears.

Note With most charts, the display will reload with updated information based on the refresh rate. To 
configure the interval, refer to “Configuring Refresh Rate” section on page 10-22.

Swapping Chart Type, Layout, and Scale

With the exception of pie charts, the chart display lets you

• Swap between charts.

• Increase or decrease the scale of the display.

• View the chart horizontally or vertically.

To perform these functions, use the buttons in Table 10-17.

Table 10-23 Chart Buttons

Button Name Function

Stacked Overlays the graphical output of each statistic.

Horizontal Rotates the axis of the graph by ninety degrees.
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Viewing Recommended World Wide Names
To view recommended world-wide node names and world-wide port names, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the WWN Allocator tab.

Step 3 Enter the GUID of the initiator for which you want to procure a WWNN or WWPN in the Guid field.

Step 4 Enter the GUID extension of the initiator for which you want to procure a WWNN or WWPN in the 
Extension field.

Step 5 Click the “...” button in the Port field and select a port for which you want to procure a WWPN.

Step 6 Click the getRecommendedWwnn radio button, then click the Apply button, to display the 
recommended WWNN in the RecommendedWwnn field.

Step 7 Click the getRecommendedWwpn radio button, then click the Apply button, to display the 
recommended WWPN in the RecommendedWwpn field.

Disconnecting ITLs on a Fibre Channel Gateway
To disconnect all ITLs through a particular Fibre Channel gateway, perform the following steps:

Step 1 Click the FibreChannel menu and select SRP. The SRP window opens.

Step 2 Click the Action tab.

Step 3 Click the disconnectAllItls radio button.

Step 4 Enter the slot of the Fibre Channel gateway whose ITLs you want to disconnect in the SlotId field.

Step 5 Click the Apply button.

Log Scale Zooms in and out.

Line Chart Displays a line chart.

Area Chart Displays an area chart.

Bar Chart Displays a bar chart.

Table 10-23 Chart Buttons (continued)

Button Name Function
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Viewing All Fibre Channel Gateways on the Server Switch
To view the gateway card(s) on your Server Switch, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the Gateway Cards folder. The Gateway Cards display appears in the right-hand frame of the 
window. Table 10-24 lists and describes the fields in this display.

Viewing Individual Fibre Channel Gateways
To view an individual Fibre Channel gateway, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the Gateway Cards folder to expand the folder.

Step 3 Click a gateway below the Gateway Cards folder. The Active ITLs display appears.

Step 4 Click the plus-sign next to an initiator in the Active ITLs display to list the targets available to the 
initiator.

Step 5 Click the plus-sign next to a target in the Active ITLs display to list the LUs available to the initiator 
through that target.

Redistributing Connections Over a Gateway
To redistribute connections over a gateway, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the Gateway Cards folder to expand the folder.

Step 3 Click a gateway below the Gateway Cards folder.

Step 4 Click the Redistribute Connections button.

Table 10-24 Gateway Cards Field Descriptions

Field Description

Gateway Lists the gateways that reside in the Server Switch.

Initiator-Target Connections Displays the number of IT connections that connect through the 
gateway.

ITLs Displays the number of ITL connections that connect through the 
gateway.
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Viewing SRP Hosts
To view SRP hosts, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the SRP Hosts folder. Table 10-25 lists and describes the fields that appear in the display.

Defining a New SRP Host
To define a new SRP host, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the SRP Hosts folder.

Step 3 Click the Define New button. The Define New SRP Host window appears.

Step 4 Enter the GUID of your host in the Host GUID field, or select it from the pulldown menu.

Note If your host successfully connects to your Server Switch, the GUID appears in the pulldown 
menu. If you want to create a SRP host entry for a host that you have not yet connected, manually 
enter the digits of the GUID in the field. Element manager will automatically enter colons (:) as 
you enter digits.

Step 5 (Optional) Enter an ASCII text description of the host in the Description field.

Step 6 Click the Next button. The WWNN and WWPNs of the entry appear.

Step 7 Click the Finish button.

Deleting SRP Hosts

To create a SRP host, refer to “Defining a New SRP Host” section on page 10-30.

To delete an SRP host, perform the following steps:

Table 10-25 SRP Hosts Field Descriptions

Field Description

Number of Active Hosts Number of active hosts that connect to the Server Switch.

Number of Inactive Hosts Number of inactive hosts that connect to the Server Switch.

Total Number of Hosts Total number of hosts that connect to the Server Switch.

Host ASCII text name of the host.

WWNN World-wide node name of the host.

Ports Registered With FC gateway ports that connect the hosts to storage.
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Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the SRP Hosts folder.

Step 3 Click the SRP host that you want to delete, then click the Remove button.

Viewing Individual SRP Hosts
When you click an individual SRP host, you have the following options:

• “Viewing General SRP Initiator Details with Storage Manager” section on page 10-6

• “Configuring General Traits of Existing SRP Initiators with Storage Manager” section on page 10-9

• “Viewing Initiator-Target Connections with Storage Manager” section on page 10-7

• “Editing SRP Host Target Access” section on page 10-31

• “Viewing Initiator-LUN Connections with Storage Manager” section on page 10-8

• “Editing SRP Hosts LUN Access” section on page 10-31

Editing SRP Host Target Access

To grant or deny the initiator access to targets, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder.

Step 3 Click the host whose target access you want to edit.

Step 4 Click the Targets tab.

Step 5 Double-click the target entry to which you want to grant or deny the initiator access. The IT Properties 
window opens.

Step 6 Click the “...” button next to the Port Mask field. The Select Port(s) window opens.

Step 7 Check the checkboxes of the ports through which you want to grant the initiator access to the target; 
uncheck the checkboxes through which you want to deny the initiator access to the target.

Step 8 Click the Ok button, then click the Apply button.

Editing SRP Hosts LUN Access

To edit SRP host LUN access, perform the following steps:

Step 1 Click the FibreChannel menu and select Storage Manager. The Storage Manager window opens.

Step 2 Click the plus-sign (+) next to the SRP Hosts folder.

Step 3 Click the host whose target access you want to edit.

Step 4 Click the LUN Access tab.

Step 5 Add or remove accessible LUNs:
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– Click a host in the Accessible LUNs field, then click the Remove button to deny that host access 
to the LUN.

– Click a host in the Available LUNs field, then click the Add button to grant that host access to 
the LUN.
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C H A P T E R 11

Help Menu Tasks

This chapter describes the Help menu tasks, and contains these sections:

• Launching Online Help, page 11-1

• Launching the Support Web Site, page 11-1

• Viewing the Element Manager Status Legend, page 11-1

Note The tasks under the Help menu provide Element Manager resources and Support resources. For 
context-sensitive online help, click the Help button in any Element Manager window.

Launching Online Help
To launch online help, perform this step:

Step 1 Click the Help menu and choose Contents. Element Manager online help launches.

Launching the Support Web Site
To launch the support Web site, perform this step:

Step 1 Click the Help menu and choose Online Support. The support Web site launches.

Viewing the Element Manager Status Legend
To view the Element Manager status legend, perform this step:
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Step 1 Click the Help menu and choose Legend. The Element Manager legend appears.

Example
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